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OPC Client Driver

Welcome to the OPC Client Driver Help. Click the following topics for   information about using the OPC 
Driver.

 l OPC   I/O Driver Overview

 l General   Installation Information

 l Using   the Power Tool

 l Configure   the I/O Driver

 l Running   the I/O Driver

 l Optimizing   the Driver

 l Troubleshooting   Your System

 l Creating   a Custom Client Application

 l Glossary

 l Where   to Find Information

 

OPC I/O Driver Overview

Click the following links for more information about the OPC I/O Driver.

 l About   the OPC I/O Driver

 l How   the I/O Driver Works

 l Features

 

About the OPC Client Driver

The OPC Client is a GE version 7.x I/O driver that provides the   interface and communications protocol 
between OLE for   Process Control servers and your process control software. GE   version 7.x drivers are 
designed with the following attributes to provide   flexibility and ease-of-use:

 l OLE Automation technology

 l iFIX integration

 l Event-driven architecture

 l OLE for Process Control   compliance
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OLE Automation Technology

Version 7.x drivers incorporate OLE Automation technology and can therefore   expose their features to 
scripting tools and other applications. Because   the drivers are OLE Automation applications, you can:

 l Create and manipulate   objects exposed in the I/O Server from another application.

 l Create tools that   access and manipulate driver objects. These tools can include embedded   
macro languages or external programming tools.

The I/O driver consists of the following OLE components:

 l The I/O Server –   The core executable program. The I/O Server maintains the OPC server,   group, 
and item objects, performs all required functions for communicating   with third-party OPC servers, 
and exposes the methods and properties to   other applications.

 l The I/O Driver Power   Tool – A client application to the I/O Server with a graphical user interface.   
The Power Tool accesses the I/O Server and lets you view and modify OPC   server, group, and 
item properties.

You can also view and modify driver properties with a custom client   application developed specifically 
for your system. Refer to Creating   Custom Client Applications to learn more about creating your own cli-
ent   application.

Integration with iFIX

GE version 7.x drivers let you automatically add addresses to   the driver configuration while you are con-
figuring your iFIX database.   When you add a block to the database that accesses a point in the OPC   
server that you have not configured, the point is automatically added   to the I/O Server and polled for 
data. Refer to Feature:   Creating Items Automatically in iFIX Process Database.

Event-Driven Architecture

Version 7.x drivers are event-based rather than time-based, reducing   CPU time and increasing per-
formance.

OPC Compliance

The OPC Client driver complies with the OLE for Process Control (OPC)   v1.0a and v2.0 standards. The 
OPC Client provides the ability to bring   data from any OPC v1.0a or v2.0 server to the GE iFIX Human-
Machine   Interface (HMI) software.

 

How the I/O Driver Works
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1. I/O Server

The I/O driver core. The I/O Server contains objects and   interfaces that perform the following tasks:

 l Maintain the I/O   driver configuration.

 l Read and write to   third-party OPC v1.0a and v2.05 servers.

 l Expose the driver   functionality through OLE automation.

2. I/O Server Objects

The I/O Server consists of the following objects:

 l Driver   Object – Manages Server Objects and the overall state of the driver.

 l Server   Object – A server is the I/O driver’s communication path to an   OPC server. The Server 
Object contains the properties and methods that   govern the behavior of a server and allow you to 
browse your OPC servers.

 l Group   Object – A group is a logical association of data, called items,   in a server. The Group 
Object contains the properties and methods that   govern the behavior of an OPC group including 
asynchronous and synchronous   communications.

 l Item   Object – An item is a piece of data that can be read from an OPC   server. The Item Object 
contains the properties and methods that manage   the behavior of an item. Item Objects in the I/O 
Server’s local memory   correspond to data areas in the Common Memory DLL. When you add 
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new items   to the I/O Server’s local memory, you also add new data areas to the Common   
Memory DLL.

3. OLE Interfaces

Exposes the data and functionality of the I/O Server to other   applications.

4. I/O DLL

Provides functions for sending and receiving data to and   from the process hardware. In this driver, your 
hardware vendor’s OPC   server software provides these functions.

5. Common Memory DLL

Builds common memory, exposes its functionality to the Server   and the NIO DLL, and stores and main-
tains process data.

6. NIO DLL

Contains the I/O driver’s data access API. The NIO DLL has   direct access to the Common Memory 
DLL, providing fast and efficient read/write   capability.

7. Signal Conditioning DLL 

Contains the API that scales raw data to the specified engineering   units.

8. I/O Driver Power Tool

Serves as a high-performance client to the I/O Server with   a graphical user interface for configuring and 
monitoring the driver.

9. iFIX Applications

Communicates with the I/O driver through the NIO DLL. Because   the NIO DLL accesses the Common 
Memory DLL directly, reading and writing   data to iFIX applications is fast and efficient.

10. Automation Controller and COM Client Applications

Communicates with the I/O driver through the OLE Interfaces.   You can design custom applications with 
a COM/OLE Automation programming   application such as Visual Basic, Power Builder, or Visual C++.

11. Process Hardware

Includes any type of I/O device that controls a process.

 

The OPC Client Features

The OPC Client driver:

 l Lets   You Automatically Create Groups and Items from iFIX Process Database

 l Lets   You Add Items Automatically to the iFIX Process Database

 l Lets   You Add Existing Items to the iFIX Process Database

 l Automatically   Creates the iFIX Process Database Log File
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 l Lets   You Add Multiple Items to a Group

 l Lets   You Configure Custom COM/OLE Automation Applications

 l Supplies   a New, Easy-to-Use Graphical User Interface

 l Provides   Remote Configuration and Control

 l Provides   Exception-Based Processing

 l Lets   you Enable or Disable Individual Servers, Groups, and Items

 l Provides   Latched Data

 l Provides   a Time/Date Stamp for Data and Alarms

 l Can   run as a Windows Service

 l Supports   Asynchronous and Synchronous I/O

 l Supports   Device and Cache Reads

 l Lets   you Browse OPC Servers

 l Supports   Data Arrays

 l Supports   Block Writes

 l Support   for Greater Precision

 

Creating Items Automatically in iFIX Process Database

By enabling the Auto Create option in the I/O Driver Power Tool, you   can automatically create items 
from your HMI process control software   by specifying an undefined item in the I/O address of a data-
base block.   After you enter the undefined item, the OPC Client I/O driver automatically   adds the new 
item to your driver configuration. As a result, you do not   have to start the I/O Driver Power Tool and cre-
ate the OPC items before   you design your process database; you only need to create the required   serv-
ers and groups.

Example 1: Creating Items Automatically

 1. Start the I/O Driver   Power Tool and choose Setup from the Options menu. The Setup dialog box   
appears.

 2. Click the Advanced   tab and select Auto Create On in the I/O Server area.

 3. Close the Setup dialog   box and choose Templates from the Options menu. The Templates dialog 
box   appears. 

 4. Enter the default   values you want to use for your server, group, and items in the Templates   dialog 
box.

 5. In the Power Tool,   add Server1 and Group1, but do not create any items.

 6. Save the Power Tool   configuration as your default, exit from the Power Tool, and close all   remote 
connections.

 7. Open iFIX Process   Database and create five database blocks with valid Item IDs using Group1   
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as the device name.

 8. Open the Power Tool.   The Tree Browser will display five new Items under Group1.

When automatically creating items, enter a valid item ID in Process   Database.

You can also automatically create groups.

Example 2: Creating Groups Automatically

 1. Using the previous   example, delete Group1 from the Power Tool.

 2. Open iFIX Process   Database and create five database blocks, all with valid Item IDs, and   dif-
ferent group names.

 3. Open the Power Tool.   The Tree Browser will display five new Groups, each with its own new 
Item,   under Server1.

When automatically creating groups, enter a unique group name. Duplicate   group names are not 
allowed.

You can also automatically create servers from Process Database. 

Example 3: Creating Servers Automatically

 1. Using the previous   example, delete Server1 from the Power Tool.

 2. Open iFIX Process   Database and create one block with a valid prog id, a unique group name,   and 
an item ID valid to the specified OPC server’s prog id. 

 3. Open the Power Tool.   The Tree Browser will display a new Server, Group, and Item.

When automatically creating servers, enter a valid OPC server prog id.

Keep in mind that all items and groups that you automatically create   from the Process Database contain 
default values found in the Templates   section of the Power Tool.
 

Add Items Automatically to the iFIX Process Database

Click the following links for more information regarding auto-creation   of items in the iFIX Database.

 l Auto-creating   items in the iFIX Process Database from the Device Browser

 l Auto-creating   items in the iFix Process Database from the Datablock Browser

By selecting the Enable iFix PDB Tag Auto-creation option in the I/O   Driver Power Tool, you can create 
items that are automatically added to   the Process Database. You can automatically create items in the 
Database   Tag, Device Browser, and Datablock Browser dialog boxes.

NOTE: This feature   is available only for iFIX version 3.0 or later. All tags added to the   process database are 
put off scan. The initial value is displayed in the   iFIX process database as ????, however, the actual value is 
displayed   correctly after you have saved and reloaded the database.

The following conditions must be met to add existing items to the iFIX   process database:

 l iFIX must be running.   If iFIX is not running, a message is displayed.

 l The Enable iFix PDB   tag auto-creation check box must be selected.
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 l The OPC Client driver   must be on the SCU list.

 To auto-create   items in the iFIX Process Database from the Device Browser:

 1. In the Tree Browser,   select the group in which you want to auto-create items.

 2. From the Display   Mode menu, choose Config Mode.

 3. From the Edit menu,   choose Add Multiple Items. The Device Browser dialog box appears.

 4. Expand the Path tree   and tag type that you want to auto-create items for.

 5. Select an item from   the Tag Type list. The item IDs for the selected item appear in the Items   list.

 6. From the Items list,   select the number of item IDs you want to auto-create. For example, if   you 
want to auto-create 10 items, select the first item ID in the Items   list, hold down the Shift key and 
select the tenth item ID.

 7. If required, select   the Enable iFix PDB Tag Auto-creation check box.

NOTE:   This check box can also be selected on the Database Tag and Datablock   Browser dialog 
boxes. For more information, see Adding and Modifying Item   IDs.

 8. From the iFIX Database   Tag Type list, select the type of datablock you want to create items for.

 9. In the Tag Desc Prefix   box, enter a brief description of the item you are adding. By default,   AG- is 
displayed.

NOTE:   "AG-" is an acronym for "Auto Generated" and indicates,   in the iFIX Process Database, that the 
tag has been automatically generated.   Adding AG- to the description provides you with a way to 
search the iFIX   Process Database for the tags you created in the OPC Client Power Tool.

 10. In the Tag Name Prefix   box, enter the prefix you want to have appear on the database blocks.

NOTES:

 l You cannot duplicate   tag names in the iFIX process database. When adding the same item 
with   a different tag type to the iFIX process database, you must add a tag   name prefix to the 
item name.

 l Tag names must contain   only alphanumeric characters. A tag name containing non-alpha-
numeric characters   (e.g., *, ~) will prevent the tag from being added to the iFIX process   data-
base.

 11. Click OK. The auto-created   items appear under the selected group in the Power Tool Tree 
Browser and   in the iFIX Process Database.

NOTE:   The displayed item ID for each of the auto-created items is the same as   the corresponding item 
ID you selected in the Device Browser dialog box.   To change the item IDs of the auto-created items, 
see Adding and Modifying   Item IDs.

 To auto-create   items in the iFix Process Database from the Datablock Browser:

 1. In the Tree Browser,   select the item you want to auto-create a database block for in the Process   
Database.

 2. From the Display   Mode menu, choose Config Mode.

 3. In the Properties   Viewer, click the Browse Server button. The Datablock Browser dialog box   
appears.

 4. In the Item IDs list,   expand the server and select the tag type that you want to create an item   for.

 5. If required, select   the Enable iFix PDB Tag Auto-creation check box.

NOTE:   This check box can also be selected on the Database Tag and Device Browser   dialog boxes.
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 6. From the iFIX Database   Tag Type list, select the type of datablock you want to create an item   
for.

 7. In the Tag Desc Prefix   box, enter a brief description of the item you are adding. By default,   AG- is 
displayed.

NOTE:   "AG-" is an acronym for "Auto Generated" and indicates,   in the iFix Process Database, that the 
tag has been automatically generated.   Adding AG- to the description provides you with a way to 
search the iFIX   Process Database for the tags you created in the OPC Client Power Tool.

 8. In the Tag Name Prefix   box, enter the prefix you want to appear on the database block.

NOTES:

 l You cannot   duplicate tag names in the iFIX process database. When adding the same   item 
with a different tag type to the iFIX process database, you must   add a tag name prefix to the 
item name.

 l Tag names   must contain only alphanumeric characters. A tag name containing non-alpha-
numeric   characters (e.g., *, ~) will prevent the tag from being added to the iFIX   process data-
base.

 9. Click OK. The auto-created   item is added to the iFIX Process Database and appears in the Dat-
ablock   Browser the next time it is opened.

 

Add Existing Items to the iFIX Process Database

The OPC Client driver allows you to create and configure items in the   Power Tool and then to add those 
items to the Process Database. For more   information, see Add Existing Items   to the iFix Process Data-
base.

 

Use the iFIX Process Database Log File

With the OPC Client driver you can create new items that are added to   both the Power Tool and the iFIX 
Process Database. You can also add existing   items from the Power Tool to the Process Database.

When you add items to the iFIX Process Database a log file is created   automatically to record all the 
actions that you performed.

The log file name can be changed using the Setup dialog box.

 To use the iFIX Process Database   log file:

 1. From the File menu,   choose Open. The Open window browser appears.

 2. From the Files of   type list, select LogFiles (*.TXT). All available log files are displayed.

 3. Double-click the   log file you want to view.

The log file is in .CSV format and has the following fields:

Field Description
Date and Time The date and time the action was performed.
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Tag Information Displays the tag name, the tag description, and the   tag I/O address.
Status Success or Failed. If the status is failed, the error   code is recorded.

 

Add Multiple Items to a Group

The OPC Client driver allows you to add multiple items to a group in   the Power Tool. See Adding Mul-
tiple Items for the complete procedure.

The number of items you chose are added under the selected group in   the Power Tool Tree Browser with 
the associated item IDs displayed in   the Item ID and Access Path fields.

To change the item IDs of the added items, see Adding and Modifying   Item IDs from the Datablock 
Browser.

 

Configure the Driver from Custom COM/OLE Automation Applications

In concert with the growing trend towards using custom programs to access   plant floor data, GE version 
7.x drivers enable you to connect easily   with custom applications. You do not have to use the OPC Cli-
ent I/O Driver   Power Tool to configure the driver. Instead, you can create your own COM   or OLE applic-
ation or use an existing OLE application (such as Microsoft's   Excel) to configure the driver and access 
data. 

Your driver may include a custom Visual Basic application. You can use   this application in place of the 
Power Tool to configure your driver.   You can also refer to it when creating your own custom application. 
Typically,   custom Visual Basic applications are created for specific needs such as:

 l Customizing the way   you gather and view statistics.

 l Automatically building   a project.

 l Creating applications   that control the way the driver operates.

 

Using the OPC Client I/O Driver Graphical User Interface

The OPC Client I/O Driver Power Tool is an OLE application that functions   as a client to the OPC I/O 
Server   and is your main graphical driver configuration tool. It provides a graphical   user interface (GUI) 
and graphical aids for configuring the driver to   communicate with your process hardware. 

Features of the Power Tool

 l Runs as a stand-alone   program or can be launched from iFIX.

 l Lets you view servers,   groups, and items graphically from the Tree Browser.

 l Displays run-time   statistical and diagnostic information for the driver and its servers,   groups, and 
items.
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 l Provides templates   for configuring default server, group, and item settings.

 l Provides options   for customizing the Power Tool’s appearance.

 l Supports remote configuration.

Refer to the following topics for a description of the Power Tool and   how to use it to configure your driver:

 l About   the I/O Driver Power Tool

 l Set   Up the OPC I/O Server Connection

 l Add   and Modifying Servers

 l Add   and Modifying Groups

 l Add   and Modifying Items

 l Add   Multiple Items

 l Add   Existing Items to iFIX Process Database

 

Remote Control and Configuration

You can control and configure the OPC I/O Server remotely using the   Power Tool or any other client 
application. To set up remote control of   the I/O Server, you can install the Power Tool or your client 
application   on a computer that does not have the server software installed. However,   you must install 
the I/O Server on the computer used   to communicate with the process hardware.

 To install the Power Tool for   remote communication:

 1. Insert the I/O Drivers   and OPC Server CD into the remote computer’s CD-ROM drive.

 2. When the start-up   screen appears, click the Install Driver button.

 3. Select the OPC Client   from the list and click the Install Now button.

 4. Click the I Agree   button to accept the user license and continue with the installation.

 5. Follow the instructions   on the screen to complete the installation. When the Install program 
prompts   you for the node type, select Client. 

 6. After installation   is complete, open the Power Tool and connect to the I/O Server using the   Net-
work list box. Refer to Set Up the   OPC I/O Server Connection to learn more about establishing a 
connection   to the OPC I/O Server.

 

Asynchronous vs. Synchronous I/O

The OPC I/O Server supports two different methods of obtaining data   from an OPC server: synchronous 
and asynchronous I/O. Synchronous I/O   enables the OPC Client to poll the OPC server at regular inter-
vals, according   to the specified poll rate. Synchronous I/O is a reliable means of getting   data at a spe-
cified time interval.
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Asynchronous I/O, by comparison, does not enable the OPC Client to poll   the server; it provides data 
between the driver and the OPC server on   an exception basis. Using Asynchronous I/O, the server noti-
fies the OPC   Client when data has exceeded the user-supplied percent deadband. This   architecture 
offers low communications overhead because the driver does   not repeatedly poll for the same data over 
and over again. 

You can enable polling for asynchronous I/O by enabling the asynchronous   watchdog. This feature 
enables the OPC Client to ask for data from the   OPC server and ensures that no data is lost because 
the OPC server was   too busy.

Using Process Database Exception-Based Processing

You can use synchronous and asynchronous I/O with exception-based database   blocks by entering a 
deadband. When incoming data exceeds the specified   deadband, SAC updates all the exception-based 
database blocks.

For synchronous I/O, enter an exception deadband in each OPC item. For   asynchronous I/O, enter a per-
cent deadband in the item’s group.
 

Using Exception-Based Processing

GE version 7.x drivers support exception-based processing when   used with iFIX products for process 
control. Exception-based processing   means that the software application processes data only if there is 
a   considerable deviation from normal values. 

Exception-based processing also applies to database blocks. You can   enable exception-based pro-
cessing for any block in the process database.   After you enable this feature, the I/O driver reports any 
data change   that exceeds the I/O driver’s deadband to the iFIX Scan, Alarm, and Control   (SAC) pro-
gram. This program resides in the background and works to maintain   the process database con-
tinuously. Upon receiving notification of an exception,   SAC polls for information on the affected 
database block and updates that   block’s value. 

 To configure a database for   exception-based processing:

 1. Start the Power Tool.

 2. Add a server and   a group, or modify an existing group by highlighting it in the Tree Browser   win-
dow.

 3. Depending on the   group's I/O, enter a deadband value as follows:

 l For asynchronous   I/O:

 a. In the Group   properties, select Asynchronous in the I/O Type field.

 b. Enter a value   in the % Deadband field.

 l For synchronous   I/O:

 a. In the Group   properties, select Synchronous in the I/O Type field.

 b. Add an Item.

 c. In the Item   properties, enter a value in the Exception Deadband field.
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 4. Start Process Database.

 5. From the program’s   spreadsheet, double-click the block you want to modify or from the Blocks   
menu, choose Add and then select the type of block you want to create.

 6. In the I/O Address   box of the database block, enter an OPC address. Reference the group or   item 
you configured in the Power Tool.

 7. Enter E   in the Scan Time field of the database block. 

If you have many database blocks, using exceptions can help reduce the   demand on SAC.

NOTES: 

 l Analog Register and Digital   Register blocks in iFIX databases do not support exception-based pro-
cessing.   In addition, the OPC Client does not support using the Text block with   exception-based pro-
cessing.

 l The OPC Client does not   support exception-based processing for database blocks that reference   
items configured as data arrays.

 

Enabling or Disabling Individual Servers, Groups, and Items

You can enable or disable messaging to servers, groups, or items at   any time. This is a very useful fea-
ture for debugging, maintenance, and   for making preliminary configurations.

Disabling a server also disables all of its groups and items because   the server’s Enable check box con-
trols the driver’s connection to the   OPC server. After the driver and server are disconnected, all of the 
server’s   groups and items are removed as well.

The same logic applies to disabling groups; when you disable a group,   all of its items are disabled. 

Disable a server if:

 l You are removing   devices on a server for repair or maintenance and do not want to display   errors.

 l You want to disconnect   from the OPC server.

Disable a group if:

 l You are removing   a device for repair or maintenance and do not want to display errors.

 l You want to reduce   the communications load when you do not need to collect data from that   
group. 

 l You want to isolate   the group for debugging.

 l You want to remove   the group from the OPC server.

Disable an item if:

 l You only want to   intermittently view data for an item.

 l You want to remove   the item from the OPC server.

 l You want to modify   the Item ID or Access Path for the item.
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NOTE: Enabling   an object only affects the selected object by default. However, you can   enable all of the 
objects below the one you are enabling with the Enable   Children check box. Refer to Enable Children for 
more information.
 
  ̀     

Using Latched Data

You can preserve an OPC item’s last read by enabling the Latch Data   option. Should a communication 
failure occur, Data links to unlatched   items display a series of question marks (?????) while Data links 
to latched   items display the last data polled. This feature is very useful when you   need to create reports 
about your process and require data at all times.   You can also use this option to preserve the last values 
on the screen   after a communication failure occurs.

Example

Your OPC server communicates with remote devices by radio transmission.   You know that radio trans-
mission is not always reliable (particularly   during inclement weather); however, you must provide daily 
reports from   your process hardware. 

By enabling the Latch Data option for your items, you ensure data is   always available for reports.

NOTES:

 l Latch data is also available   from the OPC server. Since data quality is returned from the OPC server,   
the server can latch the item’s quality. Enabling latched data in the   driver forces the quality to reflect a 
latched state and changes the actual   data quality returned by the OPC server.

 l Analog Register and Digital   Register blocks do not support latched data. Consequently, we do not 
recommend   using these blocks with the Latch Data option.

 

Time/Date Stamp for Data and Alarms

GE version 7.x I/O drivers record the time and date of the following   events:

 l The last update of   data for an item by the OPC server

 l The last time the   driver sent data to the OPC server

 l Any time an error   occurs

The driver time stamps the data and errors at the item level. 

 To view time and date stamps   in the Power Tool:

 1. From the Tree Browser,   select an OPC item.

 2. From the Display   Mode menu, choose Stats Mode. The Power Tool displays statistics for the   
selected item. 

You can also view the time stamp from iFIX Process Database. Refer to   Specify I/O Addresses   in iFIX 
Process Database for more information.
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Running as a Service

Version 7.x drivers can run as a Windows service. Running your driver   as a service lets users log on and 
off the operating system without shutting   down the driver.

IMPORTANT:   When iFIX is running in Service mode, the OPC Client must also run in   Service mode. When 
iFIX is not running in service mode, the client must   run in non-service mode. GE strongly recommends   that 
both applications run in the same context.

NOTE: If   the OPC Client driver is added to the SCU, and you do not stop it, it   will be stopped automatically 
when iFIX is shut down.

By default, an I/O Server does NOT   run as a Windows service. To set up the I/O Server to run as a     ser-
vice, you must register it as a service. During installation, the Setup   wizard automatically registers the 
server as a regular server process.   To register it to run as a service, you must run the server on the com-
mand   line, specifying that you wish to register it as a service. When the server   is running as a service, 
you may need to re-register it in certain situations,   such as when you need to change the logon account.

Before you register the I/O Server to run as a service, follow these   steps to ensure that it is not currently 
running:

 l If the driver is   currently running as a regular server, you must stop the process by shutting   down 
all clients to the server, such as the PowerTool or iFIX.

 l If the driver is   currently running as a service, you must stop the process by shutting   down all cli-
ents to the server, and you must also perform these tasks   on your operating system:

 l Windows   XP, Windows 2000,and Windows   2003 – from Control Panel, select Admin-
istrative Tools, then select   Services. A list of all services configured on the machine dis-
plays. Locate   OPCDrv Server. If the status is Started, right click and Stop the server.

After you stop the server from running, select the Process tab from   the Task Manager and verify that the 
OPCDRV.exe process is no longer listed.

Registering the I/O Server as a Service

 To register the I/O Server as a service:

 1. From the Windows   Start menu, select Run.

 2. Enter the following   command and click OK:
OPCDrv REGSERVICE

The Logon Account for Running As A Service   dialog box appears, and the registration process 
now allows the user to   specify a logon account. This provides flexibility with the user’s choice   of 
security settings.  The   dialog box allows the user to select one of these accounts when regis-
tering   the OPC Client driver to run as a service:

 l System   Account – uses the local system account to log on the I/O Server.   This pre-
defined account is useful when your local IT department’s security   policy requires pass-
word expiration.

NOTE:   The local system account cannot be used to access remote OPC servers.   If this OPC 
Client accesses remote OPCDrv servers, you must select another   account using This Account.

 l This   Account – uses an account specified by the user to log on the I/O   Server. This 
account is useful if you need to specify a domain account.   The account used here must be 
an existing account with both Administrator   and Logon as a Service privileges to run the 
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server as a service. To determine   if the account has Administrator privileges, refer to the 
manual provided   with your operating system. For example, to determine Administrator priv-
ileges   in Windows 2000, select Administrative Tools from Control panel, and then   select 
Users and Passwords. Use the Local Security Policy Setting tool   to grant the account 
Logon as a Service privilege.

 3. After you register   the driver, start the Power Tool and make sure the Auto Start option is   enabled. 
Refer to Start the I/O   Driver from the Power Tool to learn how.

 4. Configure DCOM (Distributed   Component Object Model). Refer to How   do I set up security for 
using the I/O Server remotely? to learn more.

 5. If your Human-Machine   Interface (HMI) software is FIX or iFIX, start FIX or iFIX. When either   pro-
gram runs, it will start the OPC server as a service.

If your HMI is a third-party package, then   complete the following steps instead:

 a. From Control   Panel, select Administrative Tools/Services, and then change the OPCDrv   
server startup from Manual to Automatic.

 b. Start your HMI   software.

You can reset the server to be a regular   server process again by re-registering it as:
OPCDrv REGSERVER

NOTE: Before   you register the I/O Server to run as a regular server, you must ensure   that it is not cur-
rently running.

When registering the server this way, it will run,   perform the necessary registration work, and 
then exit. You can then start   the server by using more conventional methods such as starting 
iFIX, the   Power Tool, or any client program capable of communicating with the server.

NOTE: You cannot   display the OPCDrv Server window using ALT   + SHIFT + S when running as a service.
 

Device vs. Cache Reads

You can configure each group in the OPC Client to read data from the   OPC server’s internal cache or 
from an actual device. Reading from the   cache returns the last value read by the OPC server. The server 
updates   the cache based on the group’s update rate.

Reading from an actual device returns the latest values from the process   hardware. Although the latest 
value is obtained, reading from a device   can cause undue stress on the system. For this reason, we 
recommend that   you only use device reads for diagnostic and troubleshooting purposes.

 

Browsing OPC Servers

The OPC I/O Server supports browsing of an OPC server’s address space.   By browsing your OPC serv-
ers, you can greatly simplify the addition of   new items because you can quickly determine what item IDs 
and access paths   are available to you.

To learn how to browse an OPC server, refer to How   do I browse an OPC server?
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Data Arrays

The OPC Client can read multiple values from an OPC server if the server   supports data arrays. A data 
array is a set of contiguous data of the   same data type. By reading multiple values with a single item, 
you simplify   the driver configuration and improve driver throughput.

Example 1

Suppose you want to read 200 values of contiguous addresses from your   OPC server. Without data 
arrays, you have to create 200 items, one for   each value. Each value is read independently, resulting in 
200 messages   to the OPC server. Using data arrays, you can create one item to read   all 200 values. All 
values are read at once, resulting in one message   to the OPC server. 

Using data arrays is best when the OPC Client communicates with the   server using synchronous I/O 
because the OPC Client reads the entire array.   When data arrays are used with asynchronous I/O, the 
driver throughput   may not improve because the OPC server sends the entire array to the OPC   Client 
even if only one value in the array changes. Consequently, it may   be better to create individual items for 
specific values that change frequently   and use data arrays for all other values.

Example 2

Assume the values at addresses 100, 150, and 200 change frequently.   All other values from addresses 
1 to 200 do not change frequently. In   this situation, instead of creating one data array for all 200 values,   it 
would be better to create the following items:

 l Item 1, address 100

 l Item 2, address 150

 l Item 3, address 200

 l Item 4, data array   reading addresses 1-99

 l Item 5, data array   reading addresses 101-149

 l Item 6, data array   reading address 151-199

Data Array Syntax

The item ID syntax for data arrays depends on your OPC server. However,   you can use the following 
general syntax:

itemid

- Or -

itemid!subscript:length   (Schneider Automation only)
itemid[subscript],Llength (RS-Linx only)

Where:

 l itemid   is the OPC server’s name for the item you want to access.

 l subscript   is the starting address of the array.

 l length   is the number of elements in the array. 
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Examples

To configure an item in the Power Tool as a 100-element array for an   RS-Linx OPC server, use syntax 
similar to the following:

Sign_Int_Array[0],L100

To configure an item in the Power Tool as a 100-element array for an   S7 Siemens server, use syntax 
similar to the following:

S7:[S7_300|VFD1|CP5613_5614(PROFIBUS)]DB1,B0,100

To configure an item in the Power Tool as a 100-element array for a   Schneider Automation OFS OPC 
server, use syntax similar to the following:

MBT:1.2.3.4!400001:100

Consult your OPC server documentation for the exact syntax required   for your server.

Access Data Arrays with a Database Block

You must enter an I/O address in a database block to access data from   a data array. The exact syntax 
you must use is similar to the item ID   syntax:

servername;groupname;itemid;accesspath;[element]

Where:

 l servername   is the name of your OPC server.

 l groupname   is the name of the group containing the item you want to access.

 l itemid   is the OPC server’s name for the item you want to access. The item ID   may also include a 
length. Item IDs for RS-Linx servers include brackets   and should not be confused with the array 
element you want to access.   For example, Sign_Int_Array[0] identifies an item starting at 
address   0.

 l accesspath   is the OPC server’s name for the access path you want to use. If no access   path is 
specified you can leave it blank. 

 l element   is the element in the array you want to access. This value must be between   the starting 
address and the sum of the starting address plus the length   minus 1 (start + length-1).

Examples

With an Item Start of 0 defined in the Power Tool, you can access the   fifth element in a 100-element 
array located at address 2 on the RS-Linx   OPC server RSLinxV22 using syntax similar to the following:

RSLINXV22;SignIntGroup1;Sign_Int_Array[2],L100;Clogix;[4]

To access the fifth element in a 100-element array on an S7 Siemens   server, use syntax similar to the 
following:

Server1;Group1;S7:[S7_300|VFD1|CP5613_5614(PROFIBUS)]DB1,B0,100;No   Access Path;
[4]

To access the fifth element in a 100-element array at address 400001   on a Schneider Automation OPC 
server, use syntax similar to the following:

Server1;Group1;MBT:1.2.3.4!400001:100;No   Access Path;[5]
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Using Analog Register and Digital Register Blocks

After you complete the I/O Address field of an Analog Register or Digital   Register block, you can use off-
set in picture data sources to access different   values in the array.

Example

Suppose you create an Analog Register block, AR10, with the I/O address:

RSLINXV22;SignIntGroup1;Sign_Int_Array[5],L100;;[20]

Then the following data sources access the specified array elements:

The data source... Accesses the array element...
AR10.F_0 Sign_Int_Array[5],L100;;[20]
AR10.F_1 Sign_Int_Array[5],L100;;[21]
AR10.F_2 Sign_Int_Array[5],L100;;[22]
AR10.F_3 Sign_Int_Array[5],L100;;[23]

Offsets with a Digital Register block work the same way.

NOTES: 

 l You cannot use the Auto   Create option with items configured as data arrays.

 l Data arrays support boolean   and numeric (integer and float) data types. Arrays of strings are not   sup-
ported.

 l The OPC Client does not   support exception-based processing for database blocks that reference   
items configured as data arrays.

The OPC Client does not automatically resize items configured as data   arrays. If you need to change 
the size of the array, disable the item,   change the array’s length, and re-enable the item. Make sure the 
length   of the array in the OPC Client matches the length of the array defined   in the OPC server. If the 
lengths do not match, the data quality is set   to BAD.

 

Block Writes

Block writes let you send data to various registers in the OPC server   simultaneously by using a special 
"send" command. This command   instructs the OPC Client to send all outstanding writes in a single pro-
tocol   message. 

When the OPC Client sends the array to the OPC server, it also sends   any unmodified values in the 
array using the last known value. Consequently,   reads from the array return old values until the new data 
is written.

 To send block writes through   iFIX:

 1. Enable block writes   in the OPC item you want to use:

 a. In the Tree Browser,   select the OPC item you want to use.

 b. In the Properties   Viewer, select the Enable Block Writes check box.

 2. Create a Digital   Output block with the following address:
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!Send:ItemName

Note that only item names are valid with   the !Send control address. You   cannot trigger block 
names using the following items:

 l Server and group   names in place of an item name.

 l Analog Output   blocks in place of a Digital Output block.

 

Support for Greater Precision

The OPC Client driver now supports 15 digits of precision with analog   data. 

IMPORTANT:

 l If you are   using this OPC Client driver (v7.41) in iFIX 4.5, 15-digit precision is   supported for data val-
ues only, and not for signal conditioning. Therefore,   in iFIX 4.5, signal conditioning calculations are 
limited to 7 digits   of precision. In other words, if the range of your EGU limits exceeds   7 digits, a small 
amount of imprecision will be introduced into the calculated   result for signal conditioning. 

 l If you are   using iFIX 5.0 with this OPC Client driver (v7.41),15-digit precision   is supported for both data 
values and   signal conditioning. 

 l Prior to iFIX   4.5, 15-digit precision was not supported. Instead, you are limited to   the 7 digit limits 
imposed by the use of single precision values.

 

General Installation Information

Click the following links for general installation information.

 l Overview:   Setting Up the Driver

 l Set   Up DCOM for Remote OPC Servers

 l Supported   Protocols

 l Supported   Software

Overview: Setting Up the Driver

The following is a general overview of the steps necessary for setting   up your I/O driver.

 1. Know your process hardware

 l What type of cable   are you using?

 l What is the station   number for each device?

 l What addresses do   you want to access and what data do you want to retrieve?

 l What is the method   of communication: Direct Connection, Telephone Modem, or Radio Trans-
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mission?

 l What are the bandwidth   limitations of your network and hardware?

 2. Know your OPC server

 l Item ID

 l Access Path

 l Requested Data Type

 l Asynchronous   vs. Synchronous I/O

 3. Choose the configuration method

 l Choosing a Method   for Configuring Your Driver

 4. Configure the I/O driver

 l Configuring Servers

 l Configuring   Items

 l Configuring   Groups

 l Setting   Default Values for Driver, Servers, Groups, and Items

 5. Check the I/O driver status

 l Using   Statistics Mode

 6. Test driver communication with the process hardware

 l Getting   Basic Communication

 

Set Up Windows Firewall for Remote OPC Servers

If Firewall security is enabled on Windows you may need to modify or add items to the Exceptions list.

GE recommends that you enter these settings on   the local machine running the OPC Client, as well as 
on the remote machine   that has the OPC server you want to use.

 To modify Windows Firewall settings:

 1. Log into the Windows   operating system with an Administrator account.

 2. Open the Control   Panel and double-click Windows Firewall. The Windows Firewall dialog box   
appears. You also need to click the "Allow a program through Windows firewall"   option.

 3. Click the Exceptions   tab and make sure that the File and Printer Sharing check box is selected.   
The following figure shows an example of this dialog box in Microsoft    Windows XP.
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 4. Click the Add Port   button. The Add a Port dialog box appears. The following figure shows   an 
example of this dialog box in Microsoft Windows XP.
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 5. In the Name field,   enter a name for the port.

 6. In the Port Number   field enter 135.

 7. Select the TCP option.

 8. Click OK to save   your changes.

The port name you entered is now listed   with its check box selected.

 9. Select the Add Program   button. The Add a Program dialog box appears. The following figure 
shows   an example of this dialog box in Microsoft Windows XP.
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 10. Click the Browse   button. A Browse dialog box appears.
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 11. Navigate to the System32   folder. This folder is found under the operating system folder (usually   
Windows or WINNT).

 12. In the System32 folder,   select the OPCENUM.exe file, and then click the Open button.

In the Add a Program dialog box the path   field displays the full path to, and including, the 
OPCENUM.exe file.
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 13. Click OK.

OPCENUM.exe should now be listed in the   Exceptions list with its check box selected.
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 14. Complete steps 9-13 for each OPC server that you   want to access.

NOTES:

 l You must also add the   GE OPC Client driver by adding the file OPCDrv.exe   into the Exceptions list.

 l If any OPC server that   you want to use is a dll surrogate (an in-process dll and not an .exe),   you must 
add \system32\dllhost.exe into the Exceptions list.

 l OPCENUM must reside on   the remote machine with the OPC server. While most OPC Server applic-
ations   install and register this file, some do not. You can download this file   from www.op-
cfoundation.org.   Currently it is contained within the OPC Core Components 2.00 Redistributable   
2.30.msi file. After you download OPCENUM, run the .msi file.

 

Set Up DCOM for Remote OPC Servers

The OPC Client supports DCOM (Distributed Component   Object Model) to browse remote OPC Serv-
ers. If you want to grant only   certain users permission to launch or access the remote OPC servers, you   
can use the Windows utility, DCOMCNFG.EXE for configuring DCOM applications.   DCOMCNFG.EXE 
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is usually located in your operating system’s \system32 folder.

When OPC Servers register, they set up initial custom DCOM security   settings to enable users on the 
network to access and launch the Server.   On large networks, it is recommended that you modify these 
settings to   avoid confusion and inadvertent changes to a running OPC Server.

If Firewall security is enabled on Windows, you must also modify or add items to the Exceptions list.   
Refer to Set Up Windows XP   or Vista Firewall for Remote OPC Servers.

IMPORTANT NOTES:

 l GE     recommends that all OPC Client users be members of the Administrators   group. To facilitate this, 
GE recommends creating   a users group to contain individual users that need to access remote OPC   
servers. 

For example, create a group named “DAC”   and add those users who will log into the operating sys-
tems and access   remote OPC servers. Add the users Tom, Denise, and Harry into the DAC   group. 
Each of these users will also be added into the Administrators   group. This DAC group should also con-
tain the following built-in security   principals: INTERACTIVE; NETWORK; SYSTEM.

 l To make any   OPC Client / OPC Server application work via DCOM, changes need to be   made on both 
sides, especially if you intend to use Asynchronous I/O communications.

 l OPCENUM must   reside on the remote machine with the OPC server. While most OPC Server   applic-
ations install and register this file, some do not. You can download   this file from www.op-
cfoundation.org.   Currently it is contained within the OPC Core Components 2.00 Redistributable   
2.30.msi file.  After   you download OPCENUM, run the .msi file.

 l This section   applies to OPC servers that need to use DCOM communications, regardless   of whether 
the OPC server uses Serial or Ethernet devices.

 l If OPC communications   is confined to a single machine (that is, using COM, but not DCOM), it   con-
tinues to work properly without making changes to DCOM settings.

 l If you do not   plan to use the OPC Client to connect remotely to OPC servers, then you   may not need to 
change your DCOM settings.

 l If this is   the first time you are connecting to (or allowing connections from) other   machines on the net-
work, you must run the Windows Network Wizard (from   Start > Control Panel) to set up your computer 
to run on your network.   This allows you to share resources on your computer with other computers   on 
your network. It is recommended that you run the Network Setup Wizard   before modifying the DCOM 
settings.

DCOM Settings

The following procedures provide general guidelines for configuring   DCOM settings.

 To launch the DCOM configurator:

 1. From the Start menu,   select or type Run. The Run dialog box appears.

 2. Type: dcomcnfg and   click OK.

The Component Services dialog box appears.

System-wide COM/DCOM Limits Settings

This procedure modifies the system-wide DCOM settings for the computer.   When these steps are imple-
mented, they apply to all programs that use   COM/DCOM communications on the computer.
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IMPORTANT:   Be careful when making any system-wide security changes. Any inadvertent   changes may 
affect the entire system and may cause some or all programs   to stop working.

 To update system-wide COM/DCOM limits   settings:

 1. On the Component   Services dialog box, expand Component Services, then expand the Com-
puters   item. 

 2. Right-click My Computer   and choose Properties. The My Computer Properties dialog box 
appears.

 3. Click the COM Security   tab. There are four permissions on this dialog box.

You may need to make changes to the Edit   Limits… for Access Permissions and Launch and 
Activation Permissions.

Do not change the Edit Default… settings,   since this will change the default settings for all pro-
grams and applications   running on the computer.

 4. Click Access Permissions   > Edit Limits… The Access Permission dialog box appears.

 i. Select the   user labeled ANONYMOUS LOGON, and then select the Allow check box for   
Remote Access.

NOTE:   This setting is necessary for applications that use OPCenum.exe to function   and also 
for some OPC Servers and OPC Clients that set their DCOM ‘Authentication   Level’ to ’None’ to 
allow anonymous connections. If you do not use such   applications, you may not need to 
enable remote access for anonymous logon   users.

 ii. Select the user   labeled Everyone, and then select the Allow check box for Remote 
Access.

IMPORTANT:   Since “Everyone” includes all authenticated users, it is recommended to   add 
these permissions to a smaller subset of users. One way of doing this   is to create a Group 
named “DAC” and add all user accounts to this Group   that will access any OPC server. Then 
substitute “DAC” everywhere that   “Everyone” appears in the entire DCOM configuration dia-
logs.

 iii. Click OK to close   the Access Permissions dialog box and return to the My Computer Prop-
erties   dialog box.

 5. Click Launch and   Activation Permissions > Edit Limits… The Launch Permission dialog   box 
appears.

For each user or group (preferably add the   “DAC” group) that needs to launch or activate the OPC 
server, or participates   in OPC / DCOM communications, make sure that the Local Launch, 
Remote   Launch, Local Activation, and Remote Activation check boxes are selected.

 6. Click OK to save   your changes, then click OK again to save and close the My Computer Prop-
erties   dialog box.

OPC Server-specific DCOM Settings

The following procedures detail the OPC server-specific COM/DCOM settings   on all supported Win-
dows operating systems. You must change the OPC server   settings so remote users can access the 
OPC server as an OPC Data Access   Server. This procedure is also necessary for the GE   OPC Client 
driver to connect to, launch, configure, and start the remote   OPC servers.

GE recommends that all OPC Client users be members   of the Administrators group.

28 © 2024 General Electric Company. All rights reserved.



IMPORTANT:   Since the “Everyone” group includes all authenticated users, it is recommended   to add these 
permissions to a smaller subset of users. 

GE recommends creating a group to contain individual   users that need to access remote OPC servers. GE   
also recommends that all OPC Client users be members of the Administrators   group.

For example, create a group named “DAC” and add those users who will log   into the operating systems and 
access remote OPC servers. Add the users   Tom, Denise, and Harry into the DAC group. Each of these users 
will also   be added into the Administrators group. This DAC group should also contain   the following built-in 
security principals: INTERACTIVE; NETWORK; SYSTEM.   Then substitute “DAC” everywhere that “Everyone” 
appears in the entire   DCOM configuration dialogs.

 To modify driver-specific DCOM settings:

 1. Access the DCOM configurator   (dcomcnfg.exe). The Component Services dialog box appears.

 2. Expand the Component   Services item, then expand the Computers item, and then expand the 
My   Computer item.

 3. Select the DCOM Config   object. A list of applications displays.

 4. Right-click the OPC   server you want to modify and choose Properties. The <Selected OPC   
Server> Properties dialog box appears.

 5. Click the General   tab. The Authentication Level should be left as “Default”. This uses the   default 
authentication rules that are set in the system-wide DCOM settings.

 6. Click the Location   tab and make sure that the Run Application on this computer check box   is 
selected.

 7. Click the Security   tab and select the Customize option for each of the permissions in this   dialog 
box and edit them as described in the following steps.

 8. In the Launch Permissions   area, click Edit. The Launch Permissions dialog box appears.

 9. Click the Add button.   The Select Users and Groups dialog box appears.

 10. Click the Advanced   Button. The Select Users and Groups dialog box appears.

 11. Click the Find Now   button. In the search results, select the DAC group and click OK. The   Select 
Users and Groups dialog box displays the DAC group.  

 12. Click OK to return   to the Launch Permission dialog box. The DAC group is displayed in the   Group 
or user names list.

 13. Select the DAC group   and select the Allow check box for Launch Permission.

 14. Click OK to return   to the <Selected OPC Server> Properties dialog box.

 15. In the Access Permissions   area, click Edit. The Access Permission dialog box appears.

 16. Click the Add button.   The Select Users and Groups dialog box appears. 

 17. Click the Advanced   Button. The Select Users and Groups dialog box appears.

 18. Click the Find Now   button. In the search results, select the DAC group and click OK.  The   Select 
Users and Groups dialog box displays the DAC group.  

 19. Click OK to return   to the Access Permission dialog box. The DAC group is displayed in the   Group 
or user names list.  

 20. Select the DAC group   and select the Allow check box for Access Permission.
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 21. Click OK to return   to the <Selected OPC Server> Properties dialog box.

 22. In the Configuration   Permissions area, click Edit. The Change Configuration Permission dialog   
box appears.

 23. Click the Add button.   The Select Users and Groups dialog box appears. 

 24. Click the Advanced   Button. The Select Users and Groups dialog box appears.

 25. Click the Find Now   button. In the search results, select the DAC group and click OK. The   Select 
Users and Groups dialog box displays the DAC group.

 26. Click OK to return   to the Change Configuration Permission dialog box.

 27. Select the DAC group   and select the Allow check boxes for Full Control and Read,

 28. Click OK to return   to the <Selected OPC Server> Properties dialog box.

 29. Click OK.

 30. Repeat steps 2 through   29 for each OPC server you need to access remotely.

 31. When you are done,   close the Component Services dialog box.

 

Supported Protocols

Supported OLE for Process Control v1.0a and v2.05 Interfaces:

Interface Function
IOPCServer Adding groups and items. This is the main OPC server   interface.
IOPCBrowseServer
AddressSpace

Browsing. An OPC server must support this interface   for the driver to 
be able to browse it.

IPersistFile Saving server settings. An OPC server must support   this interface for 
the driver to save its settings.

IOPCGroupStateMgt Managing the state of groups in the server.
IOPCSyncIO Performing synchronous reads and writes.
IOPCAsyncIO Performing asynchronous reads and writes.
IOPCItemMgt Maintaining the state of items in the server.
IdataObject/
IAdviseSink

Establishing asynchronous connections between the   driver and the 
OPC server.

 

Supported Software

Operating System
 l Microsoft® Windows® Server 2022 

 l Microsoft® Windows® Server 2019
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 l Microsoft® Windows® 11

 l Microsoft® Windows® 10

OPC Servers

Any OPC server that supports the OLE for Process Control specification   v1.0a or v2.05. 

NOTE: Using a   Human-Machine Interface (HMI) software package is not required to use   the OPC Client. 
However, if you choose to use an HMI software package,   select one of the following:

 l iFIX version 2.1 or greater.

 l A third-party HMI software   package.

 

Using the Power Tool

Click the following links for more information regarding use of the   Power Tool.

 l Overview:   About the I/O Power Tool

 l The   Power Tool's Graphic Interface

 l The   Power Tool Environment

Overview: About the I/O Driver Power Tool

The OPC Client I/O Driver Power Tool is your main configuration utility   for setting up and maintaining the 
OPC Client I/O driver. It provides   a means to specify the properties of servers, groups, and items.

Features

The Power Tool provides:

 l The Templates dialog   box for specifying server, group, and item defaults.

 l The Setup dialog   box for defining the default name and default path for configuration files.

 l The Server Connection   dialog box for connecting to a remote or local I/O Server.

 l The Tree Browser   for an overall view of your system configuration.

 l The Device Browser   dialog box for adding multiple items to a group.

 l The Database Tag   dialog box for adding existing items to the Process Database.

 l The Find dialog box   for searching for a server, group or item in the Tree Browser.

 l The ability to alphabetically   sort groups and items in the Tree Browser.

 l A statistics mode   for displaying the statistics of your I/O driver while it is running.   Statistics are 
provided for all levels: driver, server, group, and item.

 l A configuration mode   for displaying and modifying driver, server, group, and item properties.
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Access Methods

From the iFIX Program Group:

 1. Select Programs.   

 2. From the Programs   menu, select Dynamics or iFIX. 

 3. Select OPC Power   Tool from the menu that appears. 

From the iFIX Process Database:

 l From   the Drivers menu, choose OPC.

From the iFIX System Configuration Utility (SCU):

 1. From the Configure   menu, choose SCADA. 

 2. From the Configured   I/O Drivers list box, double-click your driver.

When you first start the Power Tool, the Server   Connection dialog box appears. This dialog box is where 
you choose   the server that the Power Tool communicates with. You can choose either   the Local Server 
(on your computer) or a Remote Server (on the network).

When you choose a server, the I/O Driver Power Tool attempts to connect   to the server. If the con-
nection is successful, a message appears telling   you that the connection is established. Then the main 
window of the Power   Tool appears. This window comprises: 

 l The   Properties Viewer

 l The   Menu Bar

By default, the following additional components also appear:

 l Tree   Browser

 l Main   Toolbar

 l Configuration   Toolbar

 l Run-time   Toolbar

 l Status   Bar

 l Search   and Sort Toolbar

You can show or hide any of the components by selecting a command from   the View menu. You can 
also customize the Power Tool’s appearance by dragging   the toolbars or the Tree Browser to the loc-
ation you want. For example,   you can make the toolbars or the Tree Browser float above the Power Tool   
by dragging them to the center of the screen. Later, you can dock them   or resize them, as needed.
 

The Power Tool's Graphic Interface

Click the following links for more information about the Power Tool's   Graphic Interface.

 l The   Properties Viewer

 l The   Tree Browser
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 l Shortcut   Keys

 l The   Status Bar

 l The   Main Toolbar

 l The   Run-time Toolbar

 l The   Search and Sort Toolbar

 l The   Configuration Toolbar

 l The   Menu Bar

 l The   File Menu

 l The   Edit Menu

 l The   View Menu

 l The   Display Mode Menu

 l The   Options Menu

 l The   Help Menu

The Properties Viewer

Click the following links for more information regarding the Properties   Viewer:

 l Displaying   an object's configuration properties

 l Modifying   an object's configuration

 l Viewing   an object's statistics

The Properties Viewer displays the statistics or the configuration properties   of the selected object in the 
Tree Browser.

 To display the   configuration properties for the driver, a server, a group, or an item:

 1. Select an object   in the Tree Browser.

 2. Choose Config Mode   from the Display Mode menu. 

 To modify   the configuration of a server, group, or item:

 1. In the Tree Browser,   select the object you want to modify.

 2. From the Display   Mode menu, choose Config Mode.

 3. Modify the object’s   properties in the fields provided.

 To view   statistics for the driver, a server, a group, or an item:

 1. Select an object   in the Tree Browser.

 2. Choose Stats Mode   from the Display Mode menu. 

 

The Tree Browser
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The Tree Browser displays a hierarchical list of the I/O driver and   its servers, groups, and items. The I/O 
driver is displayed at the top   of the tree.

When you select an object in the Tree Browser, its properties display   in the Properties   Viewer. You can 
choose to view the object’s configuration or statistics   properties with commands from the Display   Mode 
menu.

Adding Objects

When you add servers, groups, and items to a driver configuration, labels   and icons representing the 
objects automatically add to the Tree Browser.   You can add servers to the driver, groups to each server, 
and items to   each group. 

Changing Objects

When you add or modify servers, groups, or items in the Power Tool or   in iFIX Process Database, 
changes are made immediately to the I/O Server.   Changes you make to the driver configuration while 
working with the I/O   Driver Power Tool automatically display in the Tree Browser. For changes   from Pro-
cess Database to take effect, enable the Auto Create option first.

Refreshing the Tree Browser

To view changes made from another client application (such as iFIX Process   Database, another I/O 
Driver Power Tool accessing the server, or a custom   client application accessing the server), refresh the 
Tree Browser display   by selecting an object in the Tree Browser and pressing the F5 key.

Collapsing and Expanding the Tree   Browser

You can collapse or expand the tree under an object by double-clicking   it. You can also use the right 
arrow key to expand an object and the left   arrow key to collapse it, or click the plus and minus icons.

Navigating

Navigating through the Tree Browser can be done by selecting an object   with a mouse click or by using 
the keyboard. Use the up or left arrow   keys to move up in the Tree Browser. Similarly, use the down or 
right   arrow keys to move down in the Tree Browser. You can also press a letter   key to jump to the 
nearest object that begins with that letter. 

Finding and Sorting

You can use the Find dialog box to locate a group or item in the Tree   Browser, or you can sort the Tree 
Browser in ascending alphabetical order   to make locating a group or item easier. If you have selected a 
server,   you can search for or sort groups and items associated with that server.   If you have selected a 
group, you can search for or sort items associated   with that group.

Right-clicking

You can right-click any object displayed in the Tree Browser to access   run-time commands for the selec-
ted object. The following table describes   the commands available for each object type and the behavior 
of each command.

If you 
select...

The action performed is... Available for

Start The driver is started. Driver, Server, Group, 
Item

Stop The driver is stopped. Driver, Server, Group, 

34 © 2024 General Electric Company. All rights reserved.



Item
Enable The selected object is enabled. Server, Group, Item
Disable The selected object is disabled. Server, Group, Item
Enable Chil-
dren

The selected object and its associated sub-objects   are 
enabled.

Server, Group

Disable Chil-
dren

The selected object and its associated sub-objects   are 
disabled.

Server, Group

Synchronous The I/O data polling changes to synchronous com-
munication.

Group

Asynchronous The I/O data polling is changed to asynchronous com-
munication.

Group

For more information about I/O data polling, see Feature:   Asynchronous vs. Synchronous I/O.

Additional Features

Connection lines show the relationship between servers, groups, and   items by displaying which groups 
are on a server and which items belong   to a group. The plus and minus buttons indicate whether items 
are fully   expanded or collapsed. The plus button shows the item is collapsed and   the minus button indic-
ates that the item is expanded. For example, a server   with a plus sign next to it means that there are 
groups and possibly items   configured on that server. 

You can also display the driver’s server window using the Tree Browser.   To learn how to display this win-
dow, refer to How   do I view the driver’s I/O Server Window?

 

The Status Bar

Displays Power Tool status messages. It is located under the Properties   Viewer. The right hand side of 
the status bar indicates whether you are   in Configuration mode (blue background) or Statistics mode 
(green background).

 

Using Shortcut Keys

The following is a list of shortcut keys for working with the I/O Driver   Power Tool:

ShortcutFunction
F5 Refreshes the Tree Browser.
Ctrl + N Opens a new I/O driver configuration file.
Ctrl + O Allows you to open an existing file.
Ctrl + S Saves the current file.
Alt + 
Shift + S

Opens and closes the Event window when an object in   the Tree Browser is selec-
ted. Use the Event window for troubleshooting.   When you are not debugging a prob-
lem, leave the Event window closed.
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The Main Toolbar

The Power Tool’s Main toolbar is shown below:

The Main toolbar buttons are shortcuts to some commonly-used menu items.

Toolbar 
button

Function

New – Creates   a new I/O driver configuration file.

Open – Opens   an existing I/O driver configuration file, or the iFIX Process Database   
log file
Save – Saves   the current I/O driver configuration file. If the current configuration   is 
new, the Save As dialog box appears with fields for naming the file   and choosing a 
file type.
Save As – Saves   the current configuration file:

 lWith a different   file name.

 lIn a different   path.

 lAs a configuration   file.

 lAs a comma separated   value (CSV) file.
Help Topics   – Displays the OPC Client I/O driver online help.

 

The Run-time Toolbar

The Run-time toolbar is shown below:

The Run-time toolbar contains buttons that are shortcuts to dialog boxes   for viewing driver con-
figurations and statistics.

Toolbar 
button

Function

Start – Starts   the driver. Enabled only when the driver is not running. 

Stop – Stops   the driver. Enabled only when the driver is running. 

Configuration   – Displays the properties of the object selected in the Power Tool’s 
browser.   These properties appear in the Properties Viewer.
Statistics   – Displays the statistics of the object selected in the Power Tool’s 
browser.   The statistics appear in the Properties Viewer and are read-only.
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Reset – Resets   the statistics of the object currently selected in the Tree Browser. 
This   button is available only when the Power Tool is in Statistics Mode. Click   the 
Statistics button shown above to enable Statistics Mode.
Template –   Lets you enter defaults for the driver and its servers, groups, and items.

Setup – Lets   you select the statistics refresh rates, enter defaults for the I/O driver   
configuration file name and path, and make advanced settings.
OLE I/O Server   – Lets you select an OLE server.

I/O Server Event   Window – Shows and hides the driver’s server windows. Using 
the   server event window, you can display the information that the driver logs   during 
execution. This information includes operational messages from   the OPC Client.

 

The Search and Sort Toolbar

The Search and Sort toolbar is shown below:

The Search and Sort toolbar contains buttons that activate Find and   Sort operations. With them you can 
find and sort groups and items when   the focus is in the Tree Browser. If you have selected a server, you 
can   search for groups or items associated with that server. If you have selected   a group, you can search 
for items associated with that group.

If you have selected a server, you can sort the associated groups in   ascending alphabetical order. If you 
have selected a group, you can sort   the associated items.

NOTE: Searching   and sorting is available only during driver configuration.

Toolbar 
button

Function

Find – Opens the Find dialog   box where you can enter the criteria for the object you 
want to search   for. This is available at all levels of the tree browser.
Sort – Sorts   the groups and/or items associated with the object selected in the Tree   
Browser. This is available only at the server and group levels.

 

The Configuration Toolbar

The Configuration toolbar buttons are shortcuts to the driver configuration   dialog boxes.

Toolbar 
button

Function

Add Server   – Displays the OPC servers available to the local computer. After you   
select a server, the driver adds a new server object and displays the   fields for modi-
fying the server’s properties.
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Add Group –   Adds a new group to the selected OPC server and displays the 
fields for   modifying the group’s properties.
Add Item –   Adds a new item to the selected group and displays fields for modi-
fying   the new item’s properties.
Add Multiple Items   – Displays a server where you can select multiple items to 
add to the   selected group, and to automatically create tags (items) that can be 
added   to the group.
Add Item to iFix Database   – Opens the Database Tag dialog box where you can 
add the selected   item to the iFIX Process Database.
Delete – Deletes   the server, group, or item currently selected in the Tree Browser.

 

The Menu Bar

The Power Tool menu bar includes a title bar, a Minimize button, a Maximize   button, a Control-menu 
box, and menus you can use to configure the OPC   Client. The menu bar is displayed at the top of the 
screen.

The Power Tool has the following menus:

 l The   File Menu

 l The   Edit Menu

 l The   View Menu

 l The   Display Mode Menu

 l The   Options Menu

 l The   Help Menu

To open a menu and display its commands, click the menu name.

To choose a command, open the command's menu and click the command name   or press the com-
mand’s shortcut keys. You can find the shortcut keys for   a command displayed next to the command on 
its menu. For example, click   the File menu and note that the shortcut key for the New command is CTRL 
+ N.

 

The File Menu

The following commands appear on the File menu.

New

Create a new driver configuration file. 

Keyboard shortcut: CTRL + N.
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Open

Open an existing driver configuration   file or log file. You can select .OPC or .CSV configuration file 
types,   or .TXT log file types.

Keyboard shortcut: CTRL + O.

Save

Saves the current driver configuration file to the default path for   configuration files with the name you spe-
cify. The default path for configuration   files is the same path where you installed the server. You can 
change   the default path by entering a new location. Refer to Set   Defaults for I/O Driver Configuration 
File Name and Path to learn   how to configure the default path for the Power Tool.

If you save a new driver configuration file, the Save As dialog box   prompts you to enter a name for your 
driver configuration file.

Keyboard shortcut: CTRL + S.

Save As

Lets you enter a new name, path, and file type for the current driver   configuration.

Save As Dialog Box Options

 l Save   In – Select the directory that you want to store the file in.

 l File   Name – Enter a new name for the file. To save a file with an existing   file name, select the 
name in the list or enter the current name. This   will overwrite the existing file.

 l Save   as Type – Specify the type of file you want to save the configuration   as:

 l A configuration   file (*.OPC) – Specify the type of file in the format that the driver   uses to 
communicate with the process hardware. Configuration files use   the three-letter acronym 
of the driver.

 l A comma separated   value file (.CSV) – Save the file as a text file. You can open these 
files   in a text editor and use them to document your driver configurations.   You can also 
modify .CSV files in a text editor, open them in the Power   Tool, and save them as con-
figuration files. The delimiters for .CSV files   conform to national standards. For example, 
in the United States, .CSV   file delimiters are commas. In France, .CSV file delimiters are 
semicolons.   Saving a configuration as a .CSV file is sometimes referred to as exporting   
the driver configuration.

 l Refer to Use   I/O Driver Report Files for details on how to use the different file   types most effect-
ively.

 l Save   button – Saves the file with the specified name.

 l Cancel   button – Closes the dialog box without saving the file.

Exit

Exits the Power Tool.

 

The Edit Menu
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The commands that appear in the Edit menu are for creating and modifying   driver configuration files. 
These commands correspond with the buttons   on the Power   Tool’s Configuration Toolbar.

Add Server

Displays a dialog box that lists all valid OPC servers available to   your computer. By selecting an OPC 
server from the list, you can add it   to the driver. The Power Tool obtains the OPC server list from the 
registry   where the I/O server is running. Consequently, if you are trying to connect   to a remote server, 
you must register the I/O server on both the local   and remote nodes.

Add Group

Adds a new group to the selected OPC server.

Add Item

Adds a new item to the selected group.

Add Multiple Items

Displays a server browser that allows you to select multiple items to   add to the selected group.

Add Item to iFix Database

Opens the Database Tag dialog box that allows you to add the selected   item to the iFIX Process Data-
base.

Delete

Deletes the server, group, or item currently selected in the Tree Browser.   When you delete an object, all 
of its associated objects are deleted.   For example, If you delete a server, all groups and items are 
deleted   for that server.

Find

Displays a dialog box that allows you to locate a server, group, or   item listed in the Tree Browser.

Sort

Sorts the Tree Browser list in ascending alphabetical order.

 

The View Menu

The commands in the View menu are for customizing the Power Tool’s appearance.   If a check mark 
appears next to a command, the item displays; otherwise,   the item is hidden.

Tree Browser

Shows or hides the Tree Browser.

Main Toolbar

Shows or hides the Main   toolbar.

Run-time Toolbar

Shows or hides the Run-time   toolbar.
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Configuration Toolbar

Shows or hides the Configuration   toolbar.

Status Bar

Shows or hides the status bar.

Search and Sort Toolbar

Shows or hides the Search   and Sort toolbar.

 

The Display Mode Menu

The commands in the Display Mode menu are for displaying the driver’s   configuration or statistics in the 
Properties Viewer.

Configuration Mode

Displays the properties of the object selected from the Power Tool’s   browser. These properties appear in 
the Properties Viewer.

Statistics Mode

Displays the statistics of the object selected from the Power Tool’s   browser. The statistics appear in the 
Properties Viewer and are read-only.

Start

Starts the driver.

Stop

Stops the driver.

 

The Options Menu

The commands in the Options menu are for accessing specific Power Tool   options.

Reset Counters

Resets the statistics of the object currently selected in the Tree Browser.   This command is available 
only when the Power Tool is in Statistics Mode.   To enable Statistics Mode, choose Stats Mode from the 
Display Mode menu.

Templates

Lets you enter defaults for the driver’s servers, groups, and items.

Setup

Lets you set the statistics refresh rates, enter defaults for the I/O   driver configuration file name and path, 
and make advanced settings.
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OLE Server

Lets you select a local or remote OPC Client I/O Server.

Event Window

Displays the server Event window for this driver. By default, the driver   logs information about the oper-
ation of the OPC Client.

 

The Help Menu

The commands in the Help menu provide access to the Power Tool’s online   help and version number.

Help Topics

Displays the OPC Client Power Tool online help.

About Power Tool

Displays the Power Tool’s version number.

 

The Power Tool Environment

The Power Tool Environment can be configured through the following sources.   Click the links for more 
information:

 l Templates   Dialog Box

 l Setup   Dialog Box

 l I/O   Driver Server Connection Dialog Box

 l Server   Event Dialog Box

You set up the Power Tool’s environment by displaying the Setup dialog   box and completing each tab. In 
the Setup dialog box you can do the following:

 l Set   the statistics refresh rates.

 l Set   the default configuration file name and default path for the configuration   file.

 l Make   advanced settings for your I/O driver.

To display the Setup dialog box, choose Setup from the Options   menu.

 

Templates Dialog Box
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The Templates dialog box contains three tabs, each of which contains   a settings template for either a 
server, group, or item.  The   Server template (tab) is automatically displayed first when the dialog   box is 
opened.  Each   template is described below

 l Server   Properties

 l Group   Properties

 l Item   Properties
 

Setup Dialog Box

The Setup dialog box contains three tabs. The Display Setup tab is automatically   displayed first when 
the dialog box is opened. Each tab is described below:

Display Setup Tab

Server/Group Dialog

Specifies the primary refresh rate (in milliseconds) at which the I/O   driver, server, and group statistics 
are updated. 

Valid Entries

1000 ms to 60000 ms

Default Value

1 second (1000 ms).

NOTE: If you   specify a very fast refresh rate (for example, every 100 milliseconds),   other driver tasks slow 
down as the driver works to constantly refresh   statistics.

Item Dialog

Specifies the primary refresh rate (in milliseconds) at which the item   statistics are updated.

Valid Entries

1000 ms to 60000 ms

Default Value

1 second (1000 ms)

NOTE: If you   specify a very fast refresh rate (for example, every 100 milliseconds),   other driver tasks slow 
down as the driver works to constantly refresh   statistics.

Secondary Rate

Specifies the refresh rate that will be used if an error is received   from the server. The primary (server-
/group or item) refresh rate is ignored   and the refresh rate entered in this field is used. The refresh will 
continue   at the secondary refresh rate until communication succeeds. The refresh   will then auto-
matically switch to the primary refresh rates.

Valid Entries

5000 ms to 360000 ms
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Default Value

60 seconds (60000 ms)

Default Path Tab

Default Configuration File Name

Specifies the default I/O driver configuration file. This is the file   that the server loads on start-up.

Default Path for Configuration File

Specifies the default path for the driver’s configuration file. If the   server does not find the default con-
figuration file in this path, it creates   a new, empty configuration file.

Default iFIX PDB Tag Auto-creation File   Name

Specifies the default name for the driver’s log file. A log file will   be created automatically with the name 
you specify, that records all actions   that you perform to add tags to the iFIX Process Database from the 
OPC   Client driver.

NOTE: Changes   made to the Default iFIX PDB tag auto-creation log file name do not take   effect until the OPC 
Client driver is restarted.

The log file contains the following fields and is in .CSV format:

Field Description
Date and Time The date and time the action was performed.
Tag Information Displays the tag name, the tag description, and the   tag I/O address.
Status Success or Failed. If the status is failed, the error   code is recorded.

Stop SAC on File Open

Lets you stop SAC (the Scan, Alarm and Control program) when opening   an OPC Client configuration. 
Typically, SAC continues running when you   open or load an OPC Client configuration. However, we 
recommend stopping   SAC prior to loading an OPC Client configuration if:

 l You are loading a   large OPC Client configuration.

 l You are connecting   to a slow OPC server.

 l You are connecting   to the OPC Client remotely.

Advanced Tab

Maximum Size

Specifies the maximum amount of memory that the OPC Client requires.   The amount of memory spe-
cified is allocated and reserved but not committed   until needed. The number is rounded up from the value 
you enter to the   nearest value supported by your operating system.

Do not modify this field unless instructed to do so by GE Customer   Services personnel.

Valid Entries

Value in bytes

Default Value

10000000 bytes
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Growth Increment

Specifies the increment that I/O driver memory grows by when more memory   is needed. The OPC Cli-
ent rounds up the value you enter to the nearest   value supported by your operating system. 

Do not modify this field unless instructed to do so by GE Customer   Services personnel.

Default Value

4095 bytes

Overrun Buffer

Specifies an area of memory that immediately follows driver main memory   (defined by the Maximum 
Size field). The OPC Client rounds up the value   you enter to the nearest value supported by your oper-
ating system. If   you try to access memory in this area, an error is generated. You will   also experience 
problems with your driver if your system attempts to use   memory in the overrun buffer.

Do not modify this field unless instructed to do so by GE Customer   Services personnel.

Default Value

4095 bytes

Authentication Level

Specifies the default authentication level for the connection between   the Power Tool and I/O Server, and 
the connection between the I/O Server   and OPC server. 

Valid Entries

Authentication 
Level

Configures

None No client authentication or verification.
Connect The OPC server to prompt for a user name and password.   After you enter 

this information, the remote server verifies it and establishes   a connection 
with the OPC Client. If the server cannot verify the user   name and password, 
no connection is made.

Impersonation Level

Specifies the impersonation level given to the remote server by the   client. If the remote server does not 
require impersonation of the client,   then this setting is ignored. 

Valid Entries

Impersonation 
Level

Configures

Identify The server application to verify the identity of the client.
Impersonate The server application to impersonate the client application   only by per-

forming processing tasks as the client application. The server   application can 
impersonate the client application only on the computer   running the server 
application.
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Path to Signal Conditioning DLL

Specifies the path to the DLL that provides signal conditioning for   the OPC Client. Do not make entries 
in this field unless you are having   problems finding the signal conditionings.

Default Value

OPCSIG.DLL

Path to Error Resource DLL

Specifies the path to the DLL that provides all the error codes and   text error messages for the OPC Cli-
ent. Windows also uses this DLL to   provide messages to the Event Viewer.

Do not modify this field unless instructed to do so by GE Customer   Services personnel.

Default Value

OPCERR.DLL

Auto Create

Off

When selected, prohibits you from creating servers, groups, and items   automatically from within iFIX. If 
this option is selected, you must use   the Power Tool to create servers, groups, and items.

NOTE: Whenever   you enable or disable the Auto Create option, close all remote connections   and restart the 
Power Tool in order for your changes to take effect.

On

When selected, allows you to create servers, groups, and items automatically   from a client application, 
such as Process Database. When the client application   attempts to access a non-existent object, the 
OPC Client automatically   creates a new server, group, or item.

Default Value

On

NOTES: 

 l Whenever you enable or   disable the Auto Create option, close all remote connections and restart   the 
Power Tool in order for your changes to take effect.

 l You cannot auto create   an item with data array support enabled.

Auto Enable

Off

When selected, prohibits the OPC Client from enabling any server, group,   or item that is automatically 
created. This feature allows you to import   a database without enabling any objects. Later, you can go 
back and manually   enable any objects you want.

On

When selected, the OPC Client automatically enables any server, group,   or item that is created with the 
Auto Create option. Auto Create lets   you create servers, groups, and items automatically from a client 
application,   such as Process Database. When the client application attempts to access   a non-existent 
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object, the OPC Client automatically creates a new server,   group, or item. Using the Auto Enable 
option, the OPC Client enables the   object when it is created.

Auto Start

Off

When selected, prohibits the OPC Client from collecting data automatically.   As a result, you must start 
the driver yourself, or use iFIX to start   it for you.

NOTE: Whenever   you enable or disable the Auto Start option, close all remote connections   and restart the 
Power Tool in order for your changes to take effect.

On

When selected, the OPC Client automatically polls the process hardware   for data. When you set up the 
OPC Client to run as a service, this option   lets the driver collect data immediately on start-up.

NOTE: Whenever   you enable or disable the Auto Start option, close all remote connections   and restart the 
Power Tool in order for your changes to take effect.

Enable Children

When selected, all the children of any object are enabled when you enable   the parent object. The chil-
dren are the objects under the parent object   in the Tree Browser. For example, the groups of a server are 
the server’s   children. Using this check box, you can enable of all the server’s groups   and all of its items 
when you enable the server. 

Disable Floating Point Checks

When selected, the driver does not check the format of floating point   values returned from the OPC 
Server. This is a global setting, and remains   set until you clear the check box, or the driver is re-installed. 

By default, this check box is cleared. When cleared, the driver will   check the format of the floating point 
values returned from the OPC Server   and generate errors for invalid floating point values. 

 
 

Set the Statistics Refresh Rates

 To set the statistics refresh   rates:
 1. From the Options   menu, choose Setup. The Setup dialog box appears.

 2. Select the Display   Setup tab.

 3. In the Server/Group   Dialog field, enter the refresh rate for the server and group levels.

 4. In the Item Dialog   field, enter the refresh rate for the item level.

Valid refresh rates for the Item and Server/Group   levels are between 1000 and 60000. Valid   
refresh rates for the Secondary rate are between 5000 and 360000.

 5. In the Secondary   Rate field, enter the secondary refresh rate.

The secondary refresh rate is used if an   error is received from the server. The primary (server-
/group or item)   refresh rate is ignored and the refresh rate entered in this field is   used.
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NOTE: System   and channel (Server) statistics have a different update rate than the   datablock (Item) because 
the statistics at the server level do not change   as often as at the item level.
 

Set Defaults for I/O Driver Configuration File Name and Path

The default path for the configuration file is the same path where you   installed the I/O server. The OPC 
Client requires you to specify the default   path and file name when you automatically start the driver.

 To set the default configuration   file name and change the default path:
 1. From the Options   menu, choose Setup. The Setup dialog box appears.

 2. Select the Default   Path tab.

 3. Enter the configuration   file’s default name and default path in the boxes provided.

NOTES: 

 l A default configuration   file named nodename.OPC is saved in the root iFIX or Dynamics directory   
when you install the driver. Do not overwrite, rename, or modify this   file. iFIX uses this file to load the 
driver.

 l If you change the name   of your SCADA server after installing the OPC Client, iFIX cannot auto-
matically   start the driver because the name of the node does not match the name   of the configuration 
file. To correct this, rename the configuration file   to match the name of the SCADA server. For 
example, if you change the   name of the SCADA server from SCADA1 to SCADA9, rename the con-
figuration   file SCADA1.OPC to SCADA9.OPC.

 

Make Advanced Settings

You can make more detailed settings for your driver using the Advanced   tab in the Setup dialog box. 

CAUTION: Advanced   settings are for fine-tuning your driver and should not be changed unless   you have an 
intimate knowledge of how the driver operates and know that   you need to make some adjustments.

 To make advanced driver settings:
 1. From the Options   menu, choose Setup. The Setup dialog box appears.

 2. Select the Advanced   tab.

 3. Complete the Advanced   setup by making selections for the following parameters:

 l Authentication   Level

 l Impersonation   Level

 l Auto Create

 l Auto Enable

 l Auto Start

 l Enable Children

 l Disable Floating   Point Checks
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I/O Driver Server Connection Dialog Box

The I/O Driver Server Connection Dialog Box is where you can configure...

Use Local OPC Client Driver

When selected, allows you to connect to the OPC I/O Server on the local   node.

Use Remote OPC Client Driver

When selected, allows you to connect to the OPC I/O Server on a remote   node. You should know the 
name of the computer that the OPC I/O Server   resides on. 

 To connect to a remote machine, use   one of the following three methods:

 l Enter the remote   server’s name in the Remote Machine Name or TCP/IP Address box.

 l Enter the remote   server’s TCP/IP address in the Remote Machine Name or TCP/IP Address 
box.

 l Select a remote server   from the Network list box. The server’s name automatically appears in   the 
Remote Machine Name or TCP/IP Address box.

The remote server name may not be the same as its iFIX node name.

NOTE: The remote   server connection refers to the OPC Client Power Tool’s connection to   the OPC Client’s 
I/O Server. It has nothing to do with connecting the   OPC Client to remote, third-party OPC servers.

Remote Machine Name or TCP/IP Address

Specifies the remote server's computer name or TCP/IP address. If you   know the name or address of 
the remote server, you can enter it directly   in the field. Otherwise, you can browse the network using the 
Network   list box and select the appropriate computer.

Network List Box

Displays all the computers on the local network. These nodes are not   all servers. You should know 
which computer the OPC I/O Server that you   want to connect to resides on.

Show This Dialog On Startup

When selected, the I/O Driver Server Connection dialog box displays   when you start the Power Tool. If 
you select this check box, the I/O Driver   Server Connection dialog box displays every time you start the 
Power Tool,   letting you make changes to your driver configuration. 

If you clear the check box, the I/O Driver Server Connection dialog   box does not display when you start 
the Power Tool. If you plan to always   use the same I/O Server, clearing the check box spares you from 
having   to click Connect every time you start the Power Tool.

If you clear the check box and then change your mind, you can configure   the Power Tool display the I/O 
Driver Server Connection dialog box by   editing its INI file. This file resides in your Windows folder and is   
called OPCDidw.INI. 
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 To edit the INI file:

 1. Exit from the Power   Tool.

 2. Open the INI file   with a text editor such as MS Notepad.

 3. Change the line ShowOnStartup=FALSE to ShowOnStartup=TRUE

 4. Save the file.

The next time you start the Power Tool, the dialog box appears.

Connect

Connects you to the I/O Server you have selected. The server can be   local or remote.
 

Set Up the OPC I/O Driver Server Connection

Click the following links for detailed process information:

 l Connecting   to the server on the local machine

 l Connecting   to the server on a remote machine

The Power Tool is a client of the OPC I/O Server. The I/O Server maintains   the driver's server, group, 
and item objects and performs all required   functions for communicating with the process hardware. The 
Power Tool   accesses the I/O Server and lets you view and modify OPC server, group,   and item prop-
erties.

The I/O Driver Server Connection dialog box displays when you first   start the Power Tool. This dialog 
box lets you choose whether to set up   the Power Tool to communicate with a Local   I/O Server (on your 
computer) or a Remote   I/O Server (a computer on the network). If you choose a remote   I/O Server, you 
must enter or select the remote machine name or address.   

 To connect   to the server on the local machine:
 1. Start the Power Tool;   or, if it is already running, choose OLE Server from the Options menu.   The 

I/O Driver Server Connection dialog box appears.

 2. Select the Use Local   OPC Client Driver option and click Connect. 

The Power Tool attempts to connect to the   local server. If the connection is successful, the Con-
nection dialog displays   the message Connection Established and then the main window of the 
Power   Tool displays. If the connection is not successful, the Connection dialog   box displays the 
message Connection Not Established and you receive the   following message:
Connection to the selected server has failed. Do you want to select another server? 

 3. Click Yes if you   want to try connecting to a remote server. If you cannot connect to the   local 
server, there is a problem with the server start-up. Refer to Using Event Viewer for details about   
how to display any errors that the server may have generated.

 To connect   to the server on a remote machine:
 1. Start the Power Tool;   or, if it is already running, choose OLE Server from the Options menu.   The 

I/O Driver Server Connection dialog box appears.
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 2. Select the Use Remote   OPC Client Driver option and enter the remote machine name or TCP/IP 
address   in the Remote Machine Name or TCP/IP Address box. You must enter the machine   
name or address exactly. If you do not know the exact machine name, select   it using the Net-
work list box.

If the connection is successful, the Connection   dialog displays the message Connection Estab-
lished and then the main window   of the Power Tool displays. If the connection is not successful, 
the Connection   dialog box displays the message Connection Not Established and you receive   
the following message:
Connection to the selected server has failed. Do you want to select another server? 

 3. Click Yes if you   want to try another server. If you cannot connect to the machine that   the server 
is on, you may not have an account to that machine or your   DCOM settings may be incorrect. 
Refer to How   do I Set up Security for using the I/O Server Remotely for more information.

 4. Select the Show this   Dialog on Startup check box to display the I/O Driver Server Connection   dia-
log box every time you start the Power Tool.

 To change the OPC I/O Server connection:
 1. From the Options   menu, choose OLE Server. The I/O Driver Server Connection dialog box 

appears.

 2. Change the settings.
 

Set the I/O Server for Automatic Connection

 To set your I/O Driver Power   Tool to connect automatically to the I/O Server on 
either a local or remote   machine:

 1. From Windows Explorer,   open your iFIX folder, typically C:\Program Files (x86)\Proficy\iFIX,   and 
select OPCDIDW.EXE.

 2. Create a shortcut   by right-clicking the mouse and selecting Create Shortcut from the menu   dis-
played.

 3. Right-click the new    shortcut and choose Properties. 

 4. Select the Shortcut   tab.

 5. In the Target box,   append one of the following command line parameters after OPCDIDW.EXE,   
as shown in the following examples:

Connection Type Command Line Parameters Example
Remote /N remote_machine_name OPCDIDW.EXE /N Jake
Remote /N remote_ip_address OPCDIDW.EXE /N 199.103.251.114
Local /L OPCDIDW.EXE /L

This setup suppresses the I/O Driver Server   Connection dialog box on Power Tool start-up. This 
is a good practice   if you plan to always use the same server on the same computer.

 

Server Event Log Dialog Box
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Maximum Number of Messages

Lets you enter the maximum number of messages stored in the Server’s   event log. By default, the 
server stores 250 messages.

Valid Entries

0 to 2147483647
 

Configure the I/O Driver

Click the following links for more information about configuring the   I/O Driver:

 l Configure   the I/O Driver with the Power Tool

 l Configuring   from iFIX Applications

 l Use   I/O Driver Report Files

Configure the I/O Driver with the Power Tool

Click the appropriate link for more information   regarding configuring the I/O Driver:

 l OPC   Server Browse Methods

 l Server   Properties

 l Group   Properties

 l Item   Properties

 l Datablock   Browser Dialog Box

 l Database   Tag Dialog Box

 l Device   Browser Dialog Box

 l Find   Dialog Box

 l Network   Browser Dialog Box

 l Select   an OPC Server Dialog Box

 

OPC Server Browse Methods

The OPC Client uses various methods for browsing local and remote machines   for OPC servers.

Browsing OPC Servers on the Local Machine

When browsing for OPC servers on the local machine, three methods can   be used:
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 l OPCEnum.exe - this   is a tool provided by the OPC Foundation that helps clients browse local   or 
remote machines. The OPC Client installs this utility on your local   machine as part of the product 
installation.

 l Browse the Windows   Registry for OPC servers.

 l By CategoryID - any   OPC 1.0 and 2.0 server that is registered with the Windows StdCom-
ponentCategoriesMgr   as an OPC 1.0 or OPC 2.0 CATID Server displays with this method. This   
method is not supported for use with remote machines.

Browsing OPC Servers on a Remote Machine

When browsing for OPC servers on a remote machine, two methods can be   used:

 l OPCEnum.exe - this   is a tool provided by the OPC Foundation that helps clients browse local   or 
remote machines. The OPC Client installs this utility on your local   machine as part of the product 
installation.

 l Browse the Windows   Registry for OPC servers. You must have Administrator rights to be able   to 
do this on a remote machine.

All servers that are found using any of the above methods are displayed   in this list.

Browse Failure

If no servers were found on the machine, the message "No servers   were found on the machine" dis-
plays. You must then verify that either   the correct machine name/TCP/IP address was entered in the 
previous page   or that the OPC server(s) are correctly installed on the given machine.

If one or more methods fail, a message box displays indicating the methods   used and which ones suc-
ceeded or failed. It also displays an error message   indicating the reason for failure, as returned by the 
system. Any server(s)   found are listed. You can select a server from the list or remedy the   reason for the 
failure and rerun the search.

One possible remedy includes modifying your DCOM settings, even if your   OPC server is running loc-
ally. For information about modifying your DCOM   settings, refer to How   do I Set up Security for using 
the I/O Server Remotely.

IMPORTANT:   If you are browsing OPC servers on a local or remote machine, then OPCENUM   must reside 
and be registered on that machine for browsing to work correctly.   While most OPC server applications install 
and register this file, some   may not. You can download this file from www.opcfoundation.org.   Currently, it is 
contained within the OPC Core Components 2.00 Redistributable   2.30.msi file. After you download the file, 
run the .msi program and follow   the instructions on screen to install it. You must do this on each of   the local or 
remote machines you intend to browse.

 

I/O Driver Properties

You can view the driver name and the number of servers, groups, and   items configured for the driver by 
selecting the driver icon in the Tree   Browser and then choosing Configuration Mode from the Display 
Mode menu.   The following is a list of configuration properties that display for the   driver:

Name

Displays the name and version number of your OPC driver.
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Number of Servers

Displays the number of servers configured for the driver. 

Number of Groups

Displays the total number of groups configured on all servers for the   driver.

Number of Items

Displays the total number of items configured for all groups on all   servers for the driver.

 

Server Properties

NOTE: The following   fields and descriptions are identical in both the Server template (in   the Templates dialog 
box) and the Server information displayed in the   Properties Viewer when in Config Mode.

Server Name

Specifies the name of the selected server. You can use this name as   a shortcut in place of the OPC 
server’s Prog ID when adding a database   block. Do not assign the same name to more than one server. 
The server   name must be unique across all servers, groups, and items.

Valid Entries

Up to 30 alphanumeric characters, including underscores ( _ ) and hyphens   ( - ).

Server Enable Check Box

When selected, the driver is connected to the OPC server and the driver   is enabled for polling. If you 
clear the check box, the driver is disconnected   from the OPC server and all of the server’s groups and 
items are disabled   and are not polled.

Description

Specifies user-defined comments about the selected server. Such descriptions   can be very helpful 
when you go back to look at old configuration or report   files, or when you need to modify an existing con-
figuration. The more   detailed and specific the information you enter in this field, the easier   it is to identify 
the server.

Valid Entries

Up to 40 alphanumeric characters and symbols.

ProgID

Specifies the Programmatic ID for the selected OPC server. The Prog   ID is a vendor-specific string 
used by the driver to connect to the OPC   server. This field cannot be modified.

OPC Server Connection Setup

Server Location

Specifies the connection method to the OPC server. 

Valid Entries
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Select this connection method... When the OPC server resides on...
Local The local computer.
Remote A remote node on your network.

If you choose Remote, the Machine Name field becomes available and the   Browse Network button 
appears.

Machine Name

Specifies the machine name or TCP/IP address of a remote OPC server.   This field is available only if 
you select Remote from the Server Location   list.

Browse Network

Click to browse your local network for a remote server name.

OPC Persist Settings

Save on Disconnect

When selected, the current OPC server settings are saved to a file when   the OPC Client shuts down. If 
you clear the check box, the server’s settings   are not saved. If you select this check box the File Name 
box appears   and is available.

NOTE: The OPC   server must support the IPersistFile interface if you select this check   box.

File Name

Specifies the file name containing the OPC server settings. The driver   saves this file when it shuts 
down. If you do not enter a file name, the   driver saves the settings to the file currently loaded by the OPC 
Server.   This parameter is available only if you select the Save on disconnect   check box.

Client Settings

Send Messages to Event Window

When selected, asynchronous run-time messages are sent to the I/O Server’s   Event Window. For 
example, asynchronous updates (exceptions) and synchronous   timeouts received from the OPC server 
are sent to the Event Window when   you select the check box. 

You can display the Event Window by selecting Event Window from the   Options menu.

FIX DBB I/O Address Delimiter

Specifies the delimiter used by the I/O Server in order to parse I/O   addresses entered in iFIX Process 
Database. Different OPC servers use   different delimiters to parse the fields of their item IDs. For 
example,   if the item ID uses a colon as a delimiter, then the Process Database   delimiter must be some-
thing other than a colon. The default value is the   semicolon ( ; )

Valid Entries

Colon :
Comma ,
Semicolon ;
Forward slash /
Back slash \

      

Group Properties
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NOTE: The following   fields and descriptions apply to both the Group Properties Viewer and   the Group tem-
plate.

Group Name

Specifies the name of the selected group. Any application requesting   data from the I/O driver uses this 
name to access items in the group.   Each group that the driver communicates with should have a unique 
name   across all servers, groups, and items.

Valid Entries

Up to 30 alphanumeric characters including underscores ( _ ) and hyphens   ( - ).

Group Enable Check Box

When selected, the driver is enabled to poll the selected group. If   you clear the check box, the selected 
group and its associated items are   not polled. 

You may want to disable one or more groups in the following situations:

 l You are swapping   hardware for repair or maintenance and do not want to display errors.

 l You do not need to   collect data from the items within a group and you want to reduce the   com-
munications load.

 l You want to isolate   a group for debugging.

Description

Specifies user-defined comments about the selected group. Such descriptions   can be very helpful when 
you go back to look at old configuration or report   files, or when you need to modify an existing con-
figuration that you did   not create. The more detailed and specific the information you enter in   this field, 
the easier it will be to identify the group at a later date.

Valid Entries

Up to 40 alphanumeric characters and symbols.

OPC Group Communications Settings

I/O Type

Specifies the communications method the driver uses to obtain data from   the OPC server.

Valid Entries

The I/O 
Type...

Enables the driver to...

Synchronous Poll the OPC server at regular intervals, according   to the specified poll rate.
Asynchronous Update items at regular intervals (when the asynchronous   watchdog is 

enabled) or on an exception basis when data has exceeded the   user-supplied 
percent deadband. We recommend using asynchronous I/O with   the asyn-
chronous watchdog disabled whenever possible because it provides   the least 
amount of communications overhead.

Data Source

Specifies where the OPC server will obtain data from when the OPC Client   issues a read request.

Valid Entries
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The data 
source...

Returns...

Cache The last value read by the OPC server. The server   updates the cache based on the 
group’s update rate.

Device The latest values from the process hardware. Reading   directly from a device can 
cause undue stress on your system. We recommend   this selection only for dia-
gnostic and troubleshooting purposes.

Update Rate

Specifies the rate at which the OPC server polls for data from the process   hardware and updates its 
internal cache. The rate you enter applies to   all items in the current group. 

Valid Entries

Accepts the time format: days:hours:minutes:seconds.milliseconds, within   the range of 0.1 to 
6:23:59:59.9. Entering 0 forces the OPC Server to   run at its maximum rate and increases CPU usage. 

In general, you need to balance CPU usage against an acceptable update   rate. For example, if CPU 
usage is 90% and you never want the CPU usage   to exceed 50%, enter a longer (larger) value here. 
However, if changing   the update value causes updates to be too slow for your application, you   will need 
to shorten the update rate to find the acceptable minimum value.

% Deadband

Specifies the maximum fluctuation in this group’s items that can be   tolerated before reporting the change 
(an exception) to the OPC Client.   Enter this value as a percentage of the full EGU range of the group’s   
items. 

Valid Entries

0 to 100

Example

Assume the full EGU range is 0 to 100 and the maximum fluctuation (the   deadband) is 5%. Using these 
values, if the current EGU value is 10, the   new value must exceed 15 or fall below 5 before the OPC 
server reports   an exception. However, if the full EGU range is 0 to 200, the new value   must exceed 20 or 
fall below 0 before an exception is reported.

The OPC server uses the following formula to determine whether an exception   has occurred:

absolute value(last cached value – current) > Percent Deadband * (High EGU – Low EGU)

When this formula is true, the server reports an exception and updates   its cache. When the formula is 
false, it takes no action. 

NOTE: The exact   implementation of this feature differs from server to server. Refer to   your server’s doc-
umentation to learn the EGU range used by the server.

Client Communications Settings

Poll Rate

Specifies the rate at which the driver polls the OPC server for the   selected group’s items. The time range 
for poll rates is different for   synchronous and asynchronous I/O types.

Valid Entries
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Accepts the time format: days:hours:minutes:seconds:subseconds. For   synchronous, the range is from 
00:00:00:00.00 to 6:23:59:59.9. For asynchronous,   the range is from 00:00:00:30.0 to 6:23:59:59.9. For 
more information,   see Zero and Subsecond Poll   Rates.

Enable Asynchronous Watchdog

When selected, the OPC Client refreshes the selected group’s items at   the interval specified by the Poll 
Rate. This check box is available only   when you select Asynchronous from the I/O Type list.

The asynchronous watchdog does not override the item’s access time.   Consequently, when the access 
time expires, the watchdog stops.

Async Timeout

Specifies how much time the OPC Client waits for an asynchronous update   from the OPC server. When 
a timeout occurs, the OPC Client sets the quality   of all items waiting for data to Uncertain, Last Usable 
because the quality   of the data is no longer known. This setting is available only when you   select Asyn-
chronous from the I/O Type list.

By default, the driver waits 10 seconds (10000ms).

Valid Entries

250 to 2,147,483,647 milliseconds (over 24 days)

Item Properties

NOTE: The following   fields and descriptions apply to both the Item Properties Viewer and the   Item template.

Item Name

Specifies the name of the selected item. You can use the name of the   item interchangeably with its ID 
when entering I/O addresses in Process   Database. However, item names must be unique across all 
servers, groups,   and OPC items.

Valid Entries

Up to 30 alphanumeric characters including underscores ( _ ) and hyphens   ( - ).

Item Enable Check Box

Enables the OPC Client to poll the item when you select this check box   and the driver is connected to 
the item’s OPC server. If you clear the   check box, the item is disabled and not polled. 

You may want to disable one or more items in the following situations:

 l You want to remove   the item from the OPC server.

 l You want to take   the process hardware that the item is referencing off-line for servicing   and you 
do not want to see any errors.

 l You want to isolate   the item for debugging.

Description

Specifies user-defined comments about the selected item. Such descriptions   can be very helpful when 
you go back to look at old configuration or report   files, or when you need to modify an existing 
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configuration that you did   not create. The more detailed and specific the information you enter,   the easier 
it will be to identify the item at a later date.

Valid Entries

Up to 40 alphanumeric characters and symbols.

OPC Item Settings

Item ID

Specifies the fully qualified ID for this item and describes the properties   of the data point that you want to 
read. For example, an item ID can contain   addressing parameters, engineering units, and scaling prop-
erties. 

Valid Entries

The format of the item ID is specific to each OPC server. Refer to your   OPC server documentation for 
more information.

If your OPC server supports browsing, you can click the Browse Server   button and select the item you 
want. The Power Tool updates the Item ID   field with the item you select. For more information about 
browsing an   OPC server, refer to How   do I browse an OPC server?

You cannot modify this setting while the item is enabled.

Access Path

The access path is a vendor-specific method used to inform the OPC server   of the path to use when 
retrieving data for the current item. 

Example

Suppose you have two devices connected to COM1. One device is connected   by radio. The other is con-
nected using TCP/IP. In this configuration,   possible access paths might be RADIO and ETHERNET.

NOTE: Not all   OPC servers support access paths. If your OPC server does not use access   paths, you can 
leave this setting blank. Consult your OPC server documentation   for more information.

Item Start

Specifies the starting address of the data array. This setting is available   only if the Array check box is 
selected.

Valid Entries

0 to 32767

Example

Item ID: Sign_Int_Array[10],L200

This item id defines a 200-element array of integers at address 10.

You cannot modify this field while the item is enabled.

NOTE: The starting   address plus the array length minus 1 (start + length-1) must be less   than or equal to 
32767 for Process Database to be able to access all elements   of the array. For example, you cannot create 
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an array starting at 32700   with a length of 100 and have Process Database access all elements in   the array. 
Instead the array must start at 32667 or must have a length   of 67.

Item Length

Specifies the number of values stored by the data array. This setting   is available only if the Array check 
box is selected.

Valid Entries

1 to 1000

Example

Item ID: Sign_Int_Array[0],L200

This item id defines a 200-element array of integers at address 0.

The length of the array defined in the OPC Client must match the length   of the array defined in the OPC 
server. If the lengths of both arrays   do not match, the OPC Client sets the data quality of the item to 
BAD.   

You cannot modify this field while the item is enabled.

NOTES: 

 l The starting address   plus the array length minus 1 (start + length-1) must be less than or   equal to 
32767 for Process Database to be able to access all elements   of the array. For example, you cannot 
create an array starting at 32700   with a length of 100 and have Process Database access all elements 
in   the array. Instead the array must start at 32667 or must have a length   of 67.

 l Your OPC server may not   support arrays with 1000 elements. In this case, you may need to reduce   the 
size of the data array for the item you are creating and break up   the data into multiple items.

Array

When selected, the current item is configured as a data array. A data   array is a set of contiguous data of 
the same data type. By configuring   an item as a data array, you enable the OPC Client to read multiple 
values   from an OPC server, if the server supports data arrays. Reading multiple   values with a single 
item simplifies the driver configuration and improves   driver throughput.

To configure the item to hold a single value only, clear this check   box.

You cannot select or clear this check box while the item is enabled.

Requested Datatype

Specifies the item’s default data type. The driver uses this data type   for the item if you do not specify a 
database block hardware option. When   a hardware option is specified, it overrides the data type. The 
hardware   option can be changed only when the item is disabled.

Valid Entries

Data 
Type

Description

Byte Unsigned 8-bit character.
Boolean Digital value, 0 or 1.
Double Double-precision 64-bit floating point value.
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Float Single-precision 32-bit floating point value.
Long Signed 32-bit integer.
Server OPC Server specific native (canonical) data type.   Consult your OPC server vendor 

or documentation to determine the native   data type for the specified item ID.
Signed Signed 16-bit integer.
String ASCII string.
Unsigned Unsigned 16-bit integer.

NOTES:

 l Your OPC server may not   support all data types supported by the driver. Consult your OPC server   doc-
umentation to determine supported data types.

 l When data array support   is enabled for an item, the data type is an array of the selected data   type. For 
example, if the selected data type is Float and data array support   is enabled, the data type is an array 
of floats. Data arrays support boolean   and numeric (integer and float) data types. Arrays of strings are 
not   supported.

Browse Server

Opens the Browse OPC Server dialog box where you can browse an OPC server   to select an item ID 
and access path to assign to the selected item. You   can also use this dialog box to auto-create iFIX pro-
cess database tags.   

Client Settings

Disable Outputs

Prevents output from the OPC Client to the selected item when you select   this check box.

You may want to disable outputs:

 l To prevent control   outputs that may be hazardous to someone performing maintenance or repair   
on the process control hardware.

 l To prevent erroneous   writes to the item.

 l To isolate a datablock   for debugging.

Latch Data

Controls what an operator sees in a link when a communication error   occurs. 

When you... The operator sees...
Select the check box The last good value in the link.
Clear the check box A series of question marks (?????)

In iFIX applications, the link’s current alarm status changes always   displays COMM to indicate a com-
munication problem.

NOTES: 

 l FIX 6.15 does not support   latched data. However, you can add support for latched data by down-
loading   the SAC Software Improvement Module (SIM) from GE’s web site.

 l Analog Register and Digital   Register blocks do not support latched data. Consequently, we do not 
recommend   using these blocks with the Latch Data option.

Enable Block Writes

When selected, all outstanding writes for the current item are sent   to the process hardware.
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When the driver sends its outstanding writes for a data array, it also   sends any unmodified values in the 
array using the last known value.

Exception Deadband

Specifies the maximum acceptable data fluctuation in an exception-based   iFIX database block. Entering 
a deadband value prevents the database block’s   current value from changing when there is only a slight 
fluctuation in   data.

NOTE: The exception   dead band is used only for synchronous I/O.

Valid Entries

Any positive number for analog items. For digital items, set the deadband   to 0.

Example

Suppose the current value of an item is 50 and you set a deadband of   20, SAC updates the exception-
based database block when an incoming value   is less than or equal to 30 or greater than or equal to 70.

 To create an exception-based iFIX   database block:

 1. Start iFIX Process   Database.

 2. From the Blocks menu,   choose Add.

 3. Select the type of   block you want to create.

 4. Enter E in the Scan   Time field.

Access Time

Specifies how long the OPC Client keeps an item active in the OPC server   when your process control 
software no longer requests data from that item.

Whenever your process control software requests data from an item, the   OPC Client resets the access 
time for that item and the item remains active   in the OPC server. After data requests stop for the item 
and the access   time expires, the OPC Client sets the item to inactive in the OPC server.   When the item 
is inactive, the OPC server stops polling the process hardware   for that data. Consequently, if the item 
has an asynchronous watchdog   enabled, the watchdog also stops when the access time expires.

The actual implementation for setting an item to inactive is OPC server   specific.

Valid Entries

Accepts the time format: days:hours:minutes:seconds,   up to a maximum of 6:23:59:59

Example

To specify an access time of... Enter...
1 second 1
1 minute 1:00
1 hour and 30 minutes 1:30:00
2 days 2:00:00:00

NOTE: You can   force the OPC Client to never deactivate an item by entering DISABLED   in this setting.

 

Datablock Browser Dialog Box
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The Datablock Browser Properties Viewer is where you can configure Datablock   Browser properties.

Item IDs and Access Paths

Item IDs Browser

Displays the item IDs for every OPC server installed on the local computer.   Use the plus and minus but-
tons to expand and collapse the list.

Access Paths Browser

Displays all available access paths for the selected item ID. Use the   plus and minus buttons to expand 
and collapse the list.

NOTE: Not all   OPC servers support access paths.

Item ID

Specifies the fully qualified item ID that you want to use. You can   also complete the setting by browsing 
the OPC server. After you select   an item ID and click OK, the Power Tool completes the item’s Item ID 
field.

Access Path

Specifies the access path that you want to use. You can also complete   the setting by browsing the OPC 
server. After you select an access path   and click OK, the Power Tool completes the item’s Access Path 
field.

If you do not want to include an access path, you can leave this field   blank. 

iFIX Process Database Tag

Enable iFIX PDB Tag Auto-creation

Enables the Tag Desc Prefix, iFix Database Tag Type, and Tag Name Prefix   settings to allow you to 
automatically create database blocks in, and   to add existing items to, the iFIX Process Database. 

If you select this check box on the Database Tag dialog box it will   also be selected on the Device 
Browser and Datablock Browser dialog boxes.

If you select this check box on the Device Browser dialog box it will   also be selected on the Database 
Tag and Datablock Browser dialog boxes.

If you select this check box on the Datablock Browser dialog box it   will also be selected on the Data-
base Tag and Device Browser dialog boxes.

iFIX Database Tag Type

Specifies the type of datablock you are creating. This setting is available   on the Database Tag, Device 
Browser, and Datablock Browser dialog boxes.   This setting is available only if the Enable iFix PDB Tag 
Auto-creation   check box is selected.

Valid Entries

 l AI – Analog Input

 l AO – Analog Output

 l DI – Digital Input

 l DO – Digital Output
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Tag Desc Prefix

Specifies the description of the datablocks you are creating. This setting   is available on the Database 
Tag, Device Browser, and Datablock Browser   dialog boxes. This setting is available only if the Enable 
iFix PDB Tag   Auto-creation check box is selected. 

By default, "AG-" is displayed. "AG-" is an acronym   for "Auto Generated" and indicates, in the iFIX Pro-
cess Database,   that the tag has been automatically generated. Adding AG- to the description   provides 
you with a way to search the iFIX Process Database for the tags   you created in the OPC Client Power 
Tool.

Valid Entries

Up to 40 characters.

Tag Name Prefix

Specifies the prefix of the datablocks that you are creating. This setting   is available on the Database 
Tag, Device Browser, and Datablock Browser   dialog boxes. This setting is available only if the Enable 
iFix PDB Tag   Auto-creation check box is selected.

NOTES: 

 l You cannot duplicate   tag names in the iFIX process database. When adding the same item with   a dif-
ferent tag type to the iFIX process database, you must add a Tag   Name Prefix to the item name.

 l Tag names must contain   only alphanumeric characters. A tag name containing non-alphanumeric 
characters   (e.g., *, ~) will prevent the tag from being added to the iFIX process   database.

Database Tag Dialog Box

The Database Tag Properties Viewer is where you can configure Database   Tag properties.

Enable iFIX PDB Tag Auto-creation

Enables the Tag Desc Prefix, iFix Database Tag Type, and Tag Name Prefix   settings to allow you to 
automatically create database blocks in, and   to add existing items to, the iFIX Process Database. 

If you select this check box on the Database Tag dialog box it will   also be selected on the Device 
Browser and Datablock Browser dialog boxes.

If you select this check box on the Device Browser dialog box it will   also be selected on the Database 
Tag and Datablock Browser dialog boxes.

If you select this check box on the Datablock Browser dialog box it   will also be selected on the Data-
base Tag and Device Browser dialog boxes.

iFIX Database Tag Type

Specifies the type of datablock you are creating. This setting is available   on the Database Tag, Device 
Browser, and Datablock Browser dialog boxes.   This setting is available only if the Enable iFix PDB Tag 
Auto-creation   check box is selected.

Valid Entries

 l AI – Analog Input

 l AO – Analog Output
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 l DI – Digital Input

 l DO – Digital Output

Tag Desc Prefix

Specifies the description of the datablocks you are creating. This setting   is available on the Database 
Tag, Device Browser, and Datablock Browser   dialog boxes. This setting is available only if the Enable 
iFix PDB Tag   Auto-creation check box is selected.

By default, "AG-" is displayed. "AG-" is an acronym   for "Auto Generated" and indicates, in the iFIX Pro-
cess Database,   that the tag has been automatically generated. Adding AG- to the description   provides 
you with a way to search the iFIX Process Database for the tags   you created in the OPC Client Power 
Tool.

Valid Entries

Up to 40 characters.

Tag Name Prefix

Specifies the prefix of the datablocks that you are creating. This setting   is available on the Database 
Tag, Device Browser, and Datablock Browser   dialog boxes. This setting is available only if the Enable 
iFix PDB Tag   Auto-creation check box is selected.

NOTES: 

 l You cannot duplicate   tag names in the iFIX process database. When adding the same item with   a dif-
ferent tag type to the iFIX process database, you must add a Tag   Name Prefix to the item name.

 l Tag names must contain   only alphanumeric characters. A tag name containing non-alphanumeric 
characters   (e.g., *, ~) will prevent the tag from being added to the iFIX process   database.

Device Browser Dialog Box

The Device Browser Properties Viewer is where you can configure Device   Browser properties.

Path

Displays all available access paths for the selected group. Use the   plus and minus buttons to expand 
and collapse the list. Select the path   you want to display the associated items in the Items list.

NOTE: Not all   OPC servers support access paths. 

Items

Displays ItemIDs for the selected path.

Number of Items Selected

Displays the number of items you selected in the Items list.

Filter

Specifies the information you want to use to filter the list of displayed   items. You can edit the filter, or 
select from the list. You can also   use wildcards (i.e., ? to represent a single character, or * to represent   
two or more characters). The maximum number of items in the filter list   is 10 and the list is cleared when 
you close the Power Tool.
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NOTE: The filter   is case sensitive. You must enter the item information exactly as it appears   in the Items list.

Filter Button

Use this button to filter the list of items based on the information   you specified in the Filter field.

iFIX Process Database Tag

Enable iFIX PDB Tag Auto-creation

Enables the Tag Desc Prefix, iFix Database Tag Type, and Tag Name Prefix   settings to allow you to 
automatically create database blocks in, and   to add existing items to, the iFIX Process Database. 

If you select this check box on the Database Tag dialog box it will   also be selected on the Device 
Browser and Datablock Browser dialog boxes.

If you select this check box on the Device Browser dialog box it will   also be selected on the Database 
Tag and Datablock Browser dialog boxes.

If you select this check box on the Datablock Browser dialog box it   will also be selected on the Data-
base Tag and Device Browser dialog boxes.

iFIX Database Tag Type

Specifies the type of datablock you are creating. This setting is available   on the Database Tag, Device 
Browser, and Datablock Browser dialog boxes.   This setting is available only if the Enable iFix PDB Tag 
Auto-creation   check box is selected.

Valid Entries

 l AI – Analog Input

 l AO – Analog Output

 l DI – Digital Input

 l DO – Digital Output

Tag Desc Prefix

Specifies the description of the datablocks you are creating. This setting   is available on the Database 
Tag, Device Browser, and Datablock Browser   dialog boxes. This setting is available only if the Enable 
iFix PDB Tag   Auto-creation check box is selected. 

By default, "AG-" is displayed. "AG-" is an acronym   for "Auto Generated" and indicates, in the iFIX Pro-
cess Database,   that the tag has been automatically generated. Adding AG- to the description   provides 
you with a way to search the iFIX Process Database for the tags   you created in the OPC Client Power 
Tool.

Valid Entries

Up to 40 characters.

Tag Name Prefix

Specifies the prefix of the datablocks that you are creating. This setting   is available on the Database 
Tag, Device Browser, and Datablock Browser   dialog boxes. This setting is available only if the Enable 
iFix PDB Tag   Auto-creation check box is selected.

NOTES: 
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 l You cannot duplicate   tag names in the iFIX process database. When adding the same item with   a dif-
ferent tag type to the iFIX process database, you must add a Tag   Name Prefix to the item name.

 l Tag names must contain   only alphanumeric characters. A tag name containing non-alphanumeric 
characters   (e.g., *, ~) will prevent the tag from being added to the iFIX process   database.

Find Dialog Box

The Find Properties Viewer is where you can configure Find properties.

Find What

Specifies the criteria you want to use to search the Tree Browser for   a group or item.

You can use an asterisk (*) as a wildcard character to assist in your   search.

Find Next

Click to search the tree browser for the group or item specified in   the Find What box.

Find Previous

Click to move backwards through the found objects.

NOTE: This button   is available only at the Item level.

Network Browser Dialog Box

The Network Browser Properties Viewer is where you can configure Network   Browser properties.

Network Tree Browser

Displays the computer names available on the local network. Use the   plus and minus buttons to expand 
and collapse the list. When you locate   the computer you want, select it and click OK.

Remote Machine

Specifies the name of a remote computer that you want to connect to.   You can also set this by browsing 
the network. After you select a remote   computer and click OK, the Power Tool completes the OPC 
server’s Remote   Machine Name field.

Select an OPC Server Dialog Box

The Select an OPC Server Properties Viewer is where you can configure   OPC Server properties.

Server List

Displays a list of all the OPC servers installed on the local computer.

Selected Server's Description

Displays the vendor-specific description of the selected OPC server.

Add and Modify Servers
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Click the following links for detailed process information.

 l Add   a local server

 l Add   a remote server

 l Modify   a server's properties

 l Select   a new server location

 To add a   local server to your driver configuration:

 1. From the Display   Mode menu, choose Config Mode.

 2. From the Edit menu,   choose Add Server. The Select an OPC Server dialog box appears, dis-
playing   a list of the OPC servers installed on the local machine.

NOTE:   If no servers are found, verify that the OPC server(s) you want to access   are properly installed 
on the local machine.

 3. Select the OPC server   you want to connect to and click OK. The Power Tool adds the server to   
the Tree Browser.

 4. In the Properties   Viewer, enter the properties for the new server. Edits to a property do   not take 
effect until you remove the focus (the cursor) from the field.

 5. Select the Enable   check box to enable communication for the server.

 To add a   remote server to your driver configuration:

 1. From the Display   Mode menu, select Config Mode.

 2. From the Options   menu, choose OLE Server. The I\O Driver Server Connection dialog box 
appears.

 3. Select Use Remote   OPC Client Driver to choose an OPC server installed on a remote machine.

 4. In the Remote machine   name or TCP/IP address field, enter the name or TCP/IP address of the   
remote computer.

- Or -

Browse the Network list and select the name   of the computer with the OPC server you want to 
use. The selected computer   name appears in the Remote machine name or TCP/IP address 
field.

 5. Click Connect. The   OPC servers installed on the remote machine display in the Tree Browser.

NOTE:   If no servers are found, verify that the OPC server(s) you want to access   are properly installed 
on the remote machine.

 6. If applicable, enter   or update the properties for the server. Edits to a property do not take   effect 
until you remove the focus (the cursor) from the field.

 7. Select the Enable   check box to enable communication for the server.

 To modify   an existing server’s properties:

 1. In the Tree Browser,   select the server you want to modify. 

 2. In the Properties   Viewer, edit the server’s properties as needed. If the Enable check box   is selec-
ted, clear and re-select the check box for the connection property   change to take effect. Changes 
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to other properties take effect immediately   after you remove focus (the cursor) from the current 
field.

 To select   a new server location:

 1. In the Tree Browser,   select the server you want to change the location for.

 2. Click the Select   Location button. The Select the Host Machine dialog box appears.

 3. Select Use Local   OPC Server to change from a remote machine to the local machine.

- Or -

Select Use Remote OPC Server change from   the local machine to a remote machine and either 
enter the machine name   or TCP/IP address or choose the remote machine from the Network list,   
then click OK. The following message displays:

The change will not occur until the next   time the driver connects to the OPC server. Would you 
like to disconnect   form the current server and reconnect to the remote node now?

 4. Click Yes to change   the location of the server. The OPC Server Location and Remote Machine   
Name fields on the Server Properties Viewer are updated accordingly.

NOTE: Having   the ability to change the server location is useful for configuring the   server offline; that is, 
without having to connect to the remote machine,   which may not be available. For example, you select the 
server on the   local machine and configure it, and when you are ready to access the remote   server, or when it 
becomes available, you change the server location to   the appropriate remote machine.

IMPORTANT:   When you change the machine location, the OPC Client Power Tool does not   check to ensure 
that the configured server exists on that machine. For   example, if the server does not exist at the new location, 
or you do not   have access rights, you will receive runtime errors when you start or   enable the server.

Add and Modify Groups

Click the following links for detailed process information.

 l Add   a new group

 l Modify   a group

 To add a new   group to your driver configuration:

 1. In the Power Tool's   Tree Browser, select the server that you want to add a group to.

 2. From the Display   Mode menu, choose Config Mode.

 3. From the Edit menu,   choose Add Group. The new group appears in the Tree Browser and the 
group   properties appear in the Properties Viewer. 

 4. Enter the properties   for the new group. Edits to a property do not take effect until you remove   the 
focus (the cursor) from the field.

 5. Select the Enable   check box to enable communication for the new group.

 To modify   an existing group:

 1. In the Power Tool's   Tree Browser, select the group you want to modify.

 2. In the Properties   View, edit the group’s properties as needed. If the group is connected   to the 
OPC server, it updates automatically after you remove the focus   (the cursor) from the current 
field.
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Add and Modify Items

Click the following links for detailed process information.

 l Add   a new item

 l Modify   an item

 To add a   new item to your driver configuration:

 1. In the Power Tool's   Tree Browser, select the group that you want to add an item to.

 2. From the Display   Mode menu, choose Config Mode.

 3. From the Edit menu,   choose Add Item. The new item appears in the Tree Browser and the fields   
for entering item properties appear in the Properties Viewer. 

 4. Enter the properties   for the new item. Edits to a property do not take effect until you remove   the 
focus (the cursor) from the field.

 5. Select the Enable   check box to enable communication for the new item.

 To modify   an existing item:

 1. In the Power Tool's   Tree Browser, select the item you want to modify. 

 2. In the Properties   Viewer, edit the item’s fields as needed. If the Enable check box is selected   and 
the OPC Client is connected to this item’s OPC server, changes to   the Item ID and Access Path 
fields are not allowed. Changes to other fields   take place immediately.

Add and Modify Item IDs from the Datablock Browser

 To add or modify an item ID   for your driver configuration:

 1. In the Power Tool's   Tree Browser, select the item you want to add or change an item for.

 2. If required, clear   the Enabled check box or choose Stop from the Display Mode menu to stop   the 
driver.

Changes to the Item ID and Access Path are   not allowed if the item is enabled and the driver is 
connected to the   selected item’s server.

 3. Click the Browse   Server button. The Browse OPC Server (Datablock Browser) dialog box 
appears.   

 4. In the Item ID’s   tree browser, expand the list(s) and select the item ID you want to add   to the 
group. The item ID appears in the Access Path tree browser.

- Or -

Enter the database block information in   the ItemID and Access Path fields.

NOTE:   The Access Path field can be left blank.

 5. Click OK. The selected   item ID and access path are displayed in the Properties Viewer.

 

Add Multiple Items
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 To add multiple items to your   driver configuration:

 1. In the Power Tool's   Tree Browser, select the group to which you want to add multiple items.

 2. From the Display   Mode menu, choose Config Mode.

 3. From the Edit menu,   choose Add Multiple Items. The Device Browser dialog box appears.

 4. In the Path list,   use the plus buttons to expand the server and display the available server(s)   and 
tag types.

 5. Select the tag type   you want to select multiple items from. The associated item IDs are displayed   
in the Items list.

 6. If applicable, use   the Filter to further limit the displayed item IDs.

 7. From the Items list,   select the first item you want to add to the group.

 8. Hold down the Ctrl   key and select the number of items you want to add to the group, or hold   down 
the Shift key and select a consecutive group of items. The number   of selected items is displayed 
in the Number of Items Selected box.

 9. Click OK. The Device   Browser closes and the number of items you chose are added under the 
selected   group in the Power Tool Tree Browser with the associated item IDs displayed   in the 
Item ID and Access Path boxes.

 10. To change the item   IDs of the added items, see Add and   Modify Item IDs from the Datablock 
Browser.

Add Existing Items to the iFIX Process Database

NOTE: This feature   is available only for iFIX version 3.0 or later. All tags added to the   process database are 
set to OFF scan. The initial value is displayed in   the iFIX Process Database as ????, however, the actual 
value is displayed   correctly after you have saved and reloaded the database.

The following conditions must be met to add existing items to the iFIX   process database:

 l iFIX must be running.   If iFIX is not running, a message is displayed.

 l The Enable iFix PDB   tag auto-creation check box must be selected.

 l The OPC Client driver   must be on the SCU list.

 To add an existing item to the   iFIX process database:

 1. From the Tree Browser,   select the item you want to add to the iFIX process database. 

 2. Click the Add Item   to iFIX Database button. The Database Tag dialog box appears.

 3. Select the Enable   iFix PDB Tag Auto-creation check box.

 4. From the iFIX Database   Tag Type list, choose the type of tag that indicates the item you are   
adding to the process database.

 5. In the Tag Desc Prefix   box, enter a brief description of the item you are adding. By default,   AG- is 
displayed. The description you enter is displayed in the Description   box.

 6. In the Tag Name Prefix   box, enter a prefix for the item you are adding. The prefix you enter   is dis-
played in the Tag Name box, preceding the displayed item name.

NOTE:   You cannot duplicate tag names in the iFIX process database. When adding   the same item 
with a different tag type to the iFIX process database,   you must add a Tag Name Prefix to the item 
name.
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Set Default Values for Server, Group, and Item Properties

You can enter defaults for driver, server, group, and item properties   by choosing Templates from the 
Options menu and displaying the Templates   dialog box.

The driver uses the defaults you enter when you:

 l Add addresses to   the driver configuration from iFIX Process Database or an OLE application

- Or -

 l Configure the driver   from the Power Tool.

The Power Tool stores the default driver, server, group, and item properties   in the registry of the com-
puter on which you installed the OPC I/O Server.   For example, if you run the Power Tool and connect to 
a server on another   computer, the default values you enter are written to the remote server.

Setting default values can significantly decrease I/O driver configuration   time. For example, if you have 
100 groups that have the same property   settings except for the group name, you can use the default set-
tings for   each group and modify the name field as needed.

Example: Group Defaults

Entering the following as group default values:

 l Group Name: Group

 l I/O Type: Asynchronous

 l Data Source: Cache

 l Update Rate: 05:00

Sets the registry on the server as shown below:
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NOTE: The Power   Tool saves Server defaults under the ChannelDefaults key, group defaults   under the 
DeviceDefaults key, and Item defaults under the DataBlockDefaults   key.

Configuring from iFIX Applications

Click the following links for more information regarding configuring   iFIX Applications:

 l Overview:   Create Items Inside iFIX Applications

 l Specify   the I/O Driver in iFIX Process Database

 l Specify   I/O Addresses in iFIX Process Database

 l Specify   Hardware Options in iFIX Process Database

 l Set   Up for Creating Items and Groups Automatically in iFIX Process Database

 l Signal   Conditioning in iFIX Process Database

Overview: Create Items Inside iFIX Applications

You do not have to use the OPC Client Power Tool to create all of the   driver items. If you have the right 
information, you can add items while   configuring your database in iFIX Process Database.
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To configure the driver from iFIX Process Database, you must know the   following information about the 
item that you want to add:

 l The three-letter   acronym for the driver. For the OPC Client, the acronym is OPC.

 l The OPC server’s   name or Prog ID to which you will add the item.

 l The group’s name   to which you will add the item. If you do not know the group name or you   want 
to add the item to a new group, specify a group name that does not   exist. The driver will auto-
matically create the group.

 l The item ID you want   to create.

 l The access path,   if needed.

Items are only automatically created for groups that already exist in   the Power Tool. Items and groups 
are automatically created for servers   that already exist in the Power Tool. Remember that the Device 
setting   in iFIX Process Database accepts the three-letter driver acronym. The   I/O Address setting uses 
the server and group names assigned in the Power   Tool followed by the item ID and access path. 

Refer to Enter   Driver Information in iFIX Process Database for details about entering   driver data in Pro-
cess Database for automatic item creation.

IMPORTANT: Always   stop any 7.x driver you have running before you import a database, reload   a database, 
or create multiple database blocks with the Generate command.   If you leave the driver running while you com-
plete any of these tasks,   the database may not load or import properly, or you may have to restart   iFIX or Pro-
cess Database.

 

Specify the I/O Driver in iFIX Process Database

The Driver setting in iFIX Process Database identifies the I/O driver   that the database block accesses. 
That is, the driver’s three-letter acronym.   The default for this field is the first driver listed in the Con-
figured   I/O Driver list box in the SCADA Configuration dialog box of the System   Configuration Utility 
(SCU). For the OPC Client, select OPC in this field.

 

Specify I/O Addresses in iFIX Process Database

You can specify the item address that the database block accesses in   the Process Database I/O 
Address setting. OPC I/O addresses typically   consist of the server name or Prog ID, a group name, and 
the item ID or   item name. The I/O address is specific to the driver. This setting is   not case sensitive.

OPC I/O addresses to items configured as data arrays require the syntax:

servername;groupname;itemid,length;accesspath;[address]

For more information about using this syntax, refer to Access   Data Arrays with a Database Block.

OPC I/O addresses to single items use the following syntax:

SERVER_NAME;GROUP_NAME;ITEM_ID [;ACCESS_PATH]
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Where:

 l SERVER_NAME   is the name of the OPC server defined in the Power Tool. You can   enter the serv-
ers Prog ID in place of the server name. If you enter a   Prog ID that does not exist in the drivers 
configuration, the driver adds   the OPC server to its configuration.

 l GROUP_NAME   is the name of the group that the item belongs to. If you enter a group   name that 
does not exist, the driver automatically adds the group to the   server.

 l ITEM_ID   is a fully qualified Item ID. If you enter an item ID that does not exist,   the driver auto-
matically adds the item to the group. If you are creating   a database block for an item that already 
exists, you can substitute the   item name for the item ID.

 l ACCESS_PATH   is a fully qualified access path for the given item ID. Specifying   an access path 
is optional because not all OPC servers require or support   their use. Access paths are OPC-
server specific. If no access path is   required, you can omit this portion of the address.

If you enter an I/O address that is not defined by a group and item   ID, the driver performs the following 
operations if you enabled the Auto   Create option:

 l Adds the group to   the server if the group does not exist.

 l Adds the item to   the group.

If you have not enabled the Auto Create option, Process   Database prompts you to start the Power Tool 
so that you can add the nonexistent   group or item to your driver configuration. You can then continue con-
figuring   the database block.

Refer to FIX DBB I/O Address Delimiter to determine valid delimiters   that can be used in Process Data-
base.

Event I/O Addresses

You can enter the following special addresses into the I/O Address field   of a Digital Output or Analog 
Output block to perform certain events:

 l !SWITCH:NAME

 l !MODE:NAME

 l !POLL:NAME

 l !SEND:ITEM

 l !START

Where NAME is the name of the   server, group, or item you want to perform the event on.

Special Address Events

!SWITCH Toggles between Asynchronous and Synchronous I/O communications   on groups. 
This address has no functionality for servers and items.

!MODE Enables polling to the server, group, or item specified   when a value of 1 is written 
to a Digital Output block. (Analog Output   blocks are not supported.) Disabling a 
specified object occurs when a   value of 0 is written to a Digital Output block.

!POLL Triggers a demand (one-shot) poll of:

 lA server and   all of its groups and items, 
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 lA group and all   its items, or 

 lA specified item   

when any value is written to the Digital Output or   Analog Output block.
!SEND Sends a special command to the specified item when   any value is written to a 

Digital Output block. The command is sent only   if the Block Writes option is 
enabled for the item and the item is configured   as a data array. The command 
instructs the driver to send the entire data   array in a single message to the OPC 
server. 

When the OPC Client sends the data array, it also   sends any unmodified values in 
the array using the last known value. 

You cannot use an Analog Output block to trigger block   writes.
!START Starts and stops the drivers I/O server. Writing a   value of 1 to a Digital Output or 

Analog Output block starts the driver.   Writing a value of 0 stops the driver.

Item Property I/O Addresses

In addition to event addresses, Text blocks also allow you to substitute   the following address for any 
item in the driver: 

 l !QUALITY:NAME

 l !TIME:NAME

Where NAME is the name of the   item with the property you want to view.

Property Address Functionality

!QUALITY Displays the data quality for the selected item. This   setting is latched. Con-
sequently, if communication is lost to the item,   the Text block will display the last 
value it received and not a series   of question marks (?????). 

!TIME Displays the last read time and date stamp for the   item. This setting is latched. 
Consequently, if communication is lost   to the item, the Text block will display the 
last value it received and   not a series of question marks (?????).

Setting Up a Database Tag for Bit Read/Write   Within an Analog Data (16-Bit Integer) Value

You can configure a database Digital tag (DI/DO) and address an item   that has Analog data.

The following address formats allow you to access bits within an Analog   data (16-bit integer) value, by 
adding a ";/" (semi-colon and   forward slash) and specifying the Bit Offset at the end of the I/O address   
string. The Bit Offset has a range of 0 to 15.

/0 = lowest significant bit within a 16-bit integer value

/15 = most significant bit within a 16-bit integer value

NOTE: All address   formats shown must be entered without any spaces in between. Spaces are   shown here 
for readability purposes only.

 l Server   ; Group ; ItemID ;;; /BitOffset assumes that there is no access   path defined, the item is 
not set up as an array, and you want to read   a Bit Offset within a single Analog data.

76 © 2024 General Electric Company. All rights reserved.



 l Server   ; Group ; ItemID ; AccessPath ;;/BitOffset assumes that there is   an access path defined, 
the item is not set up as an array, and you want   to read a Bit Offset within a single Analog data.

 l Server   ; Group ; ItemID; AccessPath ; [ArraySubscript] ; /BitOffset assumes   that there is an 
access path defined, the item is set up as an array,   and you want to read a Bit Offset of the 
ArraySubscript element within   an array of Analog data.

 l Server   ; Group ; ItemID ;; [ArraySubscript] ; /BitOffset assumes that   there is no access path 
defined, the item is set up as an array, and you   want to read a Bit Offset of the ArraySubscript ele-
ment within an array   of Analog data.

NOTE: The OPC   Client driver attempts to resolve the address when an invalid syntax is   used for a Digital 
database tag. This results in a 0 bit offset for the   address. For example, entering Server-
1;Group1;Device1;40001   for a DI/DO block results in an address of Server1;Group1;Device1;40001;No   
Access Path;;/0.

Examples

Example 1: Using a Rockwell Software RSLinx Server

 1. In the Power Tool,   add an OPC Server connected to the RSLinx OPC Server and create a group   
with default parameters.

 2. In the Power Tool,   create an item with the following properties:

Item Name: Item1
ITEMID: Sign_Int_Array[20],L100
Access Path: CLogix1
Item Start: 20
Item Length: 100
Array: Yes
Requested Data Type: Server

This specifies that the client will read   an item Sign_Int_Array[20],L100   (with access path CLo-
gix1) defined   as an array in the server with the starting array subscript as 20 and   the length of the 
array as 100 elements of 16-bit integer data. This will   read data from the server for Sign_Int_
Array,   elements 20 to 119.

 3. In the iFIX Process   Database, create an AI (Analog Input) tag with the following parameters:

Tag Name: AI1
Device: OPC
Hardware Options: Server
I/O Address: RSLinxV22;SignIntGroup1;Sign_Int_Array[20],L100;CLogix1;[20]

This specifies that the AI tag will read   Analog data from the OPC Client Driver from Server 
RSLinxV22,   Group SignIntGroup1, Item Sign_Int_Array[20], Access Path CLogix1, defined as 
an array in the   client.

You can also create a DI (Digital Input)   tag with the following parameters:

Tag Name: DI1
Device: OPC
Hardware Options: Server
I/O Address: RSLinxV22;SignIntGroup1;Sign_Int_Array[20],L100;CLogix1;[20];/0
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This specifies that the DI tag will read   Digital data from the OPC Client Driver from Server 
RSLinxV22,   Group SignIntGroup1, Item Sign_Int_Array[20] / Bit Offset 0,   access path CLogix1, 
defined   as an array in the client.

Example 2: Using a Siemens S7 SIMATIC NET OPC Server

 1. In the Power Tool,   add an OPC Server connected to the Siemens S7 SIMATIC NET Server and 
create   a group with default parameters.

 2. In the Power Tool,   create an item with:

Item Name: Item2
ITEMID: S7:[S7_300|VFD1|CP5613_5614(PROFIBUS)]DB1,INT10,3
Access Path: No Access Path
Item Start: 10
Item Length: 3
Array: Yes
Requested Data Type: Server

This specifies that the client will read   an item S7:[S7_300|VFD1|CP5613_5614
(PROFIBUS)]DB1,INT10,3   (with no Access Path) defined as an array in the server with the   start-
ing array subscript as 10 and the length of the array as 3 elements   of 16-bit integer data. This will 
read data for elements 10 to 12 from   the server.

You can specify the data type as Server   so that the server returns the data with the correct data 
type for the   array.

 3. In the iFIX Process   Database, create an AI (Analog Input) tag with the following parameters:

Tag Name: AI2
Device: OPC
Hardware 
Options:

Server

I/O Address: Server1;Group1;S7:[S7_300|VFD1|CP5613_5614
(PROFIBUS)]DB1,INT10,3;No   Access Path;[10]

- Or -

Server1;Group1;S7:[S7_300|VFD1|CP5613_5614
(PROFIBUS)]DB1,INT10,3;;[10]

This specifies that the AI tag will read   data from the OPC Client Driver from Server1, Group1, 
Item S7:[S7_300|VFD1|CP5613_5614(PROFIBUS)]DB1,INT10,3,   Element 10 of the array, with 
no Access Path.

You can also create a DI (Digital Input)   tag with the following parameters:

Tag Name: DI2
Device: OPC
Hardware 
Options:

Server

I/O Address: Server1;Group1;S7:[S7_300|VFD1|CP5613_5614
(PROFIBUS)]DB1,INT10,3;No   Access Path;[10];/2

- Or -
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Server1;Group1;S7:[S7_300|VFD1|CP5613_5614
(PROFIBUS)]DB1,INT10,3;;[10];/2

This specifies that the DI tag will read   Digital Data from the OPC Client Driver from Server1, 
Group1, Item S7:[S7_300|VFD1|CP5613_5614(PROFIBUS)]DB1,INT10;3;   Element10 Bit Off-
set 2 of the array, with no Access Path.

Example 3: Using a Schneider Automation OFS OPC Server

 1. In the Power Tool,   add an OPC Server connected to the OFS Server and create a group with   
default parameters.

 2. In the Power Tool,   create an item with the following parameters:

Item Name: Item1
ITEMID: MBT:1.2.3.4!400001
Access Path: No Access Path
Item Start: N/A
Item Length: N/A
Array: No
Requested Data Type: Server

This specifies that the client will read   an item MBT:1.2.3.4!400001 (with   no Access Path), 
defined as a single item in the server. This will read   data for element 1 for 4x-based holding 
registers (i.e., 400001 from the   PLC).

NOTE:   In the Schneider Documentation for the current version of the server,   the ItemID uses the 6-
digit notation regardless of the settings in the   PLC. Therefore, if you are reading 40001 (5-digit nota-
tion) from the PLC,   you must enter it as 400001 in the ItemID configuration.

 3. In the iFIX Process   Database, create an AI (Analog Input) tag with the following parameters:

Tag Name: AI4
Device: OPC
Hardware Options: Server
I/O Address: Server1;Group1;MBT:1.2.3.4!400001

This specifies that the AI tag will read   data from the OPC Client Driver from Server1, Group1, 
Item MBT:1.2.3.4!400001   (which will be 400001 from the PLC), with no Access Path.

You can also create a DI (Digital Input)   tag with the following parameters:

Tag Name: DI4
Device: OPC
Hardware Options: Server
I/O Address: Server1;Group1;MBT:1.2.3.4!400001;;;/15

This specifies that the DI tag will read   Digital data from the OPC Client Driver from Server1, 
Group1, Item MBT:1.2.3.4!400001 Bit Offset 15 (which   will be 400001:15 from the PLC), no 
Access Path, defined as a single item   in the client.

NOTE:   The OPC Client supports iFIX Digital Register Block (DR) offsets for accessing   digital bit data 
for items defined as single items, or items defined as   arrays, if used in the above mentioned formats 
for Bit Offsets for 16-bit   integer data values only.
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Example 4: Using a DR tag to access digital offsets with an RSLinx   Server

NOTE: Refer to   Example 1 above for the syntax for entering the I/O address for a database   point for accessing 
bit-offsets to Analog 16-bit Integer Data.

 1. In the Power Tool,   create an item with:

Item Name: DR0
ITEMID: Integer_Array[0],L20
Access Path: CLogix1
Requested Data Type: Server

 2. In the Process Database,   create a Digital Register (DR) tag with the following parameters:

Tag Name: DR0
Device: OPC
Hardware Options: Server
I/O Address: RSLinxV22;IntegerGroup1;Integer_Array[0],L20;CLogix1;[0];/0

This specifies that the DR0 tag will read   data from the OPC Client Driver from Server 
RSLinxV22,IntegerGroup1,   Item Integer_Array [0], Bit Offset 0, and Access Path CLogix1, 
defined as an array of integers   in the server.

In iFIX Pictures, you can create a link   to the tag DR0 and specify the offset to the tag to read the 
corresponding   data values, as follows:

DR0.F_0 will read data from Integer_Array[0];Bit   Offset 0
DR0.F_1 will read data from Integer_Array[0];Bit   Offset 1
DR0.F_2 will read data from Integer_Array[0];Bit   Offset 2
&
DR0.F_15 will read data from Integer_Array[0];Bit   Offset 15
DR0.F_16 will read data from Integer_Array[1];Bit   Offset 0
DR0.F_17 will read data from Integer_Array[1];Bit   Offset 1
&
DR0.F_303 will read data from Integer_Array[18];Bit   Offset 15
DR0.F_304 will read data from Integer_Array[19];Bit   Offset 0
DR0.F_305 will read data from Integer_Array[19];Bit   Offset 1
&
DR0.F_318 will read data from Integer_Array[19];Bit   Offset 14
DR0.F_319 will read data from Integer_Array[19];Bit   Offset 15

Any digital offset greater than 319 will   return an error because the item is defined as an array of 20 
elements   each of which is a 16-bit integer.

 

Specify Hardware Options in iFIX Process Database

You can select a data type for the process data stored by iFIX from   the Hardware Options field in Pro-
cess Database. The data type you select   overrides the requested data type of the associated OPC item. 
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If you do   not select a data type, iFIX uses the item’s data type. For example, if   you configure an item 
with a Long data type and then select Float as the   hardware option in Process Database, the data type 
for the item is Float   because iFIX overrides the item’s setting. For this reason, make sure   the data type 
you select in Process Database is correct for the information   that you are requesting.

Refer to the following table for a list of valid data types. 

Supported Data Types

Data 
type

Description Process Data-
base Short-
cut

Boolean Digital value, 0 or 1. BOOL
Byte Unsigned 8-bit character. BYTE
Double Double-precision IEEE floating point value. DBL
Float Single-precision IEEE floating point value. FLT
Long Signed 32-bit integer. LONG
Server OPC Server’s native (or canonical) data type. Consult   your OPC 

Server vendor or documentation on determining the native data   
type.

SRV

Signed Signed 16-bit integer. SINT
UnsignedUnsigned 16-bit integer. UINT
String Unsigned 16-bit integer. STR

Only Signed and Unsigned data types support the use of signal conditioning.

NOTE: When completing   this field, enter either the complete data type string or the Process   Database short-
cut. We recommend using the Process Database shortcut only   when creating new items from Process Data-
base. When creating a database   block to an OPC item that already exists, we recommend that you don’t   
change the requested data type because it will affect every reference   to the OPC item. Additionally, the OPC 
specification recommends that requested   data types not be changed after   you add them because the OPC 
server may perform special initialization   for a particular data type and may then not be able to service the item   
if you change the data type.

 

Set Up for Creating Items and Groups Automatically in iFIX Process   Database

iFIX Process Database uses the default settings for groups and items   when you add a new database 
block that refers to an undefined address.   Default values may already be set for your application. To find 
out what   the default values are, open the OPC Client Power Tool and choose Templates   from the 
Options menu. When the Templates dialog box appears, you can   display the default server, group, and 
item values by selecting a tab.   To change a value, refer to Setting   Default Values for Server, Groups, 
and Item Properties.

 

Specifying Signal Conditioning in iFIX Process Database
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In the Process Database Signal Conditioning field, you can specify the   method for converting raw data 
to a value that iFIX applications can use.   When you select a signal conditioning, the OPC Client scales 
(converts)   the data to a value within the specified range.

Unsigned data types support many types of signal conditioning; signed   values only support LIN signal 
conditioning. The type of signal conditioning   you select must match the range of incoming values from 
the process hardware.   By matching the range of values in the process hardware, you ensure the   driver 
can properly convert the raw data values to the database block’s   EGU range. For example, if the incom-
ing values are between 0 and 255,   you would select 8BN signal conditioning.

IMPORTANT: 

 l Prior to iFIX   4.5, 15-digit precision was not supported. Instead, you are limited to   the 7 digit limits 
imposed by the use of single precision values.

 l If you are   using this OPC Client driver (v7.41) in iFIX 4.5, 15-digit precision is   supported for data val-
ues only, and not for signal conditioning. Therefore,   in iFIX 4.5, signal conditioning calculations are 
limited to 7 digits   of precision. In other words, if the range of your EGU limits exceeds   7 digits, a small 
amount of imprecision will be introduced into the calculated   result for signal conditioning. 

 l If you are   using iFIX 5.0 with this OPC Client driver (v7.41), 15-digit precision   is supported for both 
data values and   signal conditioning. 

OPC Supported Signal Conditioning Types

 l NONE

 l 12BN   Signal Conditioning

 l 12AL   Signal Conditioning (with alarming)

 l 15BN   Signal Conditioning

 l 15AL   Signal Conditioning (with alarming)

 l LIN   Signal Conditioning

 l 3BCD   Signal Conditioning

 l 4BCD   Signal Conditioning

 l 13BN   Signal Conditioning

 l 13AL   Signal Conditioning (with alarming)

 l 8BN   Signal Conditioning

 l 8AL   Signal Conditioning (with alarming)

IMPORTANT:

 l Most signal   conditioning types with alarming return values with all 16 bits and generate   an OVER or 
UNDER range alarm if the value is outside the EGU range of   the database block. For example, if a 
database block using 8AL signal   conditioning receives a value of 300, an OVER range alarm is gen-
erated   and the value 300 is displayed. 

 l When 3BCD or   4BCD signal conditioning is used, out of range values are not displayed.   For example, 
if a database block using 3BCD signal conditioning receives   a value of 1000, an OVER range alarm is 
generated and question marks are   displayed instead of the out of range value.

 

12AL Signal Conditioning
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Parameters for 12AL Signal Conditioning

Parameter Description
Description 12-bit binary number.
Input Range 0 – 4095
Scaling Scales 12-bit binary values to the database block’s   EGU range. 
Read 
Algorithm

Reads from a 16-bit register using the same algorithm   as 12BN, and returns a 
status indicating whether the value is out of range   and in an alarm state, or OK.

Result = ((Raw_value/4095) * Span_egu) + Lo_egu
Read 
Algorithm 
Variables

Lo_egu – the database block’s low engineering value.

Span_egu – the span of the engineering values.

Raw_value – the value stored in the field device’s   register.

Result – the scaled value stored in the database block.
Write 
Algorithm

Writes to a 16-bit register using the same algorithm   as 12BN, and returns a 
status indicating whether the value is out of range   and in an alarm state, or OK.

Result = (((InputData – Lo_egu)/Span_egu) * 4095)   + .5
Write 
Algorithm 
Variables

Lo_egu – the low engineering value.

Span_egu – the span of the engineering values.

InputData – the database block’s current value.

Result – the value sent to the process hardware.

 

12BN Signal Conditioning

Parameters for 12BN Signal Conditioning

Parameter Description
Description 12-bit binary number.
Input Range 0 – 4095
Scaling Scales 12-bit binary values to the database block’s   EGU range. Ignores 

the most significant nibble (4-bits).
Read Algorithm Reads from a 16-bit register using the following algorithm:

Result = ((Raw_value/4095) * Span_egu) + Lo_egu
Read Algorithm 
Variables

Lo_egu – the database block’s low engineering value.

Span_egu – the span of the engineering values.

Raw_value – the value stored in the field device’s   register.

Result – the scaled value stored in the database block.
Write Algorithm Writes to a 16-bit register using the following algorithm:

Result = (((InputData – Lo_egu)/Span_egu) * 4095)   + .5
Write Algorithm 
Variables

Lo_egu – the low engineering value.

Span_egu – the span of the engineering values.
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InputData – the database block’s current value.

Result – the value sent to the process hardware.

 

13AL Signal Conditioning

Parameters for 13AL Signal Conditioning

Parameter Description
Description 13-bit binary number.
Input Range 0 – 8191
Scaling Scales 13-bit binary values to the database block’s   EGU range. 
Read 
Algorithm

Reads from a 16-bit register using the same algorithm   as 13BN, and returns a 
status indicating whether the value is out of range   and in an alarm state, or OK.

Result = ((Raw_value/8191) * Span_egu) + Lo_egu
Read 
Algorithm 
Variables

Lo_egu – the database block’s low engineering value.

Span_egu – the span of the engineering values.

Raw_value – the value stored in the field device’s   register.

Result – the scaled value stored in the database block.
Write 
Algorithm

Writes to a 16-bit register using the same algorithm   as 13BN, and returns a 
status indicating whether the value is out of range   and in an alarm state, or OK.

Result = (((InputData – Lo_egu)/Span_egu) * 8191)   + .5
Write 
Algorithm 
Variables

Lo_egu – the low engineering value.

Span_egu – the span of the engineering values.

InputData – the database block’s current value.

Result – the value sent to the process hardware.

 

13BN Signal Conditioning

Parameters for 13BN Signal Conditioning

Parameter Description
Description 13-bit binary number.
Input Range 0 – 8191
Scaling Scales 13-bit binary values to the database block’s   EGU range. Ignores 

the most significant 3 bits.
Read Algorithm Reads from a 16-bit register using the following algorithm:

Result = ((Raw_value/8191) * Span_egu) + Lo_egu
Read Algorithm 
Variables

Lo_egu – the database block’s low engineering value.

Span_egu – the span of the engineering values.
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Raw_value – the value stored in the field device’s   register.

Result – the scaled value stored in the database block.
Write Algorithm Writes to a 16-bit register using the following algorithm:

Result = (((InputData – Lo_egu)/Span_egu) * 8191)   + .5
Write Algorithm 
Variables

Lo_egu – the low engineering value.

Span_egu – the span of the engineering values.

InputData – the database block’s current value.

Result – the value sent to the process hardware.

 

15AL Signal Conditioning

Parameters for 15AL Signal Conditioning

Parameter Description
Description 15-bit binary number.
Input 
Range

0 – 32767

Scaling Scales 15-bit binary values to the database block’s   EGU range. 
Read 
Algorithm

Reads from a 16-bit register with alarming using the   same algorithm as 15BN, 
and returns a status indicating whether the value   is out of range and in an alarm 
state, or OK.

Result = ((Raw_value/32767) * Span_egu) + Lo_egu
Read 
Algorithm 
Variables

Lo_egu – the database block’s low engineering value.

Span_egu – the span of the engineering values.

Raw_value – the value stored in the field device’s   register.

Result – the scaled value stored in the database block.
Write 
Algorithm

Writes to a 16-bit register with alarming using the   same algorithm as 15BN, and 
returns a status indicating whether the value   is out of range and in an alarm state, 
or OK.

Result = (((InputData – Lo_egu)/Span_egu) * 32767)   + .5
Write 
Algorithm 
Variables

Lo_egu – the low engineering value.

Span_egu – the span of the engineering values.

InputData – the database block’s current value.

Result – the value sent to the process hardware.

 

15BN Signal Conditioning
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Parameters for 15BN Signal Conditioning

Parameter Description
Description 15-bit binary number.
Input Range 0 – 32767
Scaling Scales 15-bit binary values to the database block’s   EGU range. Ignores 

the most significant bit.
Read Algorithm Reads from a 16-bit register using the following algorithm:

Result = ((Raw_value/32767) * Span_egu) + Lo_egu
Read Algorithm 
Variables

Lo_egu – the database block’s low engineering value.

Span_egu – the span of the engineering values.

Raw_value – the value stored in the field device’s   register.

Result – the scaled value stored in the database block.
Write Algorithm Writes to a 16-bit register using the following algorithm:

Result = (((InputData – Lo_egu)/Span_egu) * 32767)   + .5
Write Algorithm 
Variables

Lo_egu – the low engineering value.

Span_egu – the span of the engineering values.

InputData – the database block’s current value.

Result – the value sent to the process hardware.

 

3BCD Signal Conditioning

Parameters for 3BCD Signal Conditioning

Parameter Description
Description3-digit Binary Coded Decimal value.
Input 
Range

0 – 999

Scaling Scales 3-digit Binary Coded Decimal values to the   database block’s EGU range. 
Read 
Algorithm

Reads from a 3-digit BCD register. The Raw_value is   then separated into three 
nibbles (4 bits) prior to scaling the value.   Each nibble is examined for a value 
greater than 9 (A-F hex). If a hexadecimal   value between A and F is found, a 
range alarm is generated, indicating   the value is not within BCD range. Other-
wise, the value is scaled with   the following algorithm:

Result = ((Raw_value/999) * Span_egu) + Lo_egu
Read 
Algorithm 
Variables

Lo_egu – the database block’s low engineering value.

Span_egu – the span of the engineering values.

Raw_value – the value stored in the field device’s   register.

Result – the scaled value stored in the database block.
Write 
Algorithm

Writes to a 3-digit BCD register using the following   algorithm:

Result = (((InputData – Lo_egu) / Span_egu) * 999   + .5
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Write 
Algorithm 
Variables

Lo_egu – the low engineering value.

Span_egu – the span of the engineering values.

InputData – the database block’s current value.

Result – the value sent to the process hardware.

 

8AL Signal Conditioning

Parameters for 8AL Signal Conditioning

Parameter Description
Description 8-bit binary number.
Input Range 0 – 255
Scaling Scales 8-bit binary values to the database block’s   EGU range. 
Read 
Algorithm

Reads from a 16-bit register using the same algorithm   as 8BN, and returns a 
status indicating whether the value is out of range   and in an alarm state, or OK.

Result = ((Raw_value/255) * Span_egu) + Lo_egu
Read 
Algorithm 
Variables

Lo_egu – the database block’s low engineering value.

Span_egu – the span of the engineering values.

Raw_value – the value stored in the field device’s   register.

Result – the scaled value stored in the database block.
Write 
Algorithm

Writes to a 16-bit register using the same algorithm   as 8BN, and returns a 
status indicating whether the value is out of range   and in an alarm state, or OK.

Result = (((InputData – Lo_egu)/Span_egu) * 255) +   .5
Write 
Algorithm 
Variables

Lo_egu – the low engineering value.

Span_egu – the span of the engineering values.

InputData – the database block’s current value.

Result – the value sent to the process hardware.

 

4BCD Signal Conditioning

Parameters for 4BCD Signal Conditioning

Parameter Description
Description4-digit Binary Coded Decimal value.
Input 
Range

0 – 9999

Scaling Scales 4-digit Binary Coded Decimal values to the   database block’s EGU range.
Read 
Algorithm

Reads from a 4-digit BCD register. The Raw_value is   then separated into four 
nibbles (4 bits) prior to scaling the value.   Each nibble is examined for a value 
greater than 9 (A-F hex). If a hexadecimal   value between A and F is found, a 
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range alarm is generated, indicating   the value is not within BCD range. Other-
wise, the value is scaled with   the following algorithm:

Result = ((Raw_value/9999) * Span_egu) + Lo_egu
Read 
Algorithm 
Variables

Lo_egu – the database block’s low engineering value.

Span_egu – the span of the engineering values.

Raw_value – the value stored in the field device’s   register.

Result – the scaled value stored in the database block.
Write 
Algorithm

Writes to a 4-digit BCD register using the following   algorithm:

Result = (((InputData – Lo_egu) / Span_egu) * 9999   + .5
Write 
Algorithm 
Variables

Lo_egu – the low engineering value.

Span_egu – the span of the engineering values.

InputData – the database block’s current value.

Result – the value sent to the process hardware.

 

8BN Signal Conditioning

Parameters for 8BN Signal Conditioning

Parameter Description
Description 8-bit binary number.
Input Range 0 – 255
Scaling Scales 8-bit binary values to the database block’s   EGU range. Ignores 

the most significant byte.
Read Algorithm Reads from a 16-bit register using the following algorithm:

Result = ((Raw_value/255) * Span_egu) + Lo_egu
Read Algorithm 
Variables

Lo_egu – the database block’s low engineering value.

Span_egu – the span of the engineering values.

Raw_value – the value stored in the field device’s   register.

Result – the scaled value stored in the database block.
Write Algorithm Writes to an 8-bit register using the following algorithm:

Result = (((InputData – Lo_egu)/Span_egu) * 255) +   .5
Write Algorithm 
Variables

Lo_egu – the low engineering value.

Span_egu – the span of the engineering values.

InputData – the database block’s current value.

Result – the value sent to the process hardware.

 

Enter Driver Information in iFIX Process Database
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 To enter driver specifications   for a database block in iFIX Process Database

 1. Open iFIX Process   Database (PDB).

 2. From the Blocks menu,   choose Add. Process Database prompts you to select the type of data-
base   block you want to add.

 3. Select the type of   block you want to add and click OK. The block's dialog box appears.

 4. Enter a name in the   Tag Name box.

 5. Complete the driver   settings with the appropriate information for your driver.

I/O Driver Fields

Refer to the following topics for valid entries for each setting:

 l Specifying   I/O Drivers in iFIX Process Database

 l Specifying   Hardware Options

 l Specifying   I/O Addresses

 l Specifying   Signal Conditioning

 

Open the Power Tool from iFIX Process Database

 To open the OPC Client Power   Tool from iFIX Process Database

 1. From the Drivers   menu, choose OPC. Any servers, groups, or items that you added appear   in the 
Tree Browser. 

 2. Modify and add servers,   groups, and items as needed.

 

Verify New Items Created in iFIX Process Database

When you create an item in iFIX Process Database, it automatically adds   to the driver server. 

 To verify that the item or group   was added to the run-time configuration:

 1. Open the OPC Client’s   Power Tool and select an object in the Tree Browser. 

 2. Press the F5 key   to refresh the Tree Browser.

 3. Expand the server   containing the group you added. To view the item, expand the group.

Use the following I/O driver-specific fields in iFIX Process Database   to set up the OPC Client:

 l Device

 l Hardware   Options

 l I/O   Address

 l Signal   Conditioning
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Save Groups and Items Created in iFIX Process Database to the Configuration   File

Creating a group or item with Process Database adds the group or item   only to the run-time con-
figuration, not the driver configuration file.   

 To save the group or item to   the configuration file:

 l Save the configuration   file in the Power Tool at any time while iFIX is running by choosing Save   
from the File menu.

- Or -

 l Save the group or   item automatically to the configuration file when you shut down iFIX by   clicking 
an object in the Tree Browser and pressing ALT   + SHIFT + S. When the server window appears, 
choose Save on FIX   Exit from the Server menu.

 

Find Groups and Items in the Tree Browser

NOTE: Searching   for servers, groups, and items is available only when the driver is in   configuration mode. 
The search feature is available at all levels in the   tree browser.

 To find groups and items in   the Tree Browser

 1. In the Power Tool's   Tree Browser, select a server or group with an object you to want to search   
for.

 2. From the Edit menu,   choose Find. The Find dialog box appears.

 3. In the Find What   box, enter the name of the group or item you want to search for, or select   a pre-
vious search criterion from the list. You can use an asterisk (*)   as a wildcard character to assist in 
your search.

 4. Click the Find Next   button to perform the search. The group or item you searched for is selected   
in the Tree Browser.

NOTE: You can   use the Find Previous button to move backwards through the found objects   at the Item level 
only.

 

Sort Servers, Groups, and Items in the Tree Browser

NOTE: Sorting   servers, groups, and items is available only during configuration of the   OPC Client driver.

 To sort servers, groups, and   items in the Tree Browser:

 1. In the Power Tool's   Tree Browser, select the driver, server, or group with the objects that   you 
want to sort. If you select the driver, the associated servers are   sorted; if you select a server, the 
associated groups are sorted; if you   select a group, the associated items are sorted.

 2. From the Edit menu,   choose Sort. The objects associated with the selected driver, server,   or 
group are sorted in ascending alphabetical order.
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Use I/O Driver Report Files

You can use I/O driver report files (.CSV) to document, create, or upgrade   I/O driver configuration binary 
files. All files with the CSV extension   are Comma Separated Value files that you can view and edit in a 
text editor   or Microsoft Excel.

Driver .CSV files have the following sections:

 l Report header

 l Server header

 l Server data

 l Group header

 l Group data

 l Item header

 l Item data

Report Header – is   for information and contains the driver name and the date of the report.

Server Header – contains   a list of all the server properties. The server header must start with   an exclam-
ation point (!). 

Server Data – contains   the values of the server properties for your driver configuration. The   number of 
data values must match the number of server properties listed   in the server header. If you do not specify 
a value for a property, it   uses the default value for that property.

Group Header – contains   a list of all the group properties. The group header must start with an   at-sign 
(@).

Group Data – contains   the values of the group properties for your driver configuration. The   number of 
data values must match the number of group properties listed   in the group header. If you do not specify a 
value for a property, it   uses the default value for that property.

Item Header – contains   a list of all the item properties. The item header must start with a pound   sign (#).

Item Data – contains   the values of the item properties for your driver configuration. The number   of data 
values must match the number of item properties listed in the   item header. If you do not specify a value 
for a property, it uses the   default value for that property.

Example .CSV file displayed in a text editor

#Device, Name, Description, Enabled, ItemID, AccessPath, DeadBand, RequestedDataType,   
LatchData, OutputDisabled, AccessTime, IsDataArray, ItemLength, ItemStartAddr,   Block-
WritesEnabled
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Repor-
t 
Heade-
r

[OPC I/O Driver Configuration   Report, Wednesday, November 10

1999, 09:00 PM]

Server 
Heade-
r

!Name,De-
scription,Enabled,ProgID,PrimaryConnectionType,PrimaryRemoteMachineName,
BackupCon-
nectionType,BackupRemoteMachineName,PersistOnShutdown,PersistFileName,
SendMessageToWindow,IoAddressDelimiter

Server 
Data

Server0,,1,Intellution.OPCNIO,Local,,,,0,,1

Server3,,0,OPC.DVTest.1,Sample   OPC Server,Local,,0,,1,;

Group 
Heade-
r

@Chan-
nel,Name,Description,Enabled,Deadband,IoType,DataSource,ClientUpdateRate,
ServerUpdateRate,AsyncTimeout,AsyncWatchDogEnable,UseConnectionPoints

Group 
Data

Server0,Group20,,0,0,Synchronous,Cache,01,01,10000,1,1

Server0,Group1,,1,0,Synchronous,Cache,01,01,10000,1,1

Server1,Group2,,1,0,Asynchronous,Cache,01,01,10000,1,1

Item 
Heade-
r

#Device,Name,De-
scription,Enabled,ItemID,AccessPath,DeadBand,RequestedDataType,
LatchData,OutputDisabled,AccessTime,IsDataArray,ItemLength,ItemStartAddr,
BlockWritesEnabled

Item 
Data

Group1,Item1,,1,ISA:D1:1,No   Access Path,0,Signed,0,0,Disabled,0,,,0

Group1,Item2,,1,ISA:D1:2,No   Access Path,0,Unsigned,0,0,Disabled,0,,,1

Group2,Item5,,1,ISA:D1:1:1,No   Access Path,0,Boolean,0,0,Disabled,0,,,0

You can import a .CSV file from the Power Tool or the I/O Server. Regardless   of the method you select, 
any errors in the .CSV file appear in the I/O   Server window when you import it. To view the errors, click 
an item in   the Tree Browser and press ALT   + SHIFT + S.

 

Running the I/O Driver Overview

Click the following links for more information regarding methods on   running the driver.

 l Statistics

 l The   Data Monitor
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 l Starting   and Stopping the I/O Driver

 l Checking   Communication

 

Statistics Overview

Click the following links for more information regarding statistics.

 l I/O   Driver Statistics

 l Server   Statistics

 l Group   Statistics

 l Item   Statistics

 

I/O Driver Statistics

The I/O Driver Statistics display shows statistics for the I/O driver.   This is the highest level of driver stat-
istics and provides information   about the entire system. The number of transmits, receives, and errors   
are displayed for all servers, groups, and items in the current configuration.   To display the driver’s stat-
istics, select the I/O driver icon in the   Tree Browser and then choose Stats Mode from the Display Mode 
menu.

The following describes the fields and buttons that are visible in the   I/O Driver Properties Viewer in Stats 
Mode:

Transmits

Displays the number of messages sent to all OPC servers.

Example:

 l Number of servers   configured for the driver = 2

 l Number of messages   sent on Server1 = 560

 l Number of messages   sent on Server2 = 220

 l Total number   of messages sent = 780

 l Transmit Count   field displays: 780

Receives

Displays the total number of messages received from all OPC servers,   including both synchronous and 
asynchronous callbacks.

Errors

Displays the total number of errors sent from all OPC servers.

Errors occur when:
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 l The OPC server   rejects a read or write request.

 l An exception   occurs in the OPC server.

 l The driver is   unable to make an asynchronous connection to an OPC server.

For more information about the cause of the error,   examine the Last Error field in the OPC item stat-
istics.

Troubleshooting

When clicked, this button displays the Troubleshooting help page.

 
 

Server Statistics

The Server Statistics display shows statistics for the selected server.   The number of transmits, 
receives and errors displayed are for all groups   and items configured for the server. You can also see the 
number groups   and items on the server, the server’s connection status, the server’s   start time and cur-
rent time, the time of the last update sent to the driver,   and the version number of the server’s software.

To display a server’s statistics, select the server in the Tree Browser   and then choose Stats Mode from 
the Display Mode menu.

The following table lists and describes the fields and buttons that   are visible in the Server Properties 
Viewer in Stats Mode:

Transmits

Displays the number of messages sent from all items on all the groups   configured for the selected 
server.

Example:

 l Number of groups   configured for the driver = 4

 l Number of messages   sent on Group1 = 30

 l Number of messages   sent on Group2 = 15

 l Number of messages   sent on Group3 = 20

 l Number of messages   sent on Group4 = 10

 l Total number   of messages sent = 75

 l Transmits field   displays: 75

Receives

Displays the total number of messages received from   the OPC server, including both synchronous and 
asynchronous callbacks.

Errors

Displays the total number of errors sent from the selected server.

Errors occur when: 
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 l The OPC server   rejects a read or write request.

 l You specify an   invalid Item ID or access path from the OPC server.

For more information about the cause of the error, examine the Last   Error field in the OPC item stat-
istics.

Number of Groups

Displays the number of groups configured for the selected   server.

Number of Items

Displays the number of items configured on all the groups for the selected   server.

Write Queue Count

Displays the number of write requests that are pending for the server.

Vendor Info

Displays a vendor-supplied string describing the OPC server. Typically,   this information includes the 
vendor’s name and software version number.

Server Status

Displays the current status of the OPC server. Possible values include:

 l Not Connected

 l Suspended, No   Data

 l Running

Bandwidth

Displays OPC server specific information. One possible, and the suggested,   use is to show the approx-
imate percent of bandwidth currently in use by   the OPC server.

Start Time

Displays the time and date that the OPC server started. The time is   displayed in universal time (Green-
wich Mean Time).

Current Time

Displays the server’s current time and date. The time is displayed in   universal time (Greenwich Mean 
Time).

Last Update

Displays the time and date that the server sent its last data update   to the driver. The time is displayed in 
universal time (Greenwich Mean   Time).

Major Version

Displays the major version of the OPC server software.

Minor Version

Displays the minor version of the OPC server software.
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Build Number

Displays the build number of the OPC server software.

Connection In Use

Displays the current connection in use by the server.

Troubleshooting

When clicked, this button displays the Troubleshooting help page.

Server Dialog Refresh Status

Displays the primary refresh rate and the refresh status for the selected   server.
 

Group Statistics

The Group Statistics display shows the statistics for the selected group.   The number of transmits, 
receives, and errors are displayed for all items   configured for the group.

To display a group’s statistics, select the group in the Tree Browser   and then choose Stats Mode from 
the Display Mode menu. 

The following fields and buttons are visible in the Group Properties   Viewer in Stats Mode:

Transmits

Displays the number of reads and writes sent to the OPC server for all   the items configured for the selec-
ted group.

Example:

 l Number of items   configured for the driver = 2

 l Number of messages   sent from Item1 = 30

 l Number of messages   sent from Item2 = 30

 l Total number   of messages sent = 60

 l Transmits field   displays: 60

Receives

Displays the total number of messages the group received from the OPC   server, including both syn-
chronous and asynchronous callbacks.

Errors

Displays the total number of errors that were sent from the OPC server   and received by the selected 
group.

Errors occur when:

 l You specify an   invalid item ID or access path from the OPC server.

 l The OPC server   rejects a read or write request.

96 © 2024 General Electric Company. All rights reserved.



 l The group is   unable to establish an asynchronous connection with the OPC server.

For more information about the cause of the error, examine the Last   Error field in the OPC item stat-
istics.

Number of Items

Displays the total number of items configured for the selected group.

Actual Update Rate

Displays the actual update rate that the server uses to refresh this   group’s data cache. This value may 
be different from the requested update   rate if the requested rate is too small and the server cannot 
update the   group at that frequency.

Pending Asynchronous Transactions

Displays the number of asynchronous read and write messages that are   pending with the OPC server 
for the selected group. When the group uses   synchronous I/O, the number of pending asynchronous 
message is always   0.

Troubleshooting

When clicked, this button displays the Troubleshooting   help page.

Group Dialog Refresh Status

Displays the primary refresh rate and the refresh   status for the selected group.
 

Item Statistics

The Item Statistics display shows statistics for the selected OPC item.   The number of transmits, 
receives, and errors are displayed for the selected   item. Other available statistics include the last time 
the driver successfully   read data from and wrote data to the item, the OPC quality of the item,   the 
server’s native data type, and the access rights for the item.

To display an item’s statistics, select the item in the Tree Browser   and then choose Stats Mode from the 
Display Mode menu.

The following describes the fields and buttons that are visible in the   Item Properties Viewer in Stats 
Mode:

Item ID

Specifies the fully qualified ID for this item and describes the properties   of the data point that you want to 
read. For example, an item ID can contain   addressing parameters, engineering units, and scaling prop-
erties. 

Valid Entries

The format of the item ID is specific to each OPC server. Refer to your   OPC server documentation for 
more information.
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If your OPC server supports browsing, you can click the Browse Server   button and select the item you 
want. The Power Tool updates the Item ID   field with the item you select. For more information about 
browsing an   OPC server, refer to How   do I browse an OPC server?

You cannot modify this setting while the item is enabled.

Transmits

Displays the number of messages sent to the OPC server from the selected   item.

Receives

Displays the total number of messages the item received from the OPC   server, including both syn-
chronous and asynchronous callbacks.

Errors

Displays the total number of errors that were sent from the OPC server   and received by the selected 
item.

Errors occur when: 

 l You specify an   invalid item ID or access path.

 l You select a   requested data type that the server cannot handle.

 l The OPC quality   is bad.

 l A read or write   call fails.

For more information about the cause of the error, examine the Last   Error field for the item.

Number of Items

Displays the total number of items configured for the selected group.

Access Rights

Displays the rights of the selected item in the OPC server. 

Valid Entries:

 l Read   only: Allows you to read only from the item.

 l Write   only: Allows you to write only to the item.

 l Read/Write:   Allows you to read and write data to the item.

 l Unknown:   Indicates the item’s attributes are unknown at the current time. The driver   is not 
connected to the server, the item is not active, the item ID is   invalid, or the OPC server 
returned an invalid parameter.

Data Quality

Displays the quality of the data in the selected item. When the item   is a data array, the quality applies to 
all values in the array. Consequently,   if even one value of the array is bad, the quality of the entire array   
is bad.
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Server Datatype

Displays the format of the data that the OPC server returns to the driver.   This format does not need to be 
the same as the requested data type. For   example, if the requested data type is Unsigned, the server 
may obtain   an unsigned value, but return it to the driver in the form of a Float.

Read Data

Displays the last known data value read from the selected item.

Write Data

Displays the last good write value sent to the selected item.

Last Error

Displays the last error received by the item from the OPC server. For   a list of errors, refer to Error   
Codes.

Last Read Time

Displays the last date and time that the OPC server successfully read   data from the selected item.

Last Write Time

Displays the last date and time that the driver successfully wrote data   to the selected item.

Last Error Time

Displays the last date and time that an error occurred for the selected   item.

Block Writes Queue Count

Displays the number of items that are waiting to be written to a data   array. Block writes send data to vari-
ous registers in the OPC server simultaneously   by using a special "send" command. This command 
instructs the   OPC Client to send all outstanding writes in a single protocol message.   Block writes are 
useful in batch situations where multiple setup parameters   are required by the hardware at one time.

When the OPC Client sends a data array, it also sends any unmodified   values in the array using the last 
known value. 

To send block writes through iFIX, you must enable block writes in the   item you want to use and then 
create a Digital Output block with the following   address:

!Send:DataBlockName

Note that only item names are valid with the !Send control address.   Server and group names do not 
cause any block writes to be sent to the   OPC server. Analog Output blocks are not supported.

Data Monitor Button

Displays the Data Monitor for the selected item. The Data Monitor displays   the data received for the 
item, the data's quality, and the last time   data was read and written. The Data Monitor also displays the 
time the   last error occurred for the item.

Troubleshooting

When clicked, this button displays the Troubleshooting help page.
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Item Dialog Refresh Status

Displays the primary refresh rate and the refresh status for the selected   item.

Example 

Click the following links for more information regarding the Data Monitor.

 l Data   Monitor Dialog Box

 l Understanding   Data Quality

 

Data Monitor Dialog Box

Starting Address

Displays the data received for the selected item in the format selected   in the Format setting.

Quality

Displays the quality of the data in the selected item.

If the data quality is bad, the links in your operator displays show   question marks by default. To save the 
last good value, enable the Latch   data option. For more information about data quality, refer to Under-
standing   Data Quality.

Format

Specifies the format or data type to use when displaying an item’s data.   Possible formats include:

Format/Data Type Displays
Byte Unsigned 8-bit values
Char Signed 8-bit values
Hex 8-bit hexadecimal values
Short Signed 16-bit integers
Word Unsigned 16-bit integers
Float 32-bit floating-point values (IEEE)
Long Signed 32-bit integers
DWord Unsigned 32-bit integers
Octal Octal (unsigned integer) data
ASCII ASCII text
Digital Binary values
DblFloat 64-bit floating point values (IEEE)

Last Time Read

Displays the last time and date the I/O driver successfully read data   from the process hardware for the 
selected item.
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Last Time Written

Displays the last time and date the driver successfully wrote data to   the process hardware for the selec-
ted item.

Time of Last Error

Displays the last date and time the driver failed to access the selected   item in the process hardware.

Refresh

Click to refresh the data display with updated data from the driver.   
 

Understanding Data Quality

The OPC Client driver displays the quality of the data in the selected   item as part of its statistics. Data 
quality can be good, bad, or uncertain.   Each quality type can also have the following additional text (sub-
string)   to further explain the quality:

Data Quality Additional Text (Substrings)
Good Local Override
Bad Config Error

Input not Connected

Device Failure

Sensor Failure

Data Latched

Communication Failure

Out of Service
Uncertain Last Usable Value

Sensor not Accurate

EGU units exceeded

Sub-normal

The OPC Foundation defines each quality type and substring. For more   information on the definition of 
each item, visit the OPC   Foundation website. 

 

Use Poll Rates with Access Time

The following are practical examples for combining your primary poll   rates and access times to help you 
configure your items.
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Example 1

 l PollRec1

 l Poll Rate = 10 seconds

 l Access Time = 5 minutes

In this item, the OPC Client polls every 10 seconds for five minutes.   If no requests are made within five 
minutes, the item is disabled and   the OPC Client stops polling PollRec1.

Example 2

 l PollRec3

 l Poll Rate = 10 seconds

 l Access Time = Disabled

The driver always polls PollRec3 at 10 seconds with this configuration   because the access time is dis-
abled.

Example 3

 l PollRec4

 l Poll Rate = Disabled

 l Access Time = Disabled

The driver does not read messages from PollRec4 on the device. Instead,   the OPC Client updates the 
item when it receives data from the OPC server.

Use the Data Monitor

The Data Monitor displays the data received for the item, the data's   quality, and the last time data was 
read and written. It also provides   the time of the last error for the item.

 To use the Data Monitor:

 1. Confirm the driver   is running, and that the selected item is polling. You may have to enable   the 
item’s server and group to ensure the item is polling.

 2. Select the item you   want to examine and click the Data Monitor button. The Data Monitor dialog   
box appears.

 3. From the Format list,   select the format you want to use to display the values stored in the   item. If 
required, use the Refresh button to refresh the data display.

 

Starting and Stopping the I/O Driver

Click the following links for more information regarding Starting and   Stopping the I/O Driver.

 l Start   the I/O Driver from the Power Tool

 l Start   the I/O Driver from the iFIX SCU

 l Set   the I/O Driver for Automatic Startup in iFIX
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 l Start   the I/O Driver Manually from Mission Control

 l Stop   the I/O Driver

 

Start the I/O Driver from the Power Tool

Click the following links for detailed process information.

 l Start   the I/O Driver from the Power Tool

 l Turn   on the Auto Start option

 To start   the I/O driver from the Power Tool:

 1. Specify a default   path and configuration file name for the driver:

 a. From the Options   menu, choose Setup. The Setup dialog box appears. 

 b. Select the Default   Path tab.

 c. Enter the configuration   file’s default name and default path in the boxes provided.

 2. Configure your servers,   groups, and items. Select the Enable check box for each server, group,   
and item you want to start.

 3. From the Display   Mode menu, choose Start to start the driver. The driver processes all   enabled 
servers, groups, and items.

If you want to start the driver automatically, you should also turn   on the Auto Start option.

 To turn on the   Auto Start option:

 1. From the Options   menu, choose Setup. The Setup dialog box appears.

 2. Select the Advanced   tab in the Setup dialog box.

 3. Click the Auto Start   On option button from the Server area.

 

Start the I/O Driver from the iFIX SCU

IMPORTANT: You   must install the OPC Client in your root iFIX or Dynamics directory to   start it from the SCU. 
If you have not installed the driver in this directory,   uninstall it and then re-install it in the proper path.

 To start the OPC Client from   iFIX SCU:

 1. Start the System   Configuration Utility (SCU):

 a. From the Start   menu, select Programs. 

 b. From the Programs   menu, select Dynamics or iFIX. 

 c. Choose System   Configuration from the menu that appears.

 2. From the Configure   menu, choose SCADA. 
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 3. Click the ? button   next to the I/O Driver Name field for a list of available drivers.

 4. Select the OPC Client.   

 5. Click Add, then click   Configure.

 6. On the Power Tool,   click the Start button.

NOTES: 

 l You must have an OPC   Client configuration file in your root iFIX or Dynamics directory with   a name of 
nodename.OPC. This file is necessary for iFIX to load the driver   and is created by the installation pro-
gram when you install the OPC Client   driver. You also need a configuration file with a different name 
that   defines your servers, groups, and items.

 l If you are using iFIX,   nodename.OPC resides in your Database path (C:\FIX32\PDB, by default).   Do 
not move or delete this file. iFIX uses the file to load the driver.   Use nodename.OPC to define your 
servers, groups, and items.

 

Set the I/O Driver for Automatic Startup in FIX

Click the following links for detailed process information:

 l Set   the I/O driver for automatic startup

 l Add   the OPC Client to the SCADA Configuration dialog box

You can configure a driver to start automatically by adding the I/O   Control program to the list of programs 
that are defined in the System   Configuration Utility (SCU) to start automatically. FIX or iFIX may have   
already added this program to the list if you had one or more drivers   installed when you installed iFIX. 
However, if you do not have any drivers   installed, or I/O Control is not listed, add the program to the Con-
figured   Tasks list in the SCU.

IMPORTANT: You   must install the OPC Client in your root iFIX or Dynamics directory to   start it automatically 
from the SCU. If you have not installed the driver   in this directory, uninstall it and then re-install it in the proper 
path.

 To set the   I/O driver for automatic startup:

 1. Start the System   Configuration Utility (SCU):

 a. From the Start   menu, choose Programs. 

 b. From the Programs   menu, choose Dynamics or iFIX. 

 c. Choose System   Configuration from the menu that appears.

 2. From the Configure   menu, choose Tasks.

 3. In the Filename box,   enter the Base path and IOCNTRL.EXE.

 4. Enter the following   command lines as needed, separated by a space:

Parameter Description
/A Starts all I/O drivers identified in the SCADA configuration.
/Sxxx Starts one I/O driver where xxx is the three-letter I/O driver acronym.   

 5. Select Background   and click Add.
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If you are connecting items to one or more database blocks and need   to access data with SAC, add the 
OPC Client to the SCADA Configuration   dialog box as follows.

 To add the OPC   Client to the SCADA Configuration dialog box:

 1. From the Configure   menu, choose SCADA.

 2. Click the ? button   next to the I/O Driver Name box.

 3. Select the OPC Client   from the dialog box and click OK. The following text appears in the I/O   
Driver Name box:
OPC - OLE for Process Control Client 7.x

 4. Click Add to add   the selected I/O driver to the Configured I/O Drivers list box.

NOTES: 

 l You must have an OPC   Client configuration file in your root iFIX or Dynamics directory with   the name 
nodename.OPC. This file is necessary for iFIX to load the driver   and is created by the installation pro-
gram when you install the OPC Client   driver. You also need a configuration file with a different name 
that   defines your servers, groups, and items.

 l If you are using iFIX,   nodename.OPC resides in your Database path (C:\FIX32\PDB, by default).   Do 
not move, rename, or delete this file. iFIX uses the file to load the   driver. Use nodename.OPC to define 
your servers, groups, and items.

 l If you subsequently change   the name of your SCADA server after installing the OPC Client driver,   iFIX 
cannot automatically start the driver because the name of the node   does not match the name of the 
configuration file. To correct this, rename   the configuration file to match the name of your SCADA 
server. For example,   if you change the name of the SCADA server from SCADA1 to SCADA9, rename   
the configuration file from SCADA1.OPC to SCADA9.OPC.

 

Start the I/O Driver Manually from Mission Control

 To start the I/O driver manually   from Mission Control:

 1. Start Mission Control.

 2. Click the I/O Control   tab. This tab displays a list of the drivers installed on your system,   along 
with the driver’s status (ACTIVE or STOPPED).

 3. From the Drivers   list box, select the driver you want to start.

 4. Click Start. If the   selected I/O driver is already running, the Start button becomes a Stop   button.

NOTES: 

 l You must have an OPC   Client configuration file in your root iFIX or Dynamics directory with   the name 
of nodename.OPC. This file is necessary for iFIX to load the   driver and is created by the installation 
program when you install the   OPC Client driver. You also need a configuration file with a different   
name that defines your servers, groups, and items.

 l If you are using iFIX,   nodename.OPC resides in your Database path (C:\FIX32\PDB, by default).   Do 
not move, rename, or delete this file. iFIX uses the file to load the   driver. Use nodename.OPC to define 
your servers, groups, and items.
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Stop the I/O Driver

Click the following links for detailed process information:

 l Stop   the I/O driver manually from Mission Control

 l Stop   the I/O Driver from the Power Tool

 l Stop   the I/O driver from the iFIX Process Database

NOTE: If the   OPC Client driver is added to the SCU, and you do not stop it, it will   be stopped automatically 
when iFIX is shut down.

 To stop   the I/O driver manually from Mission Control:

 1. Start Mission Control.

 2. Click the I/O Control   tab. This tab displays a list of the drivers installed on your computer,   along 
with the driver’s status (ACTIVE or STOPPED).

 3. From the Drivers   list box, select the driver you want to stop.

 4. Click Stop.

 To stop   the I/O driver from the OPC Client Power Tool:

 From the Display Mode menu, choose Stop.

 To stop   the driver from iFIX Process Database

 1. From the Drivers   menu, choose OPC. 

 2. When the Power Tool   opens, choose Stop from the Display Mode menu.

 

Check Communication

Click the following links for detailed process information:

 l Add   the OPC Client to a SCADA configuration and launching the Power Tool

 l Configure   a group with the Power Tool

 l Add   a link to a picture that accesses the group

You can set up a single Data link and enable communications between   iFIX and the process hardware 
with the OPC Client.

You must configure a group in the I/O Driver Power Tool first, then   open a picture in the iFIX WorkSpace 
and set up a data link that accesses   process hardware using the OPC Client. When you enter the I/O 
address,   the item is automatically be created and the I/O Server starts polling   for data.

 To add the   OPC Client to a SCADA configuration and launch the Power Tool:

 1. Start the System   Configuration Utility (SCU):

From the Start menu, point to Programs,   then iFIX and click System Configuration from the   menu 
that appears.
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 2. From the Configure   menu, choose SCADA.

 3. Click the question   mark (?) next to the I/O Driver Name box. A list of drivers installed   on the local 
node appears.

 4. Select the OPC Client   and click Add. The SCU adds the OPC Client to the Configured I/O 
Drivers   list.

 5. Save and exit the   SCU. 

 6. Start or restart   iFIX.

 7. Start the OPC Power   Tool:

From the Start menu, point to Programs,   then iFIX and click OPC Power Tool.

 To configure   a group with the Power Tool:

 1. Add   a Server to the Power Tool.

 2. On the Server Properties   Viewer, select the Enable check box.

 3. From the Display   Mode menu, choose Stats Mode to verify that the driver is connected to   the 
OPC server. The Power Tool displays statistics for the selected server.

 4. From the Display   Mode menu, choose Config Mode to display the server’s properties.

 5. From the Edit menu,   choose Add Group. The Power Tool adds a group to the Tree Browser, under   
the selected server.

 6. In the Properties   Viewer, enter the appropriate information for the group and a unique name   for the 
group.

 To add an   iFIX picture that accesses the configured group:

 1. From   the OPC Client Power Tool Options menu, choose   Setup. The Setup dialog box appears.

 2. Click the Advanced   tab and choose Auto Create On from the Server area.

 3. Start the iFIX WorkSpace.

 4. For detailed   information on adding a datalink in an iFIX Picture, see the Adding   DataLinks topic in 
the Creating   Pictures e-book.

 5. From the iFIX   WorkSpace:

 l In Ribbon   view, on the Home tab, in the WorkSpace group, click Switch to Run.

- Or -

 l In Classic   view, on the WorkSpace menu, choose Switch to Run.

This action activates the run-time environment.   Data from the hardware   appears in the link. If it 
does not, refer to the Troubleshooting section.
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Optimizing Your System

Select from the following topics for tips on optimizing your process.

 l Adding   items to maximize performance.

 l Cleaning   up items while using the Auto Create option in iFIX applications.

 l Decreasing   unnecessary stress on your system.

 l Determining   the most efficient poll and update rates.

 l Understanding   the differences between using Asynchronous vs. Synchronous I/O.

 l Understanding   the differences between using Cache vs. Device reads.

 

How do I add items to maximize performance?

The best way to add items in order to maximize performance in the OPC   Client is by combining groups. 
This technique reduces the number of groups   and minimizes communications overhead. Since the poll 
rate is a property   of the group, the driver updates all items in the group at the same time.   

Example 1

Configuration 1

 l Number of groups: 100

 l Number of Items per   group: 1

 l Number of total items   = 100

 l Total calls from   the driver to the OPC server = 100 (each group constitutes one call)

Configuration 2

 l Number or groups: 1

 l Number of items per   group: 100

 l Total items: 100

 l Total calls from   the driver to the OPC server = 1

As you can see, placing multiple items in a single group significantly   decreases the communications 
overhead between the driver and the OPC server.   However, you don’t want to arbitrarily place every 
item in a single group   because this may cause unneeded stress on the system. Instead, group your   
items by their poll rate. 

Example 2

You need to add 100 items to your driver configuration. You need to   update the items as follows:

Number of items Poll Rate

108 © 2024 General Electric Company. All rights reserved.



20 1 second
15 1 minute
25 1 hour
40 By exception

To configure the driver correctly with these requirements, create 4   groups with the following properties:

Group Properties
Group 1 I/O Type: Synchronous

Update Rate: 1s

Poll Rate: 1s
Group 2 I/O Type: Synchronous

Update Rate: 30s

Poll Rate: 1:00
Group 3 I/O Type: Synchronous

Update Rate: 30:00

Poll Rate: 1:00:00
Group 4 I/O Type: Asynchronous

Update Rate: 1s

Poll Rate: 5:00

Asynchronous Watchdog: Enabled 

NOTES

 l When using synchronous   communications, we recommend that the update rate be twice as fast as   the 
poll rate. If the client is obtaining the value once an hour from   the server, there is no reason for the 
server to obtain the data once   a second.

 l We recommend that you   enable the Asynchronous Watchdog with a large poll rate to ensure that   the 
client holds the latest data in the OPC server. However, you can disable   the watchdog and not affect 
asynchronous updates from the server to the   client.

 l Also, keep the number   of items in each group to 1000 or fewer for optimum performance. For example,   
if you have a group with 1500 items, divide it into two groups of 750.

 

How do I eliminate excess items?

Click the following links for detailed process information:

 l Eliminate   excess items

 l Eliminate   excess items for specialized configuration files

Use the following procedure to eliminate items if you enabled the Auto   Create option in your I/O driver 
configuration and you created iFIX database   blocks that required items. This procedure removes any 
incorrectly configured   items or unused items.
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Using the Auto Create option also adds items with default values. If   you have modified the data type of 
one or more items, use the procedure   at the end of this topic.

NOTE: You may   not be able to delete items from the driver configuration because another   computer may start 
accessing them.

 To eliminate   excess items:

 1. With iFIX running,   open Mission Control, click the SAC tab, and click Stop, to stop SAC.

 2. Open the I/O Driver   Power Tool and delete all the items. Do not delete servers and groups.

 3. Return to Mission   Control and the SAC tab. Click Start. The driver automatically adds the   neces-
sary items with the default settings defined in the Power Tool.

This procedure guarantees that the I/O driver   configuration in the Power Tool matches what you 
are accessing in your   iFIX database.

If you made specific modifications to one   or more items, such as a different requested data type 
for each item in   a group, use the following procedure.

 To eliminate   excess items for specialized configuration files:

 1. Save the current   driver configuration as .CSV file.

 2. Perform the three   steps above for removing excess items.

 3. Compare the .CSV   file to the new configuration. Note any differences.

 4. Modify the .CSV file   as needed. 

 5. Open the modified   .CSV file and save it as a driver configuration file.

 

Decreasing Unnecessary Stress On Your System

 l Do not configure   unneeded poll and update rates. Also, configure poll rates you do need   based on 
the requirements of your application. For example, if your data   changes once a minute, set your 
poll rate to 1 minute, not 1 second. For   more information, refer to How   do I choose poll and update 
rates?

 l Whenever possible,   clean up items that you are not using for your process control system.   Refer 
to How do I eliminate   excess items? to learn how.

 l Use asynchronous   I/O instead of synchronous I/O. Let the OPC server inform the driver when   
data has changed instead of polling for the same data once a second. For   more information about 
the differences between asynchronous and synchronous   I/O, refer to Feature:   Asynchronous vs. 
Synchronous I/O.

 l Set the current group’s   data source to Cache, not Device. This configuration causes the driver   to 
read data from its cache instead of directly from a device and eliminates   a great deal of overhead. 
For more information about the differences between   Cache and Device data sources, refer to 
Feature:   Device vs. Cache Reads

 l Use exception based   processing in iFIX applications to save SAC processing time. For more   
information, refer to Feature:   Using Exception-Based Processing.
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How do I choose poll and update rates?

The poll rate determines how often the OPC Client polls for data from   the OPC server’s data cache for 
the specified group’s items. All items   in the group are polled at the same time. The update rate sets how 
often   the OPC server polls the process hardware to update the server’s internal   data cache for all the 
items in the specified group.

Setting the Poll Rate

Selecting a poll rate to use depends on whether you are using asynchronous   or synchronous I/O. 

Poll Rate and Asynchronous I/O

If you are using asynchronous I/O, we recommend setting the poll rate   to 5 minutes (5:00). Also select 
the Enable Asynchronous Watchdog check   box so that the client can periodically request data from the 
server.   If you do not select this check box, the client must rely on asynchronous   callbacks from the 
OPC server in order to refresh its data cache.

Poll Rate and Synchronous I/O

If you are using synchronous I/O, set the item’s poll rate shorter than   your scan time. For example, if you 
have a database block with a scan   time of 10 seconds, set the poll rate for the item it accesses to 5 
seconds.   Likewise, set the update rate to be shorter than the scan time and the   poll rate. 

Keep in mind that if you set poll and update rates for groups to values   that are shorter than needed, you 
impose unnecessary stress on your system.

Example
 l Database block scan   time: 10 seconds

 l Poll Rate: 5 seconds

 l Update Rate: 2 seconds

Using a Zero Poll or Update Rate

Setting the poll rate to zero forces the driver to run at its maximum   rate. 

Setting the update rate to zero requests the OPC server to update its   group at its maximum rate. The 
OPC server will return the actual, or revised,   rate that it can run at. This revised rate is displayed in the 
Actual   Rate field on the group’s statistics display in the OPC Client’s Power   Tool.

 

Troubleshooting Your System

Click the following links for information about troubleshooting your   system.
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 l How   Do I?

 l Frequently   Asked Questions

 l Troubleshooting

 l The   Most Common I/O Driver Problems

 l Tools   for Troubleshooting the OPC Client

 l Using   the Windows Event Viewer

 l Using   the Data Monitor

 l Error   Codes

 l Getting   Technical Support

 

How Do I?

 l Add   items to maximize performance?

 l Choose   poll and update rates?

 l Eliminate   excess items?

 l Set   up for remote configuration and control?

 l Prevent   the driver from writing to the hardware?

 l Create   reports of my driver configuration files?

 l Save   items created in iFIX Process Database to the I/O driver configuration   file?

 l Open   the OPC Client Power Tool in iFIX Process Database?

 l Configure   my driver for demand polling?

 l Poll   the group only when data is being accessed?

 l Set   up security for using the I/O Server remotely?

 l Set   up security when the driver runs as a service?

 l Enable   or disable servers, groups or items using iFIX?

 l Write   data to an item using the Block Writes option?

 l View   my driver statistics?

 l Browse   an OPC server?

 l View   the driver’s I/O Server Event Window?

 

Frequently Asked Questions
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Consult the frequently asked questions below to find out how to correct   common problems with your I/O 
driver:

 l How   do I avoid Asynchronous timeouts when the timeout is set?

 l What   is causing the error "Databasemanager !Unable to locate Driver Image   Table"?

 l How   do I upgrade a GE OPC Server from one version to another?

 l Why   do I have to install/register my OPC Server on the Client machine?

 l How   does the new array support in the OPC Client work with Register tag offsets?

 l Why   are simultaneous writes to an array in the OPC Client failing?

 l What   are the RSLinx array size limitations with OPC topics when using ControlLogix   pro-
cessors?

 l Why   won't the OPC Client automatically enable items upon startup?

 l Where   can I find information about DCOM configuration and security?

 

Troubleshooting

Select from the Troubleshooting tips below to find out how to correct   problems with your I/O driver.

 l What   program or tools can I use to troubleshoot my driver when I am experiencing   problems?

 l My   driver doesn’t load.

 l I   receive a message that the server is busy.

 l My   driver loads but does not start polling.

 l The   OPC Client does not connect to a local OPC server after restarting my   HMI software.

 l My   driver doesn’t communicate with any group or I receive ????? in my operator   display links.

 l The   driver is not transmitting or receiving messages.

 l The   driver is transmitting messages but not receiving any messages.

 l The   driver is receiving messages, but not transmitting messages.

 l The   driver communicates to some but not all of the items in a group.

 l I   can’t connect to a remote server.

 l I   can’t see the driver in iFIX Process Database.

 l I   am receiving old data in my HMI display.

 l What   do the numbers in the Errors field of the Power Tool’s statistics display   mean?

 l My   message rate is slow.

 l My   driver stops running after a period of time.

 l I   do not receive driver messages in Alarm History.

 l Automatic   driver startup does not work.
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 l CPU   usage is high.

 l Floating   Point errors appear after an upgrade.

 

The Most Common I/O Driver Problems

Some of the most common problems encountered when setting up and using   I/O drivers are caused by 
one or more of the following:

 l Failing to match   the communication parameters of the process hardware in the OPC server.   For 
information about appropriate values for these fields, consult your   OPC server’s documentation.

 l Failing to run SAC.   You cannot access data from your I/O driver in the Event Viewer or the   iFIX 
WorkSpace until SAC is running.

 l Attempting to communicate   to areas of memory not defined in the controller. Verify that each 
item’s   address is valid.

 l Setting an item’s   access time to be larger than its poll time so that OPC Client never polls   for 
data.

 l Not enabling the   server, group or item in the OPC Client.

 l Leaving the item   ID blank.

 

Tools for Troubleshooting the OPC Client

Click the following links for more information regarding the OPC Client:

 l View   the I/O Server program in the I/O Server

 l Close   the I/O Server program

Statistics View in the OPC Client Power Tool

The Power Tool displays communication statistics for each item, group,   server, and the entire driver. 
Displaying these statistics is useful for   narrowing down which part of the driver is not functioning. To 
view the   statistics, select an item, group, or server from the Tree Browser and   then select Stats Mode 
from the Display Mode menu.

Statistics in iFIX Mission Control

Mission Control is the main iFIX tool for monitoring background tasks,   such as SAC, and I/O drivers. 
Using Mission Control,   you can start and stop a driver, and view driver error numbers. This is   useful for 
quickly determining if the driver is having a problem. 

Mission Control also provides a summary of driver-level statistics.   To see the statistics for each server, 
use the OPC Power Tool.
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Windows Event Viewer

The driver reports any major errors to Windows Event Viewer. To learn   more about using this applic-
ation, refer to Using   the Event Viewer.

Alarm History in iFIX

Because the I/O driver reports event messages to the Alarm History application   in iFIX, you can use this 
program for debugging your driver. The events   reported include when the driver:

 l Starts and stops.

 l Connects and disconnects.

 l Fails to connect   with the OPC Server and subsequently recovers.

Refer to the iFIX documentation for details about enabling alarm services.

Message Log in the I/O Server Program

The message log in the I/O Server program tracks the following events:

 l The date and time   a configuration file loads.

 l Which configuration   file loads. If the driver is not loading the configuration file you want,   you can 
change the default file name and location in the Power Tool’s   Setup dialog box. 

 l The date and time   other applications attach to the server. This data can help you determine   if 
someone is attached and making changes to the server you are working   on.

 l CSV import errors.

 To view   the I/O Server program in the I/O Server:

 1. Open the Power Tool.

 2. Select an object   from the Tree Browser.

 3. Press ALT   + SHIFT + S.

The options in the Server’s View menu let you choose the types of messages   to display. The message 
priority is as follows:

Server 
View

Displays...

Errors Connection errors, run-time errors, and any exceptions   caused by the driver or 
OPC server.

Warnings General warnings.
InformationGeneral information such as loading files or .CSV activity.
Debug1 The connection status of the driver to an OPC server   when the server is enabled. 

Debug1 messages also contain information about   any OPC interface that was 
not obtained when the driver connected to the   OPC server.

Debug2 Information about asynchronous transactions between   the driver and the OPC 
server.

Debug3 Information about failed writes to the OPC server.
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The default setting for the Server is to display errors, warnings, and   informational messages. However, 
you can also enable any debug message   you want more information about.

 To close   the I/O Server program:

 1. Select an item from   the Tree Browser.

 2. Press Alt + Shift   + S. 

iFIX Process Database Log File

The driver reports all actions performed to add items and database blocks   to the iFIX process database. 
For more information, see Use   the iFIX Process Database Log File.

 

Use the Windows Event Viewer

GE’s Version 7.x drivers take advantage of a Windows feature known   as the Event Viewer. This feature 
allows software to write messages and   data to the Windows Event Log. These messages can then be 
viewed using   the Windows Event Viewer application. Version 7.x drivers use this ability   primarily to log 
information about problems that arise during execution,   particularly in the lowest layers of the driver 
where reporting the problem   to users is more difficult. It also allows the messages logged to include   spe-
cific information about the error. For instance, if the memory object   encounters a problem while mapping 
an area of global memory via the "CreateFileMapping()"   Win32 function, it not only reports that the error 
happened, but it can   also translate the error code returned by Windows and include that text   as well.

The Windows Event Viewer contains three different categories of messages:   System, Security, and 
Application. The OPC Client writes its messages   to the Application log.

 To view messages that might   be generated by the driver:

 1. Start the Windows   Event Viewer.

 2. Select the Application   log from the Log menu. All the log messages associated with the Applic-
ation   log appear. Any message specific to your driver contains the driver’s   acronym (OPC) in the 
Source column.

 3. Select a message   and press the Enter key;

- Or -

Highlight a message and choose Detail from   the View menu;

- Or -

Double-click the message.

Information that may be helpful for troubleshooting your I/O driver   includes:

 l Time   – The time that the message was logged.

 l Computer   – The name of the computer that the message was logged on.

 l Type   – The severity of the message. Options include: Error, Information, and   Warning.

 l Description   – The actual message logged.
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 l Data   – The specific data associated with the message. The OPC Client rarely   uses this inform-
ation.

 

Error Codes

Error codes display in the Power Tool’s statistics display and in Mission   Control’s DRVST fields. The fol-
lowing table lists the errors that appear   in the statistics display. To view an error, select an item from the 
Tree   Browser and select Stats Mode from the Display Mode menu. The error appears   in the Last Error 
field of the selected item. To learn more about Mission   Control errors, refer to one of the following:

 l DRVSTA   Error Codes

 l DRVSTB   Error Codes

 l DRVSTC   Error Codes

Item Last Error Field

Error Description Possible Cause
0x0000 No error N/A
0x0001 Generic 

error
Any error that does not fall into any other category.

0x0002 Unable to 
copy to com-
mon 
memory

The item cannot copy its data, timestamp, or quality   to memory for 
access for iFIX NIO applications. Process Database and your   operator 
displays may show old data.

0x0003 Unable to 
set active 
state

The driver cannot change the active state of the item   in the OPC server. 
Typically, this error occurs when you select the item’s   Enable check 
box and the server rejects the request.

0x0004 Unable to 
set client 
handle

The server cannot change the client handle for the   item. 

0x0005 Unable to 
set data 
type

The server cannot handle or does not support the requested   data type.

0x0006 Unable to 
read

The OPC server for this item’s group rejected a read   request. Typically, 
this error occurs when you attempt to read data from   a write-only OPC 
item. 

0x0007 Unable to 
write

The OPC server rejected a write request for this item.   Typically, this 
error occurs when you attempt to write data to a read-only   OPC item.

0x0008 Bad handle The OPC server sent an asynchronous callback containing   a bad or 
unknown handle.

0x0009 Unable to 
advise

The driver attempted to establish an asynchronous   connection with the 
OPC server, but the request failed. Verify that your   server supports 
asynchronous communications. 

0x000A Unable to 
unadvise

The driver attempted to break an asynchronous connection   with the 
OPC server, but the request failed.
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0x000B Exception 
generated

An exception was generated based on a call to the   OPC server. Refer to 
the driver’s Event window for a more detailed explanation.

0x000C Invalid Item 
ID

The specified item ID is invalid or unknown by the   OPC server.

0x000D Invalid 
Access 
Path

The specified access path is invalid or unknown by   the OPC server.

0x000E Bad Item 
Quality

The quality of the item is no longer Good.

0x000F Advise not 
received

The driver made an asynchronous connection to the   OPC server; how-
ever, server did not return data for the item. Examine   the item to ensure 
the item ID and the access path are valid. Also verify   that the item is 
enabled and communicating.

0x0010 Write 
clamped

The OPC server accepted the data you are writing,   but then clamped its 
value.

0x0011 Write value 
out of range

The data you are writing is out of range.

0x0012 Bad type for 
write value

The OPC server cannot accept the data type of the   item you are writing 
to.

0x0013 Insufficient 
access 
rights

The item does not have sufficient access rights. Typically,   this error 
occurs when you write to a read-only item. 

0x0014 Unable to 
block write

The OPC Client could not process the block write.

0x0015 Block writes 
disabled

Block writes are disabled; however, a database block   attempted to 
execute a !SEND command. 

0x0016 No data to 
read for 
block write

The block write failed because there was no data to   read in common 
memory.

0x0017 Duplicate 
block write

A duplicate block write was detected. The previous   block write request 
will be discarded.

0x0018 Error read-
ing data

The OPC Client could not read the necessary data.

0x0019 Unknown 
Item ID

While adding or validating an Item, the server returned   an error indic-
ating that the requested Item ID does not exist in it’s   address space.  
This   error may also indicate that the Item is defined in the server as 
read-only   or write-only.

The following errors are combined with the errors listed above. For   example, if you receive error 1516, 
this is a combination of error 1500,   Error reading from common memory, and Error 16, No data to read for 
block   write. From this error, you can determine that the OPC Client was reading   from common memory 
when it found no data for the pending block write.

Error Description Possible Cause
0x1000 Driver not run-

ning
The Start button on the Run-time toolbar has not been   selected. 
Select the Start button to start the OPC Client.

0x1100 Not con-
nected to the 
server

The OPC Client is not connected to the OPC server.   Make sure all 
servers, groups, and items in the OPC Client are enabled.

0x1200 Common The OPC Client failed to allocate common memory.
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memory alloc-
ation failed

0x1300 Local memory 
allocation 
failed

The OPC Client failed to allocate a temporary local   memory buffer.

0x1400 Error access-
ing common 
memory

The OPC Client could not access common memory.

0x1500 Error reading 
data from com-
mon memory

The OPC Client could not read data from common memory.

0x1600 Error adjusting 
common 
memory data 
size

The OPC Client could not resize the memory needed   for an item.

0x1700 Out of local 
memory

The temporary local memory buffer allocated by the   OPC Client is full; 
consequently, the operation in progress cannot be   completed.

0x1800 Queue Empty One of the queues used by the OPC Client is empty;   consequently, 
the driver found nothing to process.

0x1900 Error access-
ing data

The OPC Client cannot access the data it needs.

0x2000 Item not 
added to 
server

The item being processed does not exist on the OPC   server because 
it was never added to the server’s configuration.

0x2100 Outputs dis-
abled

Outputs for the item being processed are disabled;   however, a write 
from the item was attempted using a database block.

0x2200 Not setup as 
array

The item being processed uses data array syntax in   its item ID; how-
ever, the item is not configured as an array. To configure   the item as a 
data array, select the Array check box. 

0x2300 Setup as an 
array

The item being processed does not use data array syntax   in its item 
ID; however, the item is configured as an array. To correct   the error, 
clear the Array check box.

0x2400 Address out of 
bounds

The specified item ID does not exist on the OPC server.

0x2500 Data size out 
of bounds

The specified array length is larger than is supported   on the OPC 
server or the size of the data returned by the OPC server does   not 
match the size of the array configured in the Power Tool.

0x2600 Data type mis-
match

The item’s specified data type does not match the   data type specified 
by the OPC server.

0x2700 Data type 
invalid

The OPC server or OPC Client does not support the   item’s specified 
data type.

0x2800 Database 
block type 
invalid

The database block you configured cannot be used with   the command 
entered in the I/O Address field. Refer to Specifying   I/O Addresses in 
iFIX Process Database to determine the correct block   to use.

0x2900 Data type is 
empty

No data type has been selected for the item being   processed. 

0x2A00 Invalid floating 
point value

The server processed an IEEE floating point value   that was found to 
have an invalid format. 
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Mission Control   DRVST Errors

Field Contains the...
DRVSTA Number of the last error caused by an item. Refer   to the previous tables for inform-

ation on the error.
DRVSTB Group number contains the erroneous OPC item.
DRVSTC Item number causing the error.
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Creating a Custom Client Application

The OPC I/O Server is an OLE application that you can control programmatically.   It exposes its func-
tionality to other OLE applications through its interfaces,   which means you can create custom OLE 
applications to access or control   the driver. 

For example:

l You can use Visual   Basic to programmatically enable servers, groups, or items depending on
user input.

l You can use VBA in   Excel to create a program that generates reports comparing group statistics
within a driver.

l You can write programs   that control the driver with higher performance using C or C++.

Refer to the following topics for steps on getting started with creating   custom applications:

l Creating   a Custom Application Using Microsoft Visual Basic

l Creating   a Custom Application Using C or C++

Create a Custom Application Using Microsoft Visual Basic

Microsoft Visual Basic is one of many applications that you can use   to develop custom OLE applic-
ations for use with the OPC Client.

 To start designing a Visual   Basic application that accesses the OPC Client objects:

1. Start Visual Basic   and from the Projects menu, choose References. The GE OPC Client   7.10
Library should display in the Available References list box. If it   does not, browse your directories
for .TLB files and add OPCDRV.TLB to   the Available References list box.

2. From the View menu,   choose Object Browser and then from the Libraries/Projects list at the   top
of the browser, select OPCDRV.

3. Select a property   or method and press F1 to learn how to use it.

The type library, OPCDRV.TLB, is installed in the same path that you   installed the OPC Client. 

NOTE: To use   Visual Basic for Applications (VBA) instead of the VB Compiler, select   References from the 
Tools menu in step 1 and follow steps 2 and 3 above.

Create a Custom Application Using C or C++

You can create a custom client application for use with the I/O Server   using Microsoft Visual C or C++.
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 To get started creating an client   application with C or C++:

 1. Add a call to CoCreateInstance   to load the server and get a pointer to the driver interface.

 2. Include InterfaceDef.h   in the source from your driver.

 3. Add Interfacedef_i.obj   to the project.

You can obtain copies of InterfaceDef.h and Interfacedef_i.obj from   GE. Contact your local sales rep-
resentative for more information.

 

The OPC Client as a Data Source in iFIX

Click the following links for more information regarding Data Sources   in iFIX:

 l Access   the OPC Client as a Data Source in iFIX

 l Access   String Data with the OPC Client

 

Access the OPC Client as a Data Source from iFIX

You can access any item in the OPC Client as a data source in iFIX.   Using this method, the values from 
your OPC server can be displayed directly   to an operator without the overhead of using the process data-
base. Typically,   this approach is best when you only want to display the data and do not   need to alarm or 
historically trend the information.

 To access an item in the OPC   Client as a data source:

 1. Configure the OPC   Client as needed. For more information about configuring the client, refer   to 
Choosing a Method for Configuring Your Driver.

 2. Register the OPC   Client as a data server with the Data Server Installer.

 a. From   the Base path (C:\Dynamics, by default), double-click the icon for the   Data Server 
Installer (DataServerInstaller.exe).

 b. Click   Add or double-click the data server you want to modify.

 c. In the   Data Server box, enter a name. Make sure the name is not already in use.

 d. From   the OPC server list, select an OPC driver.

 e. Select   the Set as Default Server check box to make the server the default.

 3. Start iFIX and add   a Data link to any picture you have in your Pictures folder. The Data   link dialog 
box appears.

 4. Click the Browse   button to the left of the Source field. The Expression Builder dialog   box 
appears.

 5. Click the Data Servers   tab.

 6. Select the OPC Client   and navigate to the item you want to use.
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 7. Click OK to accept   your selection and close the Expression Builder.

 8. Click OK to close   the Data link dialog box.

 

Access String Data with the OPC Client

You can read string values in the OPC client by using the following   syntax as your data source:

server;group;itemid|bytes (ASCII values)

Where:

 l server   is the name of the OPC server you want to access.

 l group   is the name of the group that you want to read data from. 

 l itemid   is a itemID of the string data to read. 

 l bytes   is the number of bytes (characters) you want to read. Specifying the number   of bytes is 
optional. When omitted, the client reads 20 bytes. You can   specify a maximum of 256 bytes.

Using this feature, you can read the string values you need. However,   you cannot read past the bound-
ary of an itemID. For example, if you create   an item that contains a string of 10 characters and you spe-
cify to read   20 bytes, only the first 10 characters are read. 

NOTE: This syntax   is not supported with data arrays since arrays to not support string data.

 

Glossary

The following terms are used in the I/O Driver Power Tool.

CSV File – A   comma separated file that the I/O Driver Power Tool creates when it exports   a con-
figuration file. Comma separated files can be edited in any third-party   application that supports CSV 
files, such as Microsoft   Excel or a text editor. Comma separated value   files can also be created in a 
third-party application and read by the   I/O Driver Power Tool.

Exception-Based   Processing – SAC can perform exception-based   processing on the following 
events:

 l The item’s data changes   in common memory.

 l Asynchronous updates   from the OPC server.

 l Operator actions.

 l Instructions from   software applications.

I/O Address – A location in the process hardware (for example,   a register, address, or point) that the 
driver reads from and writes data   to. An I/O address is a portion of an OPC item.

I/O Driver – The software interface responsible for sending   data to and acquiring data from the process 
hardware. When discussing   OPC drivers the term I/O Server is sometimes used as well.
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NODE:TAG.FIELD – A   tagname in iFIX applications. It provides the information needed to access   data-
base data.

 l NODE:   defines the computer where the data you require is located. This can be   the computer you 
are working on or a remote computer.

 l TAG:   is the name of a database block. Block names can be up to 30 characters   long.

 l FIELD:   defines the data type.

Process Database   Block – Individual units of instructions   that receive, verify, manipulate, and output 
process values. Process database   blocks can also compare a process value against an alarm limit and 
perform   calculations based on a specific process value.

Primary Database   Blocks – Primary database blocks are   blocks in the process database that com-
municate with field devices.

Prog ID – A   vendor-specific string used to identify the OPC server.

Run-Time Configuration   File – The process control software   uses run-time configuration files (.OPC 
files) to communicate with the   process hardware during run-time.

SAC – The   Scan, Alarm, and Control program (SAC) is a iFIX system task that runs   on a SCADA 
server. SAC transmits and receives data back and forth between   the process database and the I/O 
driver’s common memory.

SAC performs the following tasks:

 l Fetches data from   the I/O driver’s common memory.

 l Translates the data   into the format expected by the process database.

 l Checks the data against   the alarm limits and generates alarm messages.

 l Executes the control   logic.

 l Detects exceptions.

 l Makes requested writes   to the driver’s common memory.

Signal Conditioning –   The method by which a raw process data   value is scaled.

SIM Driver – An   I/O driver used to simulate input and output of the process database for   iFIX applic-
ations. SIM values are saved in the process database itself   but are cleared when SAC is started or when 
you reload the process database.   SIM registers range from 0 to 2000 for analog values and 0:0 to 
2000:15   for digital values.

Time-Based Scan Time   – With a time-based scan time, SAC   retrieves data at set time intervals. Use 
time-based scanning when your   data changes frequently.
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Where to Find the Information You Need

Welcome to OPC Client I/O driver online help. This help system provides   all the information you need to 
use the OPC Client I/O driver. Refer to   the following topics to learn more about the features of the OPC 
Client   online help:

 l Using   Help

 l Accessing   Information

 l Navigating   in the Online Help

 l Using   F1 Help

 l Using   the Help Table of Contents

 l Using   the Help Index

 l Using   the Help Full-Text Search

 l Printing   the Online Help

 

Use Help

The OPC Client Help appears in a browser consisting of three panes:   the help button bar, the navigation 
pane, and the viewer.

Help Button Bar

Each menu contains a list of commands. To display the commands, click   the menu name. The following 
table explains the function of each command.   

Command Function
Hide/Show Hides or shows the navigation pane. The Hide button   is displayed by default.
Locate Finds and highlights the current help topic in the   Contents tab.
Back Displays the previously viewed help topic.
Forward Displays the next help topic in a previously viewed   sequence of topics.
Print From the Contents tab, prints pages, headings and   subtopics, or the entire table 

of contents. From the Index or Search tab,   opens the Print dialog for printing the 
current topic.

Options Opens a menu that provides access to:

Hide/Show tabs; Locate; Back/Forward; Home; Stop;   Refresh; Print; Search 
Highlight Off

Web Sup-
port

Opens the GE Support web site,   if an Internet connection is available.
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Navigation Pane

The Navigation pane consists of the following three tabs. For information   on each tab, click the link.

 l Contents

 l Index

 l Search

Viewer Pane

The Viewer pane displays the selected help topic. Topics that refer   you to additional information have a 
See Also button below the topic title.

 

Access Information

The OPC Client I/O driver online help consists of independent topics   with specific information on I/O 
driver concepts and procedures. You can   access these topics using one of the following methods:

 l Use   F1 Help

 l Use   the Help Index

 l Use   the Help Full-Text Search

 l Use   the Help Table of Contents

The index, full-text search, and table of contents are all located in   the Help Topics dialog box. You can 
display this dialog box by using one   of the following methods:

 l Choose Help Topics   from the Power Tool’s Help menu;

- Or -

 l Choose OPC   Help from the Start menu as follows:

 1. From the Start   menu, point to Programs, and then FIX Dynamics or iFIX. 

 2. From the menu   that pops up, choose OPC Help.

 

Navigate the Online Help

When you access a topic in the OPC Client online help, it may not provide   all the information you need. 
To learn more about a topic, you can: 

 l Use help links. 

 l Click the See Also   button and select another topic. 
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Using Help Links 

Blue words or phrases are links. Clicking a link either displays another   topic or a pop-up window on top 
of the current topic. If you are using   the keyboard, press Tab to move to the next link in the topic and 
press   Enter to activate the link. 

Links to other topics are blue with a solid underline and are called   jumps. Jumps take you out of the cur-
rent topic to a new topic. Links that   display pop-up windows are blue italics with a solid underline. Pop-
up   windows display over the current window and are usually definitions of   terms. 

Using the See Also List 

Most topics have a See Also button located directly under the topic   title. Click the See Also button to dis-
play a list of topics related to   the current topic. If you select one of the topics from the list, that   topic dis-
plays. To get back to your original topic, click the Back button   on the button bar. 

Use F1 Help

The fastest way to get help on the Power Tool controls is to press the   F1 key. To display F1 help, select 
the control you want information on   and press the F1 key. The topic that appears is specific to the selec-
ted   control and usually explains the effect of the control, which entries   are valid, and provides examples 
of valid entries when applicable.

 

Use the Help Table of Contents

The table of contents provides an overview of what’s available in the   OPC Client online help. It displays 
the titles of the books and the topics   within each book. 

 To use the Table of Contents:

 1. On the Help Topics   dialog box, select the Contents tab. 

 2. Double-click a book   to open or close it. 

 3. Double-click the   topic you want to read. 

 

Use the Help Index

The online help provides an index to all its topics. This index is similar   to the index in a printed book. 

 To search the index:

 1. On the Help Topics   browser, select the Index tab. 

 2. Type or select the   word you want information on. 
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 3. Double-click the   indexed item in the lower part of the Index tab to display the associated   topic. If 
the word you entered is associated with more than one topic,   a Topics Found list box appears dis-
playing all the topics indexed under   that word. 

 4. If applicable, in   the Topics Found list box, double-click the topic you want to display.

 

Use the Help Full-Text Search

If you can’t find the information you’re looking for in the index, you   can use the full-text search capability. 
A full-text search finds every   occurrence of a selected word or phrase anywhere within the online help.   

 To use the full-text search:

 1. On the Help Topics   browser, select the Search tab. 

 2. Enter the word or   phrase you want to locate. 

 3. Click the right arrow   button next to the Search field to perform a boolean search; that is,   to use 
AND, OR, NEAR, or NOT to create a boolean search expression.

 4. Click List Topics.   A list of topics appears in the Select topic box.

 5. From the Select topic   box, double-click the topic you want to display. 

 

Print the Online Help

 To print one OPC Client Help   topic at a time:

 1. Display the help   topic you want to print. 

 2. On the Help button   bar, click Print. The Print Topics dialog box appears.

 3. Select Print the   selected topic and then click OK. The Print dialog box appears.

 4. Click Print. The   displayed topic prints.

 To print the entire online help   as a book:

 1. Display a topic in   the book you want to print.

 2. On the Help button   bar, click Print. The Print Topics dialog box appears.

 3. Select Print the   selected heading and all subtopics and then click OK. The Print dialog   box 
appears.

 4. Click Print. All   of the topics under the selected heading print.
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